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1 SETTING UP THE KPG-89D

You can configure various functions of the transceiver 
using the KPG-89D.  You can write the configuration data 
into the transceiver by connecting it to a PC with the 
KPG-89D.  You can also edit and print out the 
configuration data of the transceiver using the KPG-89D.

1.1 System Requirements

You must prepare the following devices and operating 
systems to install the KPG-89D.

Table 1-1   System Requirements

Note: The KPG-89D may not work properly due to the insufficient 
resource when running it with other softwares.

1.2 Connecting the Transceiver 
to the PC

Follow the procedures below to connect the PC to the 
transceiver.
1. Turn the PC OFF.

2. Connect the 25-pin connector of the KPG-36/ 46 
programming cable to one of the COM 1 - COM 20 
ports on the PC.
Connect the DB-25-pin male to DB-9-pin male gender 
changer to the KPG-36/ 46 programming cable when 
the COM port is a 9-pin connector.

3. Turn the PC ON.
4. Turn the transceiver OFF.
5. Connect the modular connector of the KPG-36/ 46 

programming cables to the female connector of the 
transceiver.

6. Turn the transceiver ON.

1.3 Installing the KPG-89D

Follow the procedures below to install the KPG-89D to 
the PC.

Note:

! You must have the administrative privilege in order to install the 
KPG-89D with Windows 2000/XP.

! To update the software, uninstall the old version before installing 
the newer version.

1. Stop running all programs on the PC (including the 
virus-checking program).

2. Insert the KPG-89D CD-ROM into the CD drive.
3. You can install the KPG-89D with one of the following 

methods.
• Double-click the CD-ROM drive icon > 

“Setup.exe”.
• Select “RUN” > “setup.exe” in the CD-ROM drive.
• Click “Control Panel” > “Add/Remove Programs > 

“Install” (“Program” in Windows 2000/XP).

PC IBM PC or compatible with Windows 
operating system

Hard Disk 10 MB or more free hard disk spaces

Memory 32 MB 

CD-ROM A CD-ROM drive that can be accessed 
directly or via Network.

Monitor A monitor having the resolution of 800 x 
600 pixels and 256 or more colors.

OS

Microsoft Windows XP
Microsoft Windows 2000
Microsoft Windows Me
Microsoft Windows 98

Communication Port

A PC must have at least one 
asynchronous serial communication port 
to communicate with the transceiver.  
You can select the communication port 
from COM 1 - COM 20 ports.

Connection cable

You must connect the transceiver to a 
computer using the KPG-36/ 46 
programming cable. A D-sub 9-pin 
female to D-sub 25-pin male gender 
changer may be required.
Version: 1.11 Field Programming Reference 1



1 SETTING UP THE KPG-89D
1.4 Uninstalling the KPG-89D

Follow the procedures below to uninstall the KPG-89D 
from the PC.

Note:

! You must exit the KPG-89D before uninstalling it.

! You must have the administrative privilege in order to uninstall 
the KPG-89D with Windows 2000/XP.

! To update the software, uninstall the old version before installing 
the newer version.

1. Click “Control Panel” > “Application addition/ removal” 
> “Install”.  (Click “Add Programs” when using 
Windows 2000/XP.)

2. Select “KPG-89D” from the program list.
3. Click “Application addition/ removal”.  (Click “Change/ 

Delete Programs” when using Windows 2000/XP.)
2 Field Programming Reference Version: 1.11



2 BASIC OPERATION

This section describes basic operations of the KPG-89D.

Note: We recommend you storing the data configured with the 
KPG-89D to the hard disc or the external storage device.  
(Refer to 4 File Menu.)

2.1 Starting and Exiting the 
KPG-89D

Select “Start” >“All programs” > “KENWOOD FPU” > 
“KPG-89D” to start the KPG-89D.

Note: You can start the KPG-89D by opening the folder where you 
installed the KPG-89D, and then double-click the 
“Kpg89d.exe”.

Figure 2-1   Starting Screen of the KPG-89D

The Main window of the KPG-89D appears.
The splash logo appears in the center of the screen for a 
while and it automatically disappears.  You can also make 
the logo disappear by pressing any key on the keyboard 
or clicking a mouse button.
 Select “File” > “Exit” to exit the KPG-89D.

2.2 Initializing the Window

Select the transceiver model to configure.  (Refer to 5 
Model Menu.)
Model name, model type, frequency bandwidth, and data 
file name appear on the title bar located on the top of the 
window.  (Refer to 3.1.1 Title Bar.)

2.3 Writing the Configuration 
Data to the Transceiver

Follow the procedures below to write the configuration 
data to the transceiver.
1. Enter all necessary data.

Select the item to configure in the Edit menu and 
enter data in the window.    (Refer to 6 Edit Menu.)

2. Writing data to the transceiver
Select “Program” > “Write Data to the Transceiver”.  
(Refer to 7 Program Menu.)

2.4 Modifying the Configuration 
Data

Follow the procedures below to modify the configuration 
data.
1. Read the configuration data from the transceiver.

Select “Program” > “Read Data from the Transceiver”.  
(Refer to 7 Program Menu.)

2. Edit the data on the PC.
Select the item to configure in the Edit menu and 
enter data in the window.  (Refer to 6 Edit Menu.)

3. Write the updated data to the transceiver
Select “Program” > “Write Data to the Transceiver”.  
(Refer to 7 Program Menu.)

2.5 Editing the Configuration 
Data and Writing to the 
Transceiver

Follow the procedures below to edit the configuration 
data and write it to the transceiver.
1. Open the configuration data stored in the hard disk 

drive or other storage devices.
Select “File” > “Open” to open the configuration data.  
(Refer to 4 File Menu.)

2. Editing the configuration data using the KPG-89D
Select the item to configure in the Edit menu and 
enter data in the window.  (Refer to 6 Edit Menu.)

3. Writing the configuration data to the Transceiver
Select “Program” > “Write Data to the Transceiver”.  
(Refer to 7 Program Menu.)
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2 BASIC OPERATION
2.6 Displaying Help

Click “Help” to open the KPG-89D HTML Help window.  
Press [F1] to display the Help Topics of the selected item.  
(Refer to 12 Help Menu.)
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3 MENU DESCRPTION

3.1 Main Window

The title bar, menu bar, and tool bar appear on the top of 
this window.  The status bar appears in the lower part of 
this window.

Figure 3-1   Main Window

3.1.1 Title Bar

The title bar shows the model name, the frequency range, 
and the configuration data file name.  (Refer to 5 Model 
Menu.)

Figure 3-2   Title Bar

3.1.2 Menu Bar 

The Menu bar allows you to configure the functions of the 
transceiver using the KPG-89D.  Click the menu title to 
open the pulldown list.  The menu commands stored in 
the menu appears.  (Refer to 3.2 Menu Command 
Description.)

Note: The Window menu appears on the menu bar only when the 
function is selected in the Edit menu and the window of the 
function is displayed.

Figure 3-3   Menu Bar 
(When the Window menu is displayed.)

Figure 3-4   Menu Bar 
(When the Window menu is not displayed.)

3.1.3 Toolbar

Frequently used icons are shown on the Toolbar. 
Click the “Toolbar” icon to execute the function.

Figure 3-5   Toolbar

Note:

! You can display or hide the Toolbar by selecting “View” > 
“Toolbar”.  (Refer to 10.2 Toolbar.)

! You can drag-and-drop the Toolbar to any desired position. 

Table 3-1   Descriptions of the Buttons on the Toolbar

Button Function

New

This icon is for the New function in the File 
menu.
This function allows you to clear the current 
configuration data and create the new 
configuration data.  (Refer to 4.1 New.)

Open

This icon is for the Open function in the File 
menu.
This function allows you to open the 
configuration data stored in the hard disk or 
other external storage devices.  (Refer to 
4.2 Open.)

Save

This icon is for the Save function in the File 
menu.
This function allows you to save the current 
configuration data to the hard disk or other 
external storage devices.  (Refer to 4.3 
Save.)

Print

This icon is for the Print function in the File 
menu.
This function allows you to print out the 
configuration data.  (Refer to 4.5 Print.)

Read

This icon is for the Read Data from the 
Transceiver function in the File menu.
This function allows you to read the 
configuration data from the transceiver by 
using the KPG-89D.  (Refer to 7.1 Read 
Data from the Transceiver.)

Write

This icon is for the Write Data to the 
Transceiver function in the File menu.
This function allows you to write the data to 
the transceiver using the KPG-89D.  (Refer 
to 7.2 Write Data to the Transceiver.)

About KPG-89D

This icon is for the About KPG-89D  function 
in the File menu.  (Refer to 12.2 About KPG-
89D.)
Version: 1.11 Field Programming Reference 5



3 MENU DESCRPTION
3.1.4 Status Bar

The status bar shows the serial communication port used 
to perform the data communication between the KPG-
89D and the transceiver, and the current data and the 
date.
 

Figure 3-6   Status Bar

Note:

! You can display or hide the status bar by selecting “View” >  
“Status Bar”.  (Refer to 10.3 Status Bar.)

! Double-click “COM” to open the COM port window.

3.2 Menu Command Description

Following are the descriptions of the Menu Commands.

3.2.1 File Menu
 

Figure 3-7   File Menu

Table 3-2   Function list of the File Menu

3.2.2 Model Menu

Figure 3-8   Model Menu

Table 3-3   Function List of the Model Menu

Function Description

New
This function allows you to clear the current 
configuration data and create the new 
configuration data.  (Refer to 4.1 New.)

Open

This function allows you to open the 
configuration data stored in the hard disk or 
other external storage devices.  (Refer to 
4.2 Open.) 

Save

This function allows you to save the current 
configuration data to the hard disk or other 
external storage devices.  (Refer to 4.3 
Save.)

Save As

This function allows you to name the current 
configuration data and save it to the hard 
disk or other external storage devices.  
(Refer to 4.4 Save As.)

Print This function allows you to print out the 
configuration data.  (Refer to 4.5 Print.)

Print Preview
This function allows you to view the print 
image of the configuration data.  (Refer to 
4.6 Print Preview.)

Exit This function allows you to exit the KPG-
89D program.  (Refer to 4.7 Exit.)

Function Description

Model 
Information

This function allows you to configure the 
model name and the frequency.  (Refer to 
5.1 Model Information.)
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3 MENU DESCRPTION
3.2.3 Edit Menu

Figure 3-9   Edit Menu

Table 3-4   Function List of the Edit Menu

3.2.4 Program Menu

Figure 3-10   Program Menu

Table 3-5   Function List of the Program Menu

3.2.5 Tools Menu

Figure 3-11   Tools Menu

Table 3-6   Function List of the Tools Menu

Function Description

Zone Information
This function allows you to configure the 
Zone data.  (Refer to 6.1 Zone Information 
Window.)

Optional 
Features

This function allows you to configure the 
transceiver’s functions.  (Refer to 6.7 
Optional Features Window.)

Key Assignment
This function allows you to assign functions 
to the PF keys.  (Refer to 6.8 Key 
Assignment Window.)

Scan Information
This function allows you to configure the 
Scan function parameters.  (Refer to 6.9 
Scan Information Window.)

DTMF
This function allows you to configure the 
DTMF parameters. (Refer to 6.10 DTMF 
Window.)

2-tone
This function allows you to configure the 2-
tone signaling parameters. (Refer to 6.11 2-
tone Window.)

FleetSync
This function allows you to configure the 
FleetSync function.  (Refer to 6.12 
FleetSync Window.)

Special Alert 
Tone

This function allows you to configure the 
Special Alert Tone parameters.  (Refer to 
6.13 Special Alert Tone Window.)

Emergency 
Information

This function allows you to configure the 
Emergency Mode parameters.  (Refer to 
6.14 Emergency Information Window.)

Extended 
Function

This function allows you to configure the 
optional board, the Auxiliary ports, and the 
Modulation Line parameters.  (Refer to 6.15 
Extended Function Window.)

Zone Merge You can use the Zone Merge function.  
(Refer to 6.16 Zone Merge Window.)

Test Frequency
This function allows you to configure the 
Test Frequency (Test Channel) used in Test 
Mode.  (Refer to 6.17 Test Frequency.)

Embedded 
Message

This function allows you to configure the 
characters to be stored in the transceiver.  
(Refer to 6.18 Embedded Message 
Window.)

Embedded 
Message w/
Password

This function allows you to configure the 
characters to be stored in the transceiver 
and the password to protect the stored 
characters.  (Refer to 6.19 Embedded 
Message w/Password.)

Function Description

Read Data from 
the Transceiver

This function allows you to read the 
configuration data from the transceiver by 
using the KPG-89D.  (Refer to 7.1 Read 
Data from the Transceiver.)

Write Data to the 
Transceiver

This function allows you to write the 
configuration data to the transceiver using 
the KPG-89D.  (Refer to 7.2 Write Data to 
the Transceiver.)

Test Mode
This function allows you to test or adjust the 
transceiver using the KPG-89D.  (Refer to 
7.3 Test Mode.)

Function Description

Transceiver 
Information

This function allows you to read the data 
from the transceiver. (Refer to 8.1 
Transceiver Information.)

Function Description
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3 MENU DESCRPTION
3.2.6 Setup Menu

Figure 3-12   Setup Menu

Table 3-7   Function List of the Setup Menu

3.2.7 View Menu

Figure 3-13   View Menu

Table 3-8   Function List of the View Menu

3.2.8 Window Menu

Figure 3-14   Window Menu

Table 3-9   Function List of the Window Menu

3.2.9 Help Menu

Figure 3-15   Help Menu

Table 3-10   Function List of the Help Menu

Function Description

COM port

You can assign the serial communication 
port used to make the data communication 
between the KPG-89D and the transceiver 
to the serial communication port of the PC.  
(Refer to 9.1 COM port.)

Language File 
Setup

You can select the language used in the 
KPG-89D.  (Refer to 9.2 Language File 
Setup.)

Function Description

Tree View
This function allows you to view the contents 
of the Edit menu in the list format.  (Refer to 
10.1 Tree View.)

Toolbar This function allows you to display/hide the 
Toolbar.  (Refer to 10.2 Toolbar.)

Status Bar This function allows you to display/hide the 
Status bar.  (Refer to 10.3 Status Bar.)

Function Description

Cascade
This function allows you to rearrange the 
opened windows in an overlapped fashion 
(cascade format).  (Refer to 11.1 Cascade.)

Horizontal Tile
This function allows you to rearrange the 
opened windows in the horizontal tiles 
fashion.  (Refer to 11.2 Horizontal Tile.) 

Vertical Tile
This function allows you to rearrange the 
opened windows in the vertical tiles fashion.  
(Refer to 11.3 Vertical Tile.) 

Arrange Icons
This function allows you to rearrange the 
icons of the minimized windows.  (Refer to 
11.4 Arrange Icons.)

Close All 
Windows

This function allows you to close all the 
opened windows.  (Refer to 11.5 Close All 
Windows.)

Opened Window 
List

This function allows you to list all opened 
windows.  When clicking the title of the 
window, the selected window appears.  
(Refer to 11.6 Opened Window List.)

Function Description

Help Topics This function allows you to search for the 
help topics.  (Refer to 12.1 Help Topics.)

About KPG-89D
This function allows you to view the 
information about the KPG-89D.  (Refer to 
12.2 About KPG-89D.)
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3 MENU DESCRPTION
3.3 Shortcut Keys

You can configure the following shortcut keys using the 
KPG-89D.

3.3.1 Menu Bar Operation

Table 3-11   Shortcut Keys Used in the Menu Bar

3.3.2 File Menu Operation

Table 3-12   Shortcut Keys used in the File Menu

3.3.3 Zone Information (Conventional 
Group) Window

Table 3-13   Zone Information (Conventional Group) 
Window Shortcut Keys

3.3.4 Zone Information (Trunking 
System) Window

Table 3-14   Zone Information (Trunking System) Window
Shortcut Keys

Key Name Function

[Alt]
[F10]

You can use the Menu Bar.
The File menu opens in the same way as 
the cursor is placed on the “File” in the menu 
bar.

[←]
[→]

You can select the menu title using [←] and 
[→] after selecting the menu bar using [Alt] 
or [F10].

[↑]
[↓]

You can open the selected menu and select 
the function to be executed.

[Enter]

Press [Enter] while selecting the menu title 
to open the menu.

Press [Enter] while the menu is opened to 
execute the selected function.

Key Name Function

[Ctrl] + [N] Select File > New.  (Refer to 4.1 New.)

[Ctrl] + [O] Select File > Open.  (Refer to 4.2 Open.)

[Ctrl] + [S] Select File > Save.  (Refer to 4.3 Save.)

[Ctrl] + [P] Select File > Print.  (Refer to 4.5 Print.)

Key Name Function

[F7] The Zone number can be increased in steps of 
1.

[F8] The Zone number can be decreased in steps of 
1.

[F9]
You can display the Zone Edit (Conventional 
Group) window.  (Refer to 6.2 Zone Edit 
Window (Conventional Group).)

[F11] You can display the Channel Edit window.  
(Refer to 6.3 Channel Edit Window.)

[Shift] + [F3]

You can display the Channel Copy window.  
You can also copy the configured channel data 
to the specified channel.  (Refer to 6.3.19 
Channel Copy ([Shift] + [F3]).)

[Shift] + [F4]

You can display the Frequency Copy window.  
You can copy the Receive Frequency data to 
the Transmission Frequency data.  (Refer to 
6.3.20 Frequency Copy ([Shift] + [F4]).)

[Shift] + [F5]

You can display the QT/DQT Copy window.  
You can copy the QT/DQT Decode of the 
selected channel to the “QT/DQT Encode” data.  
(Refer to 6.3.20 Frequency Copy ([Shift] + 
[F4]).)

[Shift] + [F7]
You can display the Channel Jump window.  
You can jump to the specified channel.  (Refer 
to 6.3.21 Channel Jump.)

Key Name Function

[F6]
You can display the Repeater Information 
window.  (Refer to 6.4 Repeater Information 
Window.)

[F7] The Zone number can be increased in steps of 
1.

[F8] The Zone number can be decreased in steps of 
1.

[F9]
You can display the Zone Edit (Trunking 
system) window.  (Refer to 6.5 Zone Edit 
Window.)

[F11] You can display the GID Edit window.  (Refer to 
6.6 GID Edit Window.)

[Shift] + [F3]
You can display the GID Copy window.  You can 
copy the selected GID data to the specified GID.  
(Refer to 6.6.18 GID Copy ([Shift] + [F3]).)
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3 MENU DESCRPTION
3.3.5 Program Menu

Table 3-15   Shortcut Keys used in the Program Menu

3.3.6 Help Menu

Table 3-16   Shortcut Keys used in Help Menu

[Shift] + [F7]
You can display the GID Jump window.  You 
can jump to the specified GID.  (Refer to 6.6.19 
GID Jump.)

Key Name Function

[Ctrl] + [R]
Select “Program” > “Read Data from the 
Transceiver”.  (Refer to 7.1 Read Data from the 
Transceiver.)

[Ctrl] + [W]
Select “Program”> “Write Data to the 
Transceiver”.  (Refer to 7.2 Write Data to the 
Transceiver.)

[Ctrl] + [T] Select “Program” > “Test Mode”.  (Refer to 7.3 
Test Mode.)

Key Name Function

[F1]

You can display the KPG-89D HTML Help 
window.  The help topic for the selected 
operation appears when the [F1] key is 
pressed.  (Refer to 12 Help Menu.)

Key Name Function
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4 FILE MENU

4.1 New

Select “File” > “New” to create the new data file.  You can 
clear the current configuration data and create the new 
data file.
The default file name for a new file will be “kpg89d.dat”.
Follow the procedures below to create a new file.
1. Select “File” > “New”.

A warning message appears.

Figure 4-1   File New

2. You can select one of the following options.
• Click “OK”.

You can delete all of the opened configuration 
data.
You can clear the current configuration data and 
create a new data file.

• Click “Cancel”.
The opened configuration data will not be deleted.
No file will be created.

4.2 Open

This function allows you to open the configuration data 
file stored in the hard disk or other external storage 
devices (file extension: .dat/ .sdt).
Follow the procedures below to open the configuration 
data.
1. Select “File” > “Open”.

The Open window appears.

Figure 4-2   File Open

2. Select the configuration data file to open.
Select a file name you want to open.
The embedded message appears if the selected file 
contains an embedded message.  (Refer to 6.18 
Embedded Message Window.)

3. Click “Open”.
You can read the file selected at the previous step 
using the KPG-89D. 
The error message appears when the selected file 
contains data that is not supported by the KPG-89D. 

Figure 4-3   File Open Error Message
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4 FILE MENU
4.3 Save

This function allows you to store the current configuration 
data to the hard disk or other external storage devices.
Follow the procedures below to save the configuration 
data.
1. Select “File” > “Save”.

The configuration data is stored as a new file.
A warning message appears if a file with the same 
name exists in the destination folder. 

Figure 4-4   File Save

2. You can select one of the following options.
• Click “OK”.

You can store the new configuration data to the 
storage device.

• Click “Cancel”.
This option allows you to stop saving the 
configuration data.  The new configuration data will 
not be stored.

4.4 Save As

This function allows you to name the current configuration 
data and store it to the hard disk or other external storage 
devices.
Follow the procedures below to name and save the 
configuration data.
1. Select “File” > “Save As”.

The File Type Confirmation window appears.

Figure 4-5   Save As Confirmation Window

2. Click “Data File” to store the configuration data as a 
data file, or Source File to store the data as a source 
file.
The Save As window appears.

Figure 4-6   Save As

3. Enter the file name.
You can assign a maximum of 32 characters to a file 
name.  When assigning 33 or more characters, the 
following error message appears.

Figure 4-7   Save As Error Message

4. Click “Save”.
You can store the configuration data with the file name 
entered in the previous step.
A warning message appears if a file with the same 
name exists in the target folder. 

Figure 4-8   Save As Warning Message
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4 FILE MENU
5. You can select one of the following options.
• Click “Yes”.

You can store the new configuration data to the 
storage device.

• Click “Cancel”.
This option allows you to stop saving the 
configuration data.  The current configuration data 
will not be stored.

4.5 Print

You can print out the configuration data.
Follow the procedures print the configuration data.
1. Select “File” > “Print”.

The Printout List appears and you can view the KPG-
89D configuration data.

Figure 4-9   Printout List 1

2. Confirm the checkbox of the configuration data item 
that you want to print.

Figure 4-10   Printout List 2

Note:

! The Model checkbox and the Embedded Message checkbox 
are checked as default configuration.

! The Start Zone edit box and the End Zone edit box appear 
when checking the Zone Information checkbox

3. Click “OK”.
You can print out the KENWOOD KPG-89D 
Transceiver Programming Information.  (Refer to 4.6 
Print Preview.)

4.5.1 Print List Item

" Model
You can configure the “Model Information” parameters 
to print.  (Refer to 5.1 Model Information.)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Checked (Enabled)
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4 FILE MENU
" Optional Features
You can configure the Optional Features parameters 
to print.  (Refer to 6.7 Optional Features Window.)

" Key Assignment
You can configure the Key Assignment parameters to 
print.  (Refer to 6.8 Key Assignment Window.)

" Scan Information
You can configure the Scan Information parameters to 
print.  (Refer to 6.9 Scan Information Window.)

" DTMF
You can configure the DTMF parameters to print.  
(Refer to 6.10 DTMF Window.)

" 2-tone
You can configure the 2-tone parameters to print.  
(Refer to 6.11 2-tone Window.)

" FleetSync
You can configure the FleetSync parameters to print.  
(Refer to 6.12 FleetSync Window.)

" Special Alert Tone
You can configure the Special Alert Tone parameters 
to print.  (Refer to 6.13 Special Alert Tone Window.)

" Emergency Information
You can configure the Emergency Information 
parameters to print.  (Refer to 6.14 Emergency 
Information Window.)

" Extended Function
You can configure the Extended Function parameters 
to print.  (Refer to 6.15 Extended Function Window.)

" Test Frequency
You can configure the Test Frequency parameters to 
print.  (Refer to 6.17 Test Frequency.)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)
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4 FILE MENU
" Embedded Message
You can configure the Embedded Message 
parameters to print.  (Refer to 6.18 Embedded 
Message Window.)

" Embedded Message w/Password
You can configure the Embedded Message w/
Password parameters to print.  (Refer to 6.19 
Embedded Message w/Password.)

" Zone Information
You can configure the Zone Information parameters to 
print.  (Refer to 6.1 Zone Information Window.)

" Start Zone - End Zone
You can configure the start zone and the end zone 
only when the Channel Information checkbox is 
checked.
You can select the channel to print from the channels 
1 to 128.

Note: The value of the Start Channel must be lower than the 
End Channel value.  The End Channel will be equal to 
the Start Channel if you enter the higher value in the 
Start Channel than the End Channel.

" Total Pages
The total number of pages appears.

" Print Setup Button
Click “Print Setup” to display the Print Setup window.  
You can configure the printer used to print out the 
configuration data, the paper size, and the paper 
rotation.

" Print Preview Button
Click “Print Preview” to display the Print Preview 
window.  (Refer to 4.6 Print Preview.)

" Clear All Button
Click “Clear All” to uncheck all checkboxes.

" Select All Button
Click “Select All” to check all checkboxes.

" OK Button
Click “OK” to print the checked items.

" Cancel Button
Click “Cancel” to close the Printout List window 
without printing any parameters.

" Help Button
Click “Help” to display the KPG-89D HTML Help 
window.  The help topics for Print appear.  (Refer to 12 
Help Menu.)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Checked (Enabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Check (Enable) The parameters can be 

printed.

Uncheck (Disable) The parameters will not 
be printed.

Default Unchecked (Disabled)

Range
Start Zone End Zone 

1 - 128 1 - 128

Default 1 128
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4 FILE MENU
4.6 Print Preview

You can view the print image after selecting items to be 
printed in the Print Out List.
Follow the procedures to preview the print image.
1. You can select one of the following options.

• Select “File” > “Print Preview”.
The Printout Preview window appears and the 
print image will be displayed.

• Click “Print Preview” in the Printout List window.  
(Refer to 4.5.1 Print List Item.)
The Printout Preview window appears and the 
print image of the items selected in the Print List 
will be displayed.

Figure 4-11   Print Preview

4.6.1 Toolbar in the Print Preview

You can switch the display and move to the other page by 
clicking the buttons on the toolbar located on the top of 
the window.

Figure 4-12   Print Preview Toolbar

" Print Button
Click “Print” to display the Print List window.  (Refer 
to 4.5.1 Print List Item.)

" Next Page/ Prev Page Button
Click “Next Page” to view the next page of the current 
print image.
Click “Prev Page” to view the previous page of the 
current print image.

Note:

! You can click “Next Page” only when there are more than 
one page(s).

! You can click “Prev Page” only when there are preceding 
page(s).

" Two Page/ One Page Button
Click “Two Page” to display two pages at the same 
time.
Click “One Page” to display only one pages at the 
same time.

Note:

! The “Two Page” button appears when the layout of the print 
image is “One Page”.

! The “One Page” button appears when the layout of the print 
image is “Two Page”.

! The two page display is disabled when clicking “Zoom In” 
while the layout of the print image is two page.  When 
clicking “Zoom Out”, the layout of the print image returns to 
Two Page. 

" Zoom In/ Zoom Out Button
Click “Zoom In” to enlarge the print image.
Click “Zoom Out” to zoom out the print image.

Note:

! You can click “Zoom In” only when the print image can be 
enlarged.

! You can click “Zoom Out” only when the print image can be 
zoomed out.

! You can enlarge the print image when the magnifying glass 
icon appears on the image. You can zoom out the print 
image when the cursor returns to normal.

" Close Button
Click “Close” to close the Print Preview window and 
return to the main window or the Print Out List 
window.
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4.7 Exit

This function allows you to exit the KPG-89D program.
Follow the procedures to exit the KPG-89D.
1. Select “File” > “Exit”.

The confirmation dialog box appears to exit the KPG-
89D program.

Figure 4-13   File Exit 1

2. You can select one of the following options.
• Click “No”.

Close the confirmation dialog box.  In this case, 
you cannot exit the KPG-89D program.

• Click “Yes”.
You can immediately exit the KPG-89D program 
when the configuration data has not been modified 
or already stored.  The confirmation dialog box 
appears to ask you to store the configuration data 
if you have modified the configuration data. 

Figure 4-14   File Exit 2

3. You can select one of the following options.
• Click “Cancel”.

Close the confirmation dialog box.  In this case, 
you cannot exit the KPG-89D program.

• Click “No”.
You can exit the KPG-89D program without storing 
the configuration data to the storage device.

• Click “Yes”.
The Save As window appears.  (Refer to 4.4 Save 
As.)
You can exit the KPG-89D program after storing 
the configuration data to the storage device.
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5.1 Model Information

You can configure the transceiver’s model type and 
frequency in the Model Information window.

Figure 5-1   Model Information Window

Note:

! The following warning messages appear when clicking “OK”.

•The frequency can be changed without changing the model 
name (TK-2180/ 3180 and TK-7180/ 8180).

Figure 5-2   Model Information Warning Message 1
•The Model Name (TK-2180/ 3180 and TK-7180/ 8180) is 

changed without changing the frequency.

Figure 5-3   Model Information Warning Message 2
•Both of the Model Name (TK-2180/ 3180 and TK-7180/ 8180) 

and the frequency are changed.

Figure 5-4   Model Information Warning Message 3

! Click “OK” to delete all configured data and create a new data 
with the selected Model Type and the transmit/receive 
frequency.  Click “Cancel” to return to the Model Information 
window without changing the model type and the transmit/ 
receive frequency.

5.1.1 Model Name

This function allows you to select the model name from 
the pulldown menu.

5.1.2 Frequency

You can configure the frequency bandwidth to transmit/ 
receive.  You can select the frequency bandwidth 
according to the model type using the pulldown menu.

Range

• TK-2180 [Portable]
• TK-3180 [Portable]
• TK-7180 [Mobile]
• TK-8180 [Mobile]

Default TK-7180 [Mobile]

Model Market 
Code

Transmit/ Receive 
Frequency [MHz] Default

TK-2180 K 136 - 174 136 -174

TK-3180 K 450 - 520
400 - 470 450 - 520

TK-7180 K 136 - 174 136 - 174

TK-8180 K
450 - 520

400 - 470 *1

*1  Supports the updated version

450 - 520
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6 EDIT MENU

6.1 Zone Information Window

In the Zone Information window, configure the zone data 
to be used when the transceiver is transmitting and 
receiving.
A maximum of 128 zones in the Conventional Group/ 
Trunking sytem can be configured to the transceiver.  
A maximum of 512 CH/GIDs can be configured to the 
transceiver.  (Refer to 6.3 Channel Edit Window.)

6.1.1 Common to Conventional 
Group/Trunking System

Figure 6-1   Zone Information Window

" Zone
Configure the Zone number to be configured.  Enter a 
value directly in the edit box or click the spin button to 
configure.

" Zone Type
Configure the Zone Type.  Select the Zone Type from 
the pulldown menu.

" Zone Name
Configure the Zone Name.  Enter the Zone Name 
directly in the edit box to configure the Zone Name.

" Free 
Displays the remaining amount of memory that can be 
used for the Zone Information window.

" Zone Up/Zone Down Button
Click “Zone Up” to move up the Zone number.
Click “Zone Down” to move down the Zone number.

" Close Button
Click “Close” to close the Zone Information window.

" Help Button
Click “Help” to open the KPG-89D HTML Help 
window.  Help and topics about Zone Information are 
displayed.  (Refer to 12 Help Menu.)

6.1.2 Conventional Group

Figure 6-2   Zone Information Window (Conventional Group)

" Receive Frequency
Configure the frequency to be used when the 
transceiver receives.  Enter the frequency directly in 
the edit box to configure the frequency.

Note:

! Available frequency range varies depending on the 
transceiver model.  (Refer to FUNC 1.2 Receive/Transmit 
Frequency.)

!  A maximum of 9-digit frequency and “.” (period) can be 
entered.

! When a value outside of the available range is entered, a 
confirmation message appears, and the value is replaced 
with the frequency value automatically (upper limit value or 
lower limit value) configured at the Model Information 
window > Frequency.

! Other items on the same channel can be configured only 
when Receive Frequency value is configured to Receive 
Frequency.

Range 1 - 128

Default 1

Range Conventional Group/ Trunking System

Default Conventional Group

Range A maximum of 12 alphanumeric characters

Available 
Characters

(space) ! “ # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default **1 - 128 (The Zone number is automatically 
entered.)

Range
TK-2180/ 7180 136 - 174 MHz

TK-3180/ 8180 450 - 520 MHz
400 - 470 MHz

Default Blank
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! When Receive Frequency is deleted, other items on the 
same channel are also automatically deleted.

! When Receive Frequency is configured, the same value as 
Receive Frequency is configured to Transmit Frequency.

" Transmit Frequency
Configure the frequency to transmit.  Enter the 
frequency directly in the edit box to configure the 
frequency.

Note:

! Available frequency range varies depending on the 
transceiver model.  (Refer to FUNC 1.2 Receive/Transmit 
Frequency.)

! A maximum of 9-digit frequency and “.” (period) can be 
entered.

! When a value outside of the available range is entered, a 
confirmation message appears, and the value is replaced 
with the frequency value automatically (upper limit value or 
lower limit value) configured at the Model Information > 
Frequency.

! Transmit Frequency can be configured only when a value is 
configured in the Receive Frequency edit box.

" QT/DQT Dec (Decode)
Configure the signaling for standby to be used when 
the transceiver is receiving.  Select the QT tone or 
DQT code from the pulldown menu, or directly enter it 
in the edit box.
# When selecting from the pulldown menu:

# When entering directly in the edit box:

Note:

! A maximum of 5-digit QT and DQT having numbers and “N”, 
“D”, “I” and “.” (period) can be entered.

! When only numbers and “.” (period) are entered, the entry is 
configured as a QT tone.

! When a text string prefixed by “D” is entered, the entry is 
configured as a DQT code.

! When the entire content of the edit box is deleted, None will 
be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

! QT/DQT Dec can be configured only when a value is 
configured in the Receive Frequency edit box.

" QT/DQT Enc (Encode)
Configure the signaling for calling to be used when the 
transceiver is transmitting.  Select the QT tone or DQT 
code from the pulldown menu, or directly enter it in the 
edit box.
# When selecting from the pulldown menu:

# When entering directly in the edit box:

Note:

! A maximum of 5-digit QT and DQT having numbers and “N”, 
“D”, “I” and “.” (period) can be entered.

! When only numbers and “.” (period) are entered, the entry is 
configured as a QT tone.

! When a text string prefixed by “D” is entered, the entry is 
configured as a DQT code.

! When the entire content of the edit box is deleted, None will 
be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

! QT/DQT Enc can be configured only when a value is 
configured in the Receive Frequency edit box.

" Channel Name
Configure the channel name of the channel to be 
configured.  The channel name can be entered 
directly in the edit box to configure the channel name.

Range
TK-2180/ 7180 136 - 174 MHz

TK-3180/ 8180 450 - 520 MHz
400 - 470 MHz

Default Blank

Range

QT 67.0 - 250.3 Hz

DQT (Normal) D023N - D754N

DQT (Inverted) D023I - D754I

Default None

Range

QT 67.0 - 254.1 Hz

DQT (Normal) D000N - D777N

DQT (Inverted) D000I - D777I

Step
QT 0.1 Hz

DQT 1

Default None

Range

QT 67.0 - 250.3 Hz

DQT (Normal) D023N - D754N

DQT (Inverted) D023I - D754I

Default None

Range

QT 67.0 - 254.1 Hz

DQT (Normal) D000N - D777N

DQT (Inverted) D000I - D777I

Step
QT 0.1 Hz

DQT 1

Default None

Range A maximum of 12 alphanumeric characters

Available 
Characters

(space) ! “ # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 
: ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L M N 
O P Q R S T U V W X Y Z a b c d e f g h i j k l m n 
o p q r s t u v w x y z { | } ~

Default CH nnn (The channel number is entered 
automatically.)



Note:

! When the entire content of the edit box is deleted, this item 
will be configured as a blank.

! Channel Name can be configured only when a value is 
configured in the Receive Frequency edit box.

" Power (Transmit Power)
Configure the transmit power of each channel.  Select 
the desired transmit power from the pulldown menu.

Note: Transmit Power can be configured only when a value is 
configured in the Receive Frequency and Transmit 
Frequency edit boxes.

" W/N (Wide/ Narrow)
Configure the channel bandwidth of each channel. 
Select the desired channel bandwidth from the 
pulldown menu.

Note: W/N can be configured only when a value is configured 
in the Receive Frequency edit box.

" Scan Add
From the pulldown menu, select whether or not the 
transceiver scans each channel during the scan.

Note: Scan Add can be configured only when a value is 
configured in the Receive Frequency edit box.

" Optional Signaling
Configure the Optional Signaling of each channel. 
Select the desired Optional Signaling from the 
pulldown menu.

Note: Optional Signaling can be configured only when a value 
is configured in the Receive Frequency edit box.

" Zone Edit Button
Click “Zone Edit” to open the Zone Edit window. 
(Refer to 6.2 Zone Edit Window (Conventional 
Group).)

Note: An error message appears when there is no data 
configured to a zone.

" Channel Edit Button
Click “Channel Edit” to open the Channel Edit 
window.  (Refer to 6.3 Channel Edit Window.)

" Channel Copy ([Shift] + [F3])
Existing channel data can be copied to other 
channels.
To do this, follow the procedures below:
1. Select the channel to be copied.

The channel can be selected by clicking the 
channel number.

2. Press [Shift] + [F3] on the keyboard.
The Channel Copy window appears.

Figure 6-3   Channel Copy Window

3. Select the desired channel to copy to.
Enter a value directly in the edit box or click the 
spin button to configure.

4. Click “Copy”.
The configured data is copied to the copy target 
channel.

Note:

! This operation is possible only when data is currently 
configured to the copy source channel.

! Only numbers within the range 1 to 250 can be entered.

! When the entire content of the edit box is deleted, 1 will be 
configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

" Frequency Copy ([Shift] + [F4])
Data configured to Receive Frequency can be copied 
to Transmit Frequency of the same channel.
To do this, follow the procedures below:

Range High/ Low

Default High

Range Wide/ Narrow

Default Wide

Range Yes/ No

Default Yes

Range None/ DTMF/ 2-tone 1/ 2-tone 2/ 2-tone 3/ 
2-tone 4/ FleetSync

Default None



1. Select the channel to be copied.
The channel can be selected by clicking the 
channel number.

2. Press [Shift] + [F4] on the keyboard.
The Frequency Copy window appears.

Figure 6-4   Frequency Copy Window

3. Click “Copy”.
the Receive Frequency data is copied to Transmit 
Frequency of the same channel.

Note:

! This operation is possible only on channels in which data is 
currently configured to Receive Frequency.

! Receive Frequency configuration data cannot be copied to 
other channels.

! When a frequency is entered directly in the Frequency 
Copy window, that value is configured as the frequency of 
Transmit Frequency.  In this case, only frequencies up to 9-
digit numbers and “.” (period) can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

" QT/DQT Copy ([Shift] + [F5])
Data configured to QT/DQT Decode can be copied to 
QT/DQT Encode of the same channel.
To do this, follow the procedures below:
1. Select the channel to be copied.

The channel can be selected by clicking the 
channel number.

2. Press [Shift] + [F5] on the keyboard.
The QT/DQT Copy window appears.

Figure 6-5   QT/DQT Copy Window

3. Click “Copy”.
QT/DQT Decode data is copied to QT/DQT 
Encode of the same channel.

Note:

! This operation is possible only on channels in which data is 
currently configured to QT/DQT Decode.

! QT/DQT Decode configuration data cannot be copied to 
other channels.

! When the QT/DQT Encode value is selected or entered 
directly in the QT/DQT Copy window, that value is 
configured as QT/DQT Encode.  In this case, a maximum of 
5-digit QT and DQT having numbers and “N”, “D”, “I” and “.” 
(period) can be entered.

! When the entire content of the edit box is deleted, None will 
be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

" Channel Jump ([Shift] + [F7])
Specified channels can also be jumped to.
To do this, follow the procedures below:
1. Press [Shift] + [F7] on the keyboard.

The Channel Jump window appears.

Figure 6-6   Channel Jump Window

2. Enter the channel number to be displayed.
Enter a value directly in the edit box or click the 
spin button to configure.

3. Click “Jump”.
The specified channel appears.

Note:

! Only numbers within the range 1 to 250 can be entered.

! When the entire content of the edit box is deleted, 1 will be 
configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.



" Context Menu
If you select and right-click the channel number, 
Context Menu appears, and then operations such as 
copy and delete of configuration data can be 
performed.

Figure 6-7   Context Menu

Table 6-1   Context Menu

6.1.3 Trunking System

Figure 6-8   Zone Information Window (Trunking System)

" Encode ID
Configure the Encode ID to be used when the 
transceiver transmits.  Enter the Encode ID number 
directly in the edit box to configure the Encode ID 
number.

Note:

! A maximum of 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, this item 
will be configured as a blank.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

" Decode ID
Configure the Decode ID to be used when the 
transceiver is receiving.  Enter the Decode ID number 
directly in the edit box to configure the Decode ID 
number.

Note:

! A maximum of 3-digit numbers can be entered.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

! When the value of the Decode ID edit box is deleted, the 
other items of the same Group ID are automatically deleted.

" GID Name
Configure the Group ID name of the Group ID to be 
configured.  Enter the Group ID name directly in the 
edit box to configure the Group ID name.

Note:

! When the entire content of the edit box is deleted, this item 
will be configured as a blank.

! GID Name can be configured only when a value is 
configured in the Decode ID edit box.

" Call (Call Indicator)
Configure whether or not to leave behind a call 
indicator when a user cannot answer a call.  (Refer to 
FUNC 17.2.6 Call Indicator.)

Note: Call can be configured only when a value is configured 
in the Decode ID edit box.

Function Description

Copy Copies the currently selected channel data.

Paste Pastes the copied channel data.

Delete Deletes the currently selected channel data.

to Clipboard Copies the currently selected channel data to 
the Clipboard as text data.

to Clipboard 
(w/headings)

Copies the currently selected channel data to 
the Clipboard as text data with a heading.

Range Blank/ 1 - 250

Step 1

Default Blank

Range Blank/ 1 - 250

Step 1

Default A value entered by Encode ID

Range A maximum of 12 alphanumeric characters

Available 
Characters

(space) ! “ # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 
: ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L M N 
O P Q R S T U V W X Y Z a b c d e f g h i j k l m n 
o p q r s t u v w x y z { | } ~

Default GR nnn (The Group ID number is automatically 
entered.)

Range

Check (Enable) Activates the Call Indicator 
when a GID is received.

Uncheck (Disable)
Does not activate the Call 
Indicator when a GID is 
received.

Default Unchecked (Disabled)



" Power (Transmit Power)
Configure the transmit power of each channel.  Select 
the desired transmit power from the pulldown menu.

Note: Power can be configured only when a value is 
configured in the Decode ID and Encode ID edit boxes.

" Transpond
Configure to enable or disable the Transpond function 
by each Group ID.  Select the desired Transpond from 
the pulldown menu.

Note:

! Transpond can be configured only when a value is 
configured in the Decode ID and Encode ID edit boxes.

! Transpond cannot be configured when an item other than 
“None” is selected in the Opt Signal pulldown menu.

" Scan Add
From the pulldown menu, select whether or not the 
transceiver scans each Group ID during the scan.

Note: Scan Add can be configured only when a value is 
configured in the Decode ID edit box.

" Optional Signaling
Configure the Optional Signaling of each Group ID.  
Select the desired Optional Signaling format from the 
pulldown menu.

Note: Optional Signal can be configured only when a value is 
configured in the Decode ID edit box.

" TA (Talk Around)
Configure to enable or disable the Talk Around 
function by each Group ID.  Select the desired Talk 
Around option from the pulldown menu.

Note: TA can be configured only when a value is configured in 
the Decode ID edit box.

" Repeater Button
Click “Repeater” to open the Repeater Information 
window.  (Refer to 6.4 Repeater Information Window.)

Note: An error message appears when there is no data 
configured to a zone.

" Zone Edit Button
Click “Zone Edit” to open the Zone Edit window. 
(Refer to 6.5 Zone Edit Window.)

Note: An error message appears when there is no data 
configured to a zone.

" GID Edit Button
Click “GID Edit” to open the GID Edit window.  (Refer 
to 6.6 GID Edit Window.)

" GID Copy ([Shift] + [F3])
Existing GID data can be copied to other channels.
To do this, follow the procedures below:
1. Select the GID to be copied.

The GID can be selected by clicking the GID 
number.

2. Press [Shift] + [F3] on the keyboard.
The GID Copy window appears.

Figure 6-9   GID Copy Window

3. Select the desired GID to copy to.
Enter a value directly in the edit box or click the 
spin button to configure.

4. Click “Copy”.
The configured data is copied to the copy target 
GID.

Range High/ Low

Default High

Range Yes/ No

Default No

Range Yes/ No

Default Yes

Range None/ DTMF/ FleetSync

Default None

Range Yes/ No

Default No
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Note:

! This operation is possible only when data is currently 
configured to the copy source GID.

! Only numbers within the range 1 to 250 can be entered.

! When the entire content of the edit box is deleted, 1 will be 
configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

" GID Jump ([Shift] + [F7])
Specified GIDs can also be jumped to.
To do this, follow the procedures below:
1. Press [Shift] + [F7] on the keyboard. 

The GID Jump window appears.

Figure 6-10   GID Jump Window

2. Enter the GID number to be displayed.
Enter a value directly in the edit box or click the 
spin button to configure.

3. Click “Jump”.
The specified GID appears.

Note:

! Only numbers within the range 1 to 250 can be entered.

! When the entire content of the edit box is deleted, the lower 
limit value will be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

" Context Menu
If you click the GID number to select the GID and 
right-click the GID number, Context Menu appears, 
and operations such as copy and delete of 
configuration data can be performed.

Figure 6-11   Context Menu

Table 6-2   Context Menu

6.2 Zone Edit Window 
(Conventional Group)

Click “Zone Edit” in the Zone Information window 
(Conventional Group) to open the Zone Edit window.
In the Zone Edit window, configures the zones when the 
transceiver transmits and receives in Conventional 
Group.

Figure 6-12   Zone Edit Window

6.2.1 Zone Name

Configure the Zone Name.  Enter the Zone Name directly 
in the edit box to configure the Zone Name.

Note: When the entire content of the edit box is deleted, this item 
will be configured as a blank.

Function Description

Copy Copies the currently selected GID data.

Paste Pastes the copied GID data.

Delete Deletes the currently selected channel data.

to Clipboard Copies the currently selected GID data to the 
Clipboard as text data.

to Clipboard 
(w/headings)

Copies the currently selected GID data to the 
Clipboard as text data with a heading.

Range A maximum of 12 alphanumeric characters

Available 
Characters

(space) ! “ # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default **1 - **128 (The zone number is automatically 
entered.)
Version: 1.11 Field Programming Reference 25



6 EDIT MENU
6.2.2 Data Zone-CH/GID

Configure the Zone-CH/GID to be used when 
communicating data.  Enter a value for Zone-CH/GID 
directly in the edit box, or select it from the pulldown 
menu.  (Refer to FUNC 16.1.2 Data Zone-CH/GID.)

Note:

! A maximum of 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, None will be 
configured.

! When None is configured in the Zone edit box, None will be 
configured also in the CH/GID edit box.

! When an unavailable Zone-CH/GID is entered, an error 
message appears, and the value returns to its original value.

! When a value is configured in the Zone edit box, and either 
“Close” is clicked or writing data with the CH/GID edit box in a 
None state, an error message appears.

6.2.3 Home Channel

Configure the channel to move when the PF Home CH/
GID key is pressed.  Enter a value for Home Channel 
directly in the edit box, or select it from the pulldown 
menu.  (Refer to FUNC 2.7 Home CH/GID.)

Note:

! A maximum of 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, None will be 
configured.

! Home Channel can be configured only when PF Home CH/GID 
is configured to any key.

! When an unavailable channel is entered, an error message 
appears, and the value returns to its original value.

6.2.4 Home Channel Operator 
Selectable

Configure whether or not to enable changes to Home CH/
GID by using PF.  When Home Channel Operator 
Selectable is enabled, the currently selected channel can 
be changed to Home CH/GID by holding down the PF 
Home CH/GID key for 3 seconds.  (Refer to FUNC 16.1.4 
Home Channel Operator Selectable.)

Note: Home Channel Operator Selectable can be configured only 
when PF Home CH/GID is configured to any key.

6.2.5 Optional Signaling Decode 
Condition

Configure the Optional Signaling decode conditions.  The 
transceiver emits a Call Alert Tone, displays Call Alert and 
performs the Transpond operation when Optional 
Signaling is decoded and signaling matches.  (Refer to 
FUNC 16.1.5 Optional Signaling Decode Condition.)
Select the desired Optional Signaling Decode Condition 
from the pulldown menu.

6.2.6 Audio Control

Configure the conditions for deactivating mute in 
conjunction with the QT/DQT and Optional Signaling.  
When the configured conditions are met, the transceiver 
disables muting and sends received signal.  (Refer to 
FUNC 16.1.6 Audio Control.)
Select the desired Audio Control condition from the 
pulldown menu.

Range None/ Existing Zone-CH/GID

Default None

Range None/ Configured channels

Default None

Range
Check (Enable) Enables Home Channel 

Operator Selectable.

Uncheck 
(Disable)

Disables Home Channel 
Operator Selectable.

Default Unchecked (Disabled)

Range

QT/DQT
Optional Signaling performs 
decoding only when QT/DQT 
matches.

Carrier

Optional Signaling performs 
decoding when a Carrier 
(signal) is detected 
regardless of QT/DQT Mode.

Default QT/DQT
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6.2.7 Time-out Timer (TOT)

Configure the time that the transceiver is allowed to 
transmit continuously.  Enter a value for Time-out Timer 
directly in the edit box, or click the spin button to configure 
the Time-out Timer.  (Refer to FUNC 11.1.1 Time-out 
Timer.)

Note:

! A maximum of 4-digit numbers can be entered.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range.

! When the entire content of the edit box is deleted, the lower limit 
value will be configured.

! A value less than 15 seconds is discarded.

6.2.8 TOT Pre-alert

Configure the time for notifying a user that transmission is 
about to end as configured by Time-out Timer.  An Alert 
Tone sounds when the end of transmission by Time-out 
Timer exceeds the configured time.  (Refer to FUNC 
11.1.2 TOT Pre-alert.)
Enter a value for TOT Pre-alert directly in the edit box or 
click the spin button to configure the TOT Pre-alert .

Note:

! A maximum of 2-digit numbers can be entered.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value of the range.

! When the entire content of the edit box is deleted, Off will be 
configured.

! When “0” is entered, Off will be configured.

6.2.9 TOT Rekey Time

Configure the time that a user can make the next 
transmission after Time-out Timer is expired.  Enter a 
value for TOT Rekey Time directly in the edit box or click 
the spin button to configure the TOT Rekey Time.  (Refer 
to FUNC 11.1.3 TOT Rekey Time.)

Note:

! A maximum of 2-digit numbers can be entered.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value of the range.

! When the entire content of the edit box is deleted, Off will be 
configured.

! When “0” is entered, Off will be configured.

6.2.10 TOT Reset Time

Configure the time to reset Time-out Timer.  Enter a value 
for TOT Reset Time directly in the edit box or click the 
spin button to configure the TOT Reset Time.  (Refer to 
FUNC 11.1.4 TOT Reset Time.)

Note:

! A maximum of 2-digit numbers can be entered.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value of the range.

! When the entire content of the edit box is deleted, Off will be 
configured.

! When “0” is entered, Off will be configured.

Range

QT/DQT

QT/DQT is used to monitor 
communications within a Talkgroup.  
Mute is canceled by QT/DQT.
Conditions remain unchanged even 
if the transceiver transmits.

QT/DQT and 
Optional 
Signaling

Mute is not canceled unless Optional 
Signaling matches.  When Optional 
Signaling matches, QT/DQT 
disables mute.
When the transceiver transmits, it 
enters Monitor Mode, and Optional 
Signaling is disabled.  For this 
reason, mute is disabled by QT/DQT 
after transmission ends.

QT/DQT or 
Optional 
Signaling

When Optional Signaling does not 
match, QT/DQT cancels mute.
Mute is not canceled by Carrier 
Squelch while Optional Signaling 
matches.  Mute cancelling 
conditions remain unchanged even if 
the transceiver transmits.

Default QT/DQT

Range 15 - 1200 s

Step 15 s

Default 60 s

Range Off/ 1 - 10 s

Step 1 s

Default Off

Range Off/ 1 - 60 s

Step 1 s

Default Off

Range Off/ 1 - 15 s

Step 1 s

Default Off
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6.2.11 BCL Override

Configure to enable or disable the BCL Override function.  
When BCL Override is enabled, transmission is still 
possible even if Busy Channel Lockout is enabled.  (Refer 
to FUNC 12.2 BCL Override.)

6.2.12 Zone Add

Configure whether or not the transceiver scans the 
current zone during the scan.

Note: Zone Add cannot be configured when an item other than 
“Multi” is currently selected in the Scan Type pulldown menu 
in the Scan Information window.

6.2.13 Scan List

Configure whether or not the transceiver performs the list-
scan to the current zone according to the Scan List.  Also 
configure Scan List Table for the list scan.  (Refer to 
6.2.15 Scan List Table Window.)

Note: Scan List cannot be configured when an item other than 
“List” is currently selected in the Scan Type pulldown menu 
in the Scan Information window.

6.2.14 Table Button

Click “Table” to open the Scan List Table window.  (Refer 
to 6.2.15 Scan List Table Window.)

6.2.15 Scan List Table Window

Configure the zone for the List Scan.  The transceiver 
scans according to the configuration in the Scan List 
Table window.

Figure 6-13   Scan List Table Window

Note:

! The display of zones without configuration data is disabled.

! The Scan List Table window can be configured only when the 
Scan List check box is checked.

6.3 Channel Edit Window

Click “Channel Edit” in the Zone Information window to 
open the Channel Edit window. 
In the Channel Edit window, configures the channels 
when the transceiver transmits and receives in 
Conventional Group. 

Range
Check (Enable) Enables BCL Override.

Uncheck 
(Disable) Disables BCL Override.

Default Unchecked (Disabled)

Range
Check (Enable) Performs scanning.

Uncheck 
(Disable) Does not perform scanning.

Default Checked (Enabled)

Range
Check (Enable) Performs the list scan.

Uncheck 
(Disable)

Does not perform the list 
scan.

Default Unchecked (Disabled)

Range
Check (Enable) Performs the list scan.

Uncheck 
(Disable)

Does not perform the list 
scan.

Default Checked (Enabled)
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Figure 6-14   Channel Edit Window

6.3.1 Zone (Conventional Group)

Configure the Zone number to be configured.  Enter a 
value directly in the edit box or click the spin button to 
configure the zone number. 

Note:

! The zone for which “Trunking system” is selected in the Zone 
Type pulldown menu cannot be configured. 

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

6.3.2 Channel

Configure the channel number to be configured.  Enter a 
value directly in the edit box or click the spin button to 
configure the channel number. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

6.3.3 Receive Frequency

Configure the frequency to be used when the transceiver 
receives.  Enter the frequency directly in the edit box to 
configure the Receive Frequency.

Note:

! Available frequency range varies depending on the transceiver 
model.  (Refer to FUNC 1.2 Receive/Transmit Frequency.)

!  A maximum of 9-digit frequency and “.” (period) can be entered. 

! When a value outside of the available range is entered, a 
confirmation message appears, and the value is replaced with 
the frequency value automatically (upper limit value or lower 
limit value) configured in the Model Information window > 
Frequency. 

! Other items can be configured only when the Receive 
Frequency is configured to the Receive Frequency edit box. 

! When the content of the Receive Frequency edit box is deleted, 
other items on the same channel are also automatically deleted. 

! If the Transmit Frequency edit box is not configured when the 
Receive Frequency edit box is configured, the same value as 
the Receive Frequency edit box is configured to the Transmit 
Frequency edit box. 

6.3.4 Transmit Frequency

Configure the frequency to transmit.  Enter the frequency 
directly in the edit box to configure the Transmit 
Frequency.

Note:

! Available frequency range varies depending on the transceiver 
model.  (Refer to FUNC 1.2 Receive/Transmit Frequency.)

!  A maximum of 9-digit frequency and “.” (period) can be entered. 

! When a value outside of the available range is entered, a 
confirmation message appears, and the value is replaced with 
the frequency value automatically (upper limit value or lower 
limit value) configured at the Model Information window > 
Frequency. 

! Transmit Frequency can be configured only when a value is 
configured in the Receive Frequency edit box. 

Range 1 - 128

Step 1

Default Same value as Zone in Zone Information

Range 1 - 250

Step 1

Default Channel number currently selected in Zone 
Information

Range
TK-2180/ 7180 136 - 174 MHz

TK-3180/ 8180 450 - 520 MHz
400 - 470 MHz

Default Blank

Range
TK-2180/ 7180 136 - 174 MHz

TK-3180/ 8180 450 - 520 MHz
400 - 470 MHz

Default Blank
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6.3.5 QT/DQT Dec (Decode)

Configure the signaling for standby to be used when the 
transceiver is receiving.  Select the desired QT tone or 
DQT code from the pulldown menu, or directly enter a 
value in the edit box.  

# When selecting from the pulldown menu:

# When entering directly in the edit box:

Note:

! A maximum of 5-digit QT and DQT having numbers and “N”, “D”, 
“I”, and “.” (period) can be entered. 

! When only numbers and “.” (period) are entered, the entry is 
configured as a QT tone. 

! When a text string prefixed by “D” is entered, the entry is 
configured as a DQT code. 

! When the entire content of the edit box is deleted, None will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! QT/DQT Dec can be configured only when a value is configured 
in the Receive Frequency edit box. 

6.3.6 QT/DQT Enc (Encode)

Configure the signaling for calling to be used when the 
transceiver is transmitting.  Select the QT tone or DQT 
code from the pulldown menu, or directly enter a value in 
the edit box. 

# When selecting from the pulldown menu:

# When entering directly in the edit box:

Note:

! A maximum of 5-digit QT and DQT having numbers and “N”, “D”, 
“I”, and “.”  (period) can be entered. 

! When only numbers and “.” (period) are entered, the entry is 
configured as a QT tone. 

! When a text string prefixed by “D” is entered, the entry is 
configured as a DQT code. 

! When the entire content of the edit box is deleted, None will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! QT/DQT Enc can be configured only when a value is configured 
in the Receive Frequency edit box.

6.3.7 Channel Name

Configure the channel name of the channel to be 
configured.  Enter characters for Channel Name directly 
in the edit box to configure the Channel Name. 

Note:

! When the entire content of the edit box is deleted, this item will 
be configured as a blank. 

! Channel Name can be configured only when a value is 
configured in the Receive Frequency edit box. 

6.3.8 Transmit Power

Configure the transmit power of each channel.  Select the 
transmit power from the pulldown menu. 

Note: Transmit Power can be configured only when a value is 
configured in the Receive Frequency and Transmit 
Frequency edit boxes. 

Range

QT 67.0 - 250.3 Hz

DQT (Normal) D023N - D754N

DQT (Inverted) D023I - D754I

Default None

Range

QT 67.0 - 254.1 Hz

DQT (Normal) D000N - D777N

DQT (Inverted) D000I - D777I

Step
QT 0.1 Hz

DQT 1

Default None

Range

QT 67.0 - 250.3 Hz

DQT (Normal) D023N - D754N

DQT (Inverted) D023I - D754I

Default None

Range

QT 67.0 - 254.1 Hz

DQT (Normal) D000N - D777N

DQT (Inverted) D000I - D777I

Step
QT 0.1 Hz

DQT 1

Default None

Range A maximum of 12 alphanumeric characters

Available 
Characters

(space) ! “ # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default CH nnn (The channel number is entered 
automatically.)

Range High/ Low

Default High
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6.3.9 Wide/ Narrow

Configure the channel bandwidth of each channel.  Select 
the desired channel bandwidth from the pulldown menu. 

Note: Wide/ Narrow can be configured only when a value is 
configured in the Receive Frequency edit box.

6.3.10 Optional Signaling

Configure the signaling for individual calling.  Alert Tone 
sounds and Transpond is started when the received 
Optional Signaling matches the Optional Signaling the 
transceiver is standing by for.  (Refer to FUNC 18.2 
Optional Signaling.)
Select the desired Optional Signaling from the pulldown 
menu. 

Note: Optional Signaling can be configured only when a value is 
configured in the Receive Frequency edit box.

6.3.11  Busy Channel Lockout

Configure to enable or disable the Busy Channel Lockout 
function.  When Busy Channel Lockout is configured to 
enabled, transmission can be automatically restricted to 
prevent interference with calls from other stations.  (Refer 
to FUNC 12.1 Busy Channel Lockout.)
Select the desired Busy Channel Lockout from the 
pulldown menu. 

Note: Busy Channel Lockout can be configured only when a value 
is configured in the Receive Frequency and Transmit 
Frequency edit box. 

6.3.12 PTT ID

Configure the timing of PTT ID transmission.  Select the 
PTT ID from the pulldown menu.  (Refer to FUNC 14.2 
PTT ID (CH/GID Information).)

# PTT ID Type is DTMF:

# PTT ID Type is FleetSync:

Range Wide/ Narrow

Default Wide

Range None /DTMF/ 2-tone 1/ 2-tone 2/ 2-tone 3/ 
2-tone 4/ FleetSync

Default None

Range

No Disables Busy Channel 
Lockout. 

QT/DQT Tone

Enables Transmission when 
the QT/DQT configured to a 
channel matches the 
received QT/DQT. 

Optional 
Signaling

Enables Transmission when 
Optional Signaling matches. 

Carrier only Disables Transmission while 
the carrier is being received. 

Default No

Range

Off Does not transmit the PTT 
ID. 

BOT Transmits the PTT ID when 
the PTT switch is pressed. 

EOT Transmits the PTT ID when 
the PTT switch is released. 

Both
Transmits the PTT ID when 
the PTT switch is pressed 
and released. 

Default Off

Range

Off Does not transmit the PTT 
ID. 

BOT Transmits the PTT ID when 
the PTT switch is pressed. 

EOT Transmits the PTT ID when 
the PTT switch is released. 

Both
Transmits the PTT ID when 
the PTT switch is pressed 
and released. 

List 1 - 100 
(FleetSync only)

Selcall is performed when 
the PTT switch is pressed.

Default Off
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# PTT ID Type is ANI Board:

Note:

! The PTT ID can be configured only when a value is configured in 
the Receive Frequency and Transmit Frequency edit boxes. 

! At List 1 to 100, the ID currently configured on the FleetSync 
window > the ID List tab is displayed.

! When “Close” is clicked but the configured ID is not available, an 
error message appears. 

! When the Optional Features window > the Common-Page 3 
tab > the PTT ID Type pulldown menu is changed to another 
item from “ANI Board”, Off will be automatically configured. 

! When the Optional Features window > the Common-Page 3 
tab > the PTT ID Type pulldown menu is changed to “ANI Board” 
from “DTMF” or “FleetSync”, Off will be automatically configured. 

! If List 1 to100 is configured when the Optional Features 
window > the Common-Page 3 tab > the PTT ID Type pulldown 
menu is changed to another item from “FleetSync”, Off will be 
automatically configured. 

6.3.13 Beat Shift

Configure to enable or disable the Beat Shift function.  
When Beat Shift is enabled, radio interference caused by 
oscillators in the transceiver can be avoided. 
Due to the configuration of the transceiver’s circuits, the 
harmonics of the oscillators mounted for the 
microcomputer may interfere with receiving performance.  
Radio interference can be avoided by slightly shifting the 
frequency of the oscillators.  (Refer to FUNC 1.8 Beat 
Shift.)
Select the desired Beat Shift option from the pulldown 
menu. 

Note:

! Beat Shift can be configured only when a value is configured in 
the Receive Frequency edit box. 

! Beat Shift may be automatically enabled when a specific 
frequency is entered to the Receive Frequency edit box.

6.3.14 Scan Add

From the pulldown menu, select whether or not the 
transceiver scans the current channel during the scan. 

Note: Scan Add can be configured only when a value is configured 
in the Receive Frequency edit box. 

6.3.15 Compander

Configure to enable or disable the Compander function.  
When Compander is enabled, noise can be reduced to 
improve the S/N ratio (Signal to Noise Ratio). 
The Compander function compresses audio signals at 
transmission modulation, and expands them at receiving 
demodulation to improve the S/N ratio.  This function 
compresses the width of transmission signals at 
transmission, and expands the width at receiving to 
restore the signals.  (Refer to FUNC 1.7 Compander.)

Note: Compander can be configured only when a value is 
configured in the Receive Frequency edit box.

6.3.16 Data

Configure which of data communications or voice 
communications the channel is to be used for. 

Note: Data can be configured only when a value is configured in 
the Receive Frequency edit box.

Range

Off Does not transmit the PTT 
ID. 

On

Transmits the ANI code of 
the ANI Board.  The 
transmission timing is 
configured on the ANI Board. 

Default Off

Range

Transceiver Enables Beat Shift on the 
transceiver. 

VGS-1 Enables Beat Shift on the VGS-
1. 

Transceiver and 
VGS-1

Enables Beat Shift on the 
transceiver and the VGS-1. 

Off Disables Beat Shift.

Default Off

Range
Check (Enable) Performs scanning. 

Uncheck 
(Disable) Does not perform scanning. 

Default Checked (Enabled)

Range
Check (Enable) Enables Compander.

Uncheck 
(Disable) Disables Compander.

Default Unchecked (Disabled)

Range
Check (Enable) The channel is used for data 

communications. 

Uncheck 
(Disable)

The channel is used for voice 
communications. 

Default Unchecked (Disabled)
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6.3.17 Voice Scrambler

Configure to enable or disable the Voice Scrambler 
function.  When Voice Scramber is enabled, voice 
communications are scrambled so that conversations can 
be made with higher secrecy.  (Refer to FUNC 29 Voice 
Scrambler.)

Note: Voice Scrambler can be configured only when a value is 
configured in the Receive Frequency edit box.

6.3.18 Scrambler Code

Configure the Scrambler Code.  The original voice can be 
restored only when the Scrambler Code of the 
transmitting and receiving transceivers matches.  (Refer 
to FUNC 29 Voice Scrambler.)
Enter a value directly in the edit box or click the spin 
button to configure the Scrambler Code. 

Note:

! Scrambler Code can be configured only when a value is 
configured in the Receive Frequency edit box. 

! Scrambler Code can be set only when “Voice Scrambler” is 
selected in the Extended Function window > the Optional 
Board pulldown menu. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.3.19 Channel Copy ([Shift] + [F3])

Existing channel data can be copied to other channels. 
To do this, follow the procedures below:
1. Select the channel to be copied. 
2. Press [Shift] + [F3] on the keyboard. 

The Channel Copy window appears. 

Figure 6-15   Channel Copy Window

3. Enter a value directly in the edit box or click the spin 
button to configure the channel number.

4. Click “Copy”. 
The configured data is copied to the copy target 
channel. 

Note:

! This operation is possible only when data is currently configured 
to the copy source channel. 

! A maximum of 3-digit numberd (250) can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.3.20 Frequency Copy ([Shift] + [F4])

Data configured to Receive Frequency can be copied to 
Transmit Frequency of the same channel. 
To do this, follow the procedures below:
1. Select the channel to be copied. 
2. Press [Shift] + [F4] on the keyboard. 

The Frequency Copy window appears. 

Figure 6-16   Frequency Copy Window

3. Click “Copy”. 
the Receive Frequency data is copied to Transmit 
Frequency of the same channel. 

Range
Check (Enable) Enables Voice Scrambler. 

Uncheck 
(Disable) Disables Voice Scrambler. 

Default Unchecked (Disabled)

Range 1 - 16

Step 1

Default 1
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Note:

! This operation is possible only on channels in which values are 
currently configured to the Receive Frequency edit box.

! Receive Frequency configuration data cannot be copied to other 
channels. 

! When a frequency is entered directly in the Frequency Copy 
window, that value is configured as the frequency of Transmit 
Frequency.  In this case, only frequency up to 9-digit numbers and 
“.” (period) can be entered.  

! When the entire content of the edit box is deleted, a blank will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.3.21 QT/DQT Copy ([Shift] + [F5])

Data configured to QT/DQT Decode can be copied to QT/
DQT Encode of the same channel. 
To do this, follow the procedures below:
1. Select the channel to be copied. 
2. Press [Shift] + [F5] on the keyboard. 

The QT/DQT Copy window appears.

Figure 6-17   QT/DQT Copy Window

3. Click “Copy”. 
QT/DQT Decode data is copied to QT/DQT Encode of 
the same channel. 

Note:

! This operation is possible only on channels in which values are 
currently configured to the QT/DQT Decode edit box. 

! QT/DQT Decode configuration data cannot be copied to other 
channels. 

! When the QT/DQT Encode value is selected or entered directly 
in the QT/DQT Copy window, that value is configured as QT/
DQT Encode.  In this case, a maximum of 5-digit QT and DQT 
having numbers and “N”, “D”, “I”, and “.” (period) can be entered. 

! When the entire content of the edit box is deleted, None will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.4 Repeater Information 
Window

Click “Repeater” in the Zone Information window to 
open the Repeater Information window. 
In the Repeater Information window, configure the 
repeaters that are used by the transceiver in the LTR 
Trunking System. 

Figure 6-18   Repeater Information Window

6.4.1 Area Code

Configure the Area Code.  The Area Code function is 
used to prevent radio interface caused by jamming from 
neighboring systems.  Normally, configure the Area Code 
to “0”.  However, when there is radio interference, 
configure the Area Code of one of the systems to “0” and 
the other to “1”.  (Refer to FUNC 17.3.1 Area Code.) 

Note:

! Only “0” or “1” can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

Range 0/ 1

Step 1

Default 0
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6.4.2 Home Repeater

Configure the repeater number of the Home Repeater.   
Enter a value directly in the edit box or click the spin 
button to configure the Home Repeater.  (Refer to FUNC 
17.3.2 Home Repeater.) 

Note:

! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.4.3 Receive Frequency

Configure the Receive Frequency of the repeater.  
Directly enter to the No. 1 to No. 20 edit boxes to 
configure the Receive Frequency.  (Refer to FUNC 17.3.3 
Repeater Information Table.) 

Note:

! Available frequency range varies depending on the transceiver 
model.  (Refer to FUNC 1.2 Receive/Transmit Frequency.) 

!  A maximum of 9-digit frequency and “.” (period) can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! Other items can be configured only when the Receive 
Frequency is configured in the Receive Frequency edit box. 

! When the content of the Receive Frequency edit box is deleted, 
other items on the same number also are automatically deleted. 

! If the Transmit Frequency edit box is not configured when the 
Receive Frequency edit box is configured, a value shifted 
5 MHz from the Receive Frequency value will be configured to 
Transmit Frequency. 

6.4.4 Transmit Frequency

Configure the Transmit Frequency of the repeater.   
Directly enter to the No. 1 to No. 20 edit boxes to 
configure the Transmit Frequency.  (Refer to FUNC 
17.3.3 Repeater Information Table.)

Note:

! Available frequency range varies depending on the transceiver 
model.  (Refer to FUNC 1.2 Receive/Transmit Frequency.) 

!  A maximum of 9-digit frequency and “.” (period) can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! Other items can be configured only when values are configured 
to the Receive Frequency edit box. 

! When the content of the Transmit Frequency edit box is 
deleted, other items on the same number also are automatically 
deleted. 

6.4.5 Beat Shift

Configure to enable or disable the Beat Shift function.  
When Beat Shift is enabled, radio interference caused by 
oscillators in the transceiver can be avoided. 
Due to the configuration of the transceiver’s circuits, the 
harmonics of the oscillators for the microcomputer may 
interfere with receiving performance.  The radio 
interference can be avoided by slightly shifting the 
frequency of the oscillators.   (Refer to FUNC 17.3.3 
Repeater Information Table.)
Select the desired Beat Shift option from the No. 1 to No. 
20 pulldown menu. 

Note:

! Beat Shift can be configured only when a value is configured in 
the Receive Frequency edit box. 

!  Beat Shift may be automatically enabled when a specific 
frequency is entered to the Receive Frequency edit box.

Range 1 - 20

Step 1

Default 1

Range
TK-2180/ 7180 136 - 174 MHz

TK-3180/ 8180 450 - 520 MHz
400 - 470 MHz

Default Blank

Range
TK-2180/ 7180 136 - 174 MHz

TK-3180/ 8180 450 - 520 MHz
400 - 470 MHz

Default Blank

Range

Transceiver Enables Beat Shift on the 
transceiver. 

VGS-1 Enables Beat Shift on the 
VGS-1. 

Transceiver and 
VGS-1

Enables Beat Shift on the 
transceiver and the VGS-1. 

Off Disables Beat Shift.

Default Off
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! “VGS-1” and “Transceiver VGS-1” can only be selected when 
“VGS-1” is selected in the Extended Function window > the 
Optional Board tab.

6.4.6 TEL

Configure whether or not the repeater is to use PSTN. 
Select the desired TEL option from the No. 1 to No. 20 
pulldown menu. (Refer to FUNC 17.3.3 Repeater 
Information Table.) 

Note: Telephone can be configured only when a value is 
configured in the Receive Frequency edit box. 

6.5 Zone Edit Window

Click “Zone Edit” in the Zone Information window to 
open the Zone Edit window. 
In the Zone Edit window, configure the zones when the 
transceiver transmits and receives in the LTR Trunking 
System. 

Figure 6-19   Zone Edit Window

6.5.1 Zone Name

Configure the Zone Name.  Enter the Zone Name directly 
in the edit box to configure the Zone Name.

Note: When the entire content of the edit box is deleted, this item 
will be configured as a blank. 

6.5.2 Scan Weight

Configure the time that the LTR ID from the repeater is 
decoded during the scan.  Enter a value directly in the 
edit box or click the spin button to configure the Scan 
Weight.  (Refer to FUNC 17.1.2 Scan Weight.) 

Note:

! Only 1 to 8 can be entered. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! Scan Weight can be configured only when the PF Scan key is 
configured to any key. 

! 1 Weight Unit is about 500 ms . 

6.5.3 Wide/ Narrow

Select the Channel Spacing of channels on which the 
transceiver operates.  Select Channel Spacing from the 
pulldown menu. 

6.5.4 Data Zone-CH/GID

Configure the Zone-CH/GID to be used when 
communicating data.  Enter a value for Zone-CH/GID 
directly in the edit box, or select it from the pulldown 
menu.  (Refer to FUNC 17.1.4 Data Zone-CH/GID).)

Range
Yes PSTN is used. 

No PSTN is not used. 

Default No

Range A maximum of 12 alphanumeric characters

Available 
Characters

(space) ! “ # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 
: ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L M N 
O P Q R S T U V W X Y Z a b c d e f g h i j k l m n 
o p q r s t u v w x y z { | } ~

Default **1 - **128 (The zone number is automatically 
entered.)

Range 1 - 8

Step 1

Default 1

Range Wide/ Narrow

Default Wide

Range None/ Existing Zone-CH/GID

Default None
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Note:

! A maximum of 3-digit numbers can be entered.  When “0“ is 
entered, 1 will be configured. 

! When the entire content of the edit box is deleted, None will be 
configured. 

! When None is configured in the Zone edit box, None will be 
configured also in the CH/GID edit box. 

! When an unavailable Zone-CH/GID is entered, an error 
message appears, and the value returns to its original value. 

! When a value is configured in the Zone edit box, and either 
“Close” is clicked or writing data with the CH/GID edit box in a 
None state, an error message appears. 

6.5.5 Data Delay Time

Configure the time until LTR data is transmitted after 
transmission starts.  Use this item, for example, when it is 
difficult to establish a link from the transceiver to a 
repeater. 
Enter a value for Data Delay Time directly in the edit box 
or click the spin button to configure Data Delay Time.  
(Refer to FUNC 17.1.5 Data Delay Time.) 

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.5.6 Home GID

Configure the Group ID to move to when the PF Home 
CH/GID key is pressed.  Enter a value for Home GID 
directly in the edit box, or select it from the pulldown 
menu.  (Refer to FUNC 2.7 Home CH/GID.) 

Note:

! A maximum of 3-digit numbers can be entered.  When “0” is 
entered, “1” is configured. 

! When the entire content of the edit box is deleted, None will be 
configured. 

! Home GID can be configured only when PF Home CH/GID will 
be configured to any key. 

! When an unavailable channel is entered, an error message 
appears, and the value returns to its original value. 

6.5.7 Home GID Operator Selectable

Configure whether or not to enable changes to Home CH/
GID by using PF.  When Home GID Operator Selectable 
is enabled, the currently selected channel can be 
changed to Home CH/GID by holding down the PF Home 
CH/GID key for 3 seconds.  (Refer to FUNC 17.1.7 Home 
GID Operator Selectable.)

Note: Home GID Operator Selectable can be configured only 
when PF Home CH/GID is configured to any key. 

6.5.8 Time-out Timer (Dispatch)

Configure the maximum time that the transceiver is 
allowed to transmit continuously when a user is talking by 
Dispatch ID.  Enter a value for Time-out Timer (Dispatch) 
directly in the edit box, or click the spin button to configure 
the Time-out Timer (Dispatch).  (Refer to FUNC 17.1.8 
Time-out Timer (Dispatch).) 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

! A value less than 15 seconds is discarded. 

6.5.9 Time-out Timer (Telephone)

Configure the maximum time that the transceiver is 
allowed to transmit continuously when a user is talking by 
Telephone ID.  Enter a value for Time-out Timer 
(Telephone) directly in the edit box, or click the spin 
button to configure the Time-out Timer (Telephone).  
(Refer to FUNC 11.2.2 Time-out Timer (Telephone).)  

Range 0 - 100 ms

Step 1 ms

Default 15 ms

Range None/ Configured Group ID

Default None

Range
Check (Enable) Enables Home GID Operator 

Selectable. 

Uncheck 
(Disable)

Disables Home GID Operator 
Selectable. 

Default Unchecked (Disabled)

Range 15 - 600 s

Step 15 s

Default 60 s

Range 15 - 600 s

Step 15 s

Default 180 s
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Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

! A value less than 15 seconds is discarded. 

6.5.10 Audio Control

Configure the conditions for deactivating mute in 
conjunction with LTR ID and Optional Signaling.  Select 
the desired Audio Control option from the pulldown menu.  
(Refer to FUNC 18.3 Signaling (Audio Control).) 

6.5.11 Encode Data Type

Configure whether or not to invert the logic of the LTR 
Message to send.  Select the desired Encode Data Type 
from the pulldown menu.  (Refer to FUNC 17.1.1 Encode 
Data Type.) 

6.5.12 Zone Add

Configure whether or not the transceiver scans the 
current zone during the scan. 

Note: Zone Add cannot be enabled when an item other than 
“Multi” is currently selected in the Scan Information window 
> the Scan Type pulldown menu. 

6.5.13 Scan List

Configure whether or not the transceiver scans the 
current zone during the list scan.  Also configure Scan 
List Table for the list scan.   (Refer to 6.5.25 Scan List 
Table Window.)

Note: Scan List cannot be enabled when an item other than “List” 
is currently selected in the Scan Information window > the 
Scan Type pulldown menu. 

6.5.14 Table Button

Click “Table” to open the Scan List Table window.  (Refer 
to 6.5.25 Scan List Table Window.)

Note: “Table” can be clicked only when the Scan List checkbox is 
checked. 

6.5.15 Auto Telephone Search

Configure whether or not to search for the current zone 
during the Auto Telephone Search.  The Auto Telephone 
Search function automatically searches for and connects 
a connectable repeater.  (Refer to FUNC 17.1.14 Auto 
Telephone Search.) 

Note: Even in Zones that are not checked in the Auto Telephone 
Search checkbox, that Zone is searched when an Auto 
Telephone Search is executed from that Zone. 

Range

LTR ID

Deactivates mute when LTR ID 
matches.  Mute canceling conditions 
remain unchanged even if the 
transceiver transmits. 

LTR ID and 
Optional 
Signaling

Unmuting, Call Alert Tone, Call Alert 
display, and Transpond operation 
are activated when Optional 
Signaling matches LTR ID. 
Once the configured Optional 
Signaling is detected, it retains the 
status until it is reset.  After the 
configured Optional Signaling is 
detected, the transceiver unmutes if 
the same LTR ID is detected.  When 
the transceiver transmits, it enters 
Monitor Mode, and Optional 
Signaling is disabled.  For this 
reason, mute is deactivated by LTR 
ID after transmission ends. 

Default LTR ID

Range
Normal Does not invert the logic of the LTR 

Message.

Invert Inverts the logic of the LTR 
Message. 

Default Invert

Range
Check (Enable) Performs scanning.

Uncheck (Disable) Does not perform 
scanning.

Default Checked (Enabled)

Range
Check (Enable) Performs a list scan.

Uncheck (Disable) Does not perform a list scan.

Default Unchecked (Disabled)

Range

Check (Enable)
Performs a search when 
an Auto Telephone 
Search is executed.

Uncheck (Disable)

Does not perform a 
search when an Auto 
Telephone Search is 
executed.

Default Unchecked (Disabled)
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6.5.16 TA Busy Channel Lockout

Configure to enable or disable the TA Busy Channel 
Lockout function.  When TA Busy Channel Lockout is 
configured to enabled, transmission can be automatically 
restricted to prevent interference with calls from other 
stations.  (Refer to FUNC 13.2.1 TA Busy Channel 
Lockout.) 

6.5.17 TA Key

Configure the availability of PF Talk Around key 
operations in the Trunking system.  This is used to 
prevent a user from operating the Talk Around function by 
the PF Talk Around key.  (Refer to FUNC 13.2.2 TA Key.) 

6.5.18 ID (Fix ID)

Configure an LTR ID having a higher Priority than Group 
ID.  When the Fix ID is received, the transceiver switches 
to the Fix ID even if it is receiving on the Group ID, and 
the transceiver can receive by that Fix ID.  (Refer to 
FUNC 17.1.17 Fix ID.)
Enter a value directly in the 1st and 2nd edit boxes or 
click the spin button to configure the Fix ID. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.5.19 Call Indicator (Fix ID)

Configure activation of the Call Indicator function when a 
Fix ID is received.  Select the desired Call Indicator option 
from the 1st or 2nd pulldown menu.  (Refer to FUNC 
17.1.17 Fix ID.) 

Note: Call Indicator (Fix ID) can be configured only when values 
are configured to the ID (Fix ID) edit box. 

6.5.20 Optional Signaling (Fix ID)

Configure the Optional Signaling when a Fix ID is 
received.  Select the desired Optional Signaling from the 
1st or 2nd pulldown menu.  (Refer to FUNC 17.1.17 Fix 
ID.) 

Note: Optional Signaling (Fix ID) can be configured only when 
values are configured to the ID (Fix ID) edit box. 

6.5.21 Horn Alert (Fix ID) 
(TK-7180/ 8180 only)

Configure activation of the Horn Alert function when a Fix 
ID is received.  Select the desired Horn Alert option from 
the 1st or 2nd pulldown menu.  (Refer to FUNC 17.1.17 
Fix ID.)

Note: Horn Alert (Fix ID) can be configured only when values are 
configured to the ID (Fix ID) edit box. 

Range
Check (Enable) Enables TA Busy Channel 

Lockout. 

Uncheck (Disable) Does not enable TA Busy 
Channel Lockout. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables operation of the PF 

Talk Around key. 

Uncheck (Disable) Does not enable operation of 
the PF Talk Around key. 

Default Unchecked (Disabled)

Range Blank/ 1 - 250

Step 1

Default Blank

Range

Yes Activates the Call Indicator when 
a Fix ID is received. 

No
Does not activate the Call 
Indicator when a Fix ID is 
received. 

Default No

Range None/ DTMF/ FleetSync

Default None

Range
Yes Activates the Horn Alert when a 

Fix ID is received. 

No Does not activate the Horn Alert 
when a Fix ID is received. 

Default No
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6.5.22 Telephone (Block IDs)

Configure the ID for when the transceiver is connected to 
a telephone line.  Directly enter a value to the Start and 
End edit boxes to configure the Telephone. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When a value is entered to the Start edit box, “250” will be 
configured to the End edit box. 

! The End edit box can be configured only when a value is 
configured in the Start edit box. 

! When the content of the Start or End edit box is deleted, the 
value of the other edit box will be substituted by a blank. 

! When the value of the End edit box is smaller than the value of 
the Start edit box, “250” will be configured to the End edit box. 

6.5.23  Transmit Inhibit (Block IDs)

Configure the ID to be inhibited after an ID is received. 
The Transmit Inhibit function does not allow a user to 
transmit immediately after the transceiver has received a 
specific ID.  (Refer to FUNC 17.1.18 Transmit Inhibit 
(Block IDs).)
Directly enter a value to the Start and End edit boxes to 
configure Transmit Inhibit. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When a value is entered to the Start edit box, “250” will be 
configured to the End edit box. 

! The End edit box can be configured only when a value is 
configured in the Start edit box. 

! When the content of the Start or End edit box is deleted, the 
value of the other edit box will be substituted by a blank. 

! When the value of the End edit box is smaller than the value of 
the Start edit box, “250” will be configured to the End edit box. 

6.5.24 Decode (Block IDs)

Configure the ID to restrict a user to transmit and use the 
transceiver exclusively for receiving.  Directly enter a 
value to the Start and End edit boxes to configure the 
Decode.  (Refer to FUNC 17.1.19 Decode (Block IDs).) 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When a value is entered to the Start edit box, “250” will be 
configured to the End edit box. 

! The End edit box can be configured only when a value is 
configured in the Start edit box. 

! When the content of the Start or End edit box is deleted, the 
value of the other edit box will be substituted by a blank. 

! When the value of the End edit box is smaller than the value of 
the Start edit box, “250” will be configured to the End edit box. 

6.5.25 Scan List Table Window

Configure the zone to perform the List Scan.  The 
transceiver scans according to the configuration in the 
Scan List Table window. 

Figure 6-20   Scan List Table Window

Range Blank/ 1 - 250

Step 1

Default Blank

Range Blank/ 1 - 250

Step 1

Default Blank

Range Blank/ 1 - 250

Step 1

Default Blank
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Note:

! The display of zones without configuration data is disabled.

! The Scan List Table window can be configured only when the 
Scan List check box is checked.

6.6 GID Edit Window

Click “GID Edit” in the Zone Information window to open 
the GID Edit window. 
In the GID Edit window, configure the Group ID when the 
transceiver transmits and receives in the LTR Trunking 
System. 

Figure 6-21   GID Edit Window

6.6.1 Zone (Trunking System)

Configure the Zone number to be configured.  Enter a 
value directly in the edit box or click the spin button to 
configure the Zone number. 

Note:

! The zone selected as “Conventional Group” in the Zone Type 
pulldown menu cannot be configured. 

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

6.6.2 GID

Configure the GID number to be configured.  Enter a 
value directly in the edit box or click the spin button to 
configure the channel number. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted, the lower limit 
value will be configured. 

6.6.3 Encode ID

Configure the LTR ID to transmit.  Enter a value directly in 
the edit box or click the spin button to configure the 
Encode ID. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted,  a blank is 
configured. 

6.6.4 Decode ID

Configure the LTR ID to receive.  Enter a value directly in 
the edit box or click the spin button to configure the 
Decode ID. 

Range

Check 
(Enable) Performs the list scan.

Uncheck 
(Disable) Does not perform a list scan.

Default Checked (Enabled)

Range 1 - 128

Step 1

Default Same value as Zone in Zone Information

Range 1 - 250

Step 1

Default Group ID currently selected in Zone Information

Range Blank/ 1 - 250

Step 1

Default Blank

Range Blank/ 1 - 250

Step 1

Default Value configured to Encode ID
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Note:

! A maximum of 3-digit numbers can be entered. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the content of the Decode ID edit box is deleted, other 
items on the same GID also are automatically deleted. 

6.6.5 GID Name

Configure the GID name of the Group ID to be 
configured.  Enter the GID Name directly in the edit box to 
configure the GID Name. 

Note:

! When the entire content of the edit box is deleted, this item will 
be configured as a blank. 

! GID Name can be configured only when a value is configured in 
the Decode ID edit box. 

6.6.6 Transmit Power

Configure the Transmit Power of each GID.  Select the 
desired Transmit Power from the pulldown menu. 

Note: Transmit Power can be configured only when a value is 
configured in the Encode ID and Decode ID edit boxes. 

6.6.7 Optional Signaling

Configure the signaling for individual calling.  Alert Tone 
sounds and Transpond is started when the received 
Optional Signaling matches the Optional Signaling the 
transceiver is standing by for.  (Refer to FUNC 18.2 
Optional Signaling.)
Select the desired Optional Signaling format from the 
pulldown menu. 

Note: Optional Signaling can be configured only when a value is 
configured in the Decode ID edit box. 

6.6.8 PTT ID

Configure the timing of PTT ID transmission.  Select the 
desired PTT ID option from the pulldown menu.  (Refer to 
FUNC 14.2 PTT ID (CH/GID Information).)

When PTT ID Type is DTMF:

When PTT ID Type is FleetSync:

When PTT ID Type is ANI Board:

Note:

! PTT ID can be configured only when a value is configured in the 
Encode ID and Decode ID edit boxes. 

! At List 1 to 100, the ID currently configured on the FleetSync 
window > the ID List tab is displayed. 

! When an unavailable ID is configured when “Close” is clicked, 
an error message appears. 

! When the Optional Features window > the Common-Page 3 
tab > the PTT ID Type pulldown menu is changed to another 
item from “ANI Board”, Off will be automatically configured. 

! When the Optional Features window > the Common-Page 3 
tab > the PTT ID Type pulldown menu is changed to “ANI Board” 
from “DTMF” or “FleetSync”, Off will be automatically configured. 

! If List 1 to 100 is configured when the Optional Features 
window > the Common-Page 3 tab > the PTT ID Type pulldown 
menu is changed to another item from “FleetSync”, Off will be 
automatically configured. 

Range A maximum of 12 alphanumeric characters

Available 
Characters

(space) ! “ # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default CH nnn (The channel number is entered 
automatically.)

Range High/ Low

Default High

Range None/ DTMF/ FleetSync

Default None

Range

Off Does not transmit the PTT ID. 

BOT Transmits the PTT ID when the PTT 
switch is pressed. 

EOT Transmits the PTT ID when the PTT 
switch is released. 

Both Transmits the PTT ID when the PTT 
switch is pressed and released. 

Default Off

Range

Off Does not transmit the PTT ID. 

BOT Transmits the PTT ID when the PTT 
switch is pressed. 

EOT Transmits the PTT ID when the PTT 
switch is released. 

Both Transmits the PTT ID when the PTT 
switch is pressed and released. 

List 1 - 
100 
(FleetSync 
only)

Selcall is performed when the PTT 
switch is pressed. 

Default Off

Range

Off Does not transmit the PTT ID. 

On
Transmits the ANI code of the ANI 
Board.  The transmission timing is 
configured on the ANI Board. 

Default Off
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6.6.9 Call Indicator

Configure whether or not to leave behind a call indicator 
when a user cannot answer a call.  (Refer to FUNC 17.2.6 
Call Indicator.) 

Note: Call Indicator can be configured only when a value is 
configured in the Decode ID edit box. 

6.6.10 Horn Alert (TK-7180/ 8180 only)

Configure activation of the Horn Alert terminal when a 
GID is received.  (Refer to FUNC 9 Horn Alert Function.)

Note: Horn Alert can be configured only when a value is 
configured in the Decode ID edit box. 

6.6.11 Scan Add

Configure whether or not the transceiver scans the 
current GID during the scan. 

Note: Scan Add can be configured only when a value is configured 
in the Decode ID edit box. 

6.6.12 Transpond

Configure whether or not to transmit a Transpond to the 
Dispatcher after the transceiver receives a call by LTR ID.  
(Refer to FUNC 15 Transpond Function.)

Note: Transpond can be configured only when a value is 
configured in the Encode ID and Decode ID edit boxes. 

6.6.13 Talk Around

Configure to enable or disable the Talk Around function 
by GID.  (Refer to FUNC 13 Talk Around Function.) 

Note: Talk Around can be configured only when a value is 
configured in the Decode ID edit box. 

6.6.14 Compander

Configure to enable or disable the Compander function.  
When Compander is enabled, noise can be reduced to 
improve the S/N ratio (Signal to Noise Ratio). 
The Compander function compresses audio signals at 
transmission modulation, and expands them at receiving 
demodulation to improve the S/N ratio.  This function 
compresses the width of transmission signals at 
transmission, and expands the width at receiving to 
restore the signals.  (Refer to FUNC 1.7 Compander.)

Note: Compander can be configured only when a value is 
configured in the Decode ID edit box. 

Range

Check (Enable)
Activates the Call 
Indicator when a GID is 
received.

Uncheck (Disable)
Does not activate the 
Call Indicator when a 
GID is received.

Default Unchecked (Disabled)

Range

Check (Enable) Activates the Horn Alert 
when a GID is received. 

Uncheck (Disable)
Does not activate the 
Horn Alert when a GID is 
received. 

Default Unchecked (Disabled)

Range Check (Enable) Performs scanning.

Uncheck (Disable) Does not perform 
scanning.

Default Checked (Enabled)

Range
Check (Enable) Transmits a Transpond. 

Uncheck (Disable) Does not transmit a 
Transpond. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables Talk Around.

Uncheck (Disable) Disables Talk Around.

Default Unchecked (Disabled)

Range
Check (Enable) Enables Compander.

Uncheck (Disable) Disables Compander.

Default Unchecked (Disabled)
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6.6.15 Data

Configure which of data communications or voice 
communications GID is to be used for. 

Note: Data can be configured only when a value is configured in 
the Decode ID edit box. 

6.6.16 Voice Scrambler

Configure to enable or disable the Voice Scrambler 
function.  When Voice Scramber is enabled, voice 
communications are scrambled so that conversations can 
be made with higher secrecy.  (Refer to FUNC 29 Voice 
Scrambler.)

Note: Scrambler can be configured only when a value is 
configured in the Decode ID edit box. 

6.6.17 Scrambler Code

Configure the Scrambler Code.  The original voice can be 
restored only when the Scrambler Code of the 
transmitting and receiving transceivers matches.  (Refer 
to FUNC 29 Voice Scrambler.) 
Enter a value directly in the edit box or click the spin 
button to configure the Scrambler Code. 

Note:

! Scrambler Code can be configured only when a value is 
configured in the Decode ID edit box. 

! Scrambler Code can be configured only when “Voice Scrambler” 
is selected in the Extended Function window > the Optional 
Board pulldown menu. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.6.18 GID Copy ([Shift] + [F3])

Configured GID data can be copied to other channels. 
To do this, follow the procedures below:
1. Select the GID to be copied.
2. Press [Shift] + [F3] on the keyboard. 

The GID Copy window appears.

Figure 6-22   GID Copy Window

3. Select the desired GID to copy to.
Enter a value directly in the edit box or click the spin 
button to configure. 

4. Click “Copy”. 
The configured data is copied to the copy target GID.

Note:

! This operation is possible only when data is currently configured 
to the copy source GID. 

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

Range
Check (Enable) The GID is used for data 

communications. 

Uncheck (Disable) The GID is used for voice 
communications. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables Voice Scrambler. 

Uncheck (Disable) Disables Voice Scrambler. 

Default Unchecked (Disabled)

Range 1 - 16

Step 1

Default 1
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6.7 Optional Features Window

In the Optional Features window, configure receiving 
and transmission when various transceivers are used, 
configure transceiver operation at receiving 
receivingreceivingand transmission, and configure the 
various functions to suit the transceiver operating 
conditions. 
The Optional Features window has the following tabs, 
and display can be switched by clicking of these tabs. 
• Common-Page 1 tab
• Common-Page 2 tab
• Common-Page 3 tab
• Conventional tab
• Trunking tab
• VGS-1 tab

6.7.1 Common-Page 1 Tab

In the Common-Page 1 tab, configure the transceiver 
display, passwords, Horn Alert, Ignition, and other items. 

Figure 6-23   Common-Page 1 Tab

" Zone Name Text Length
Configure the number of characters for when the Zone 
Name is displayed on the main display.   Enter a value 
directly in the edit box or click the spin button to 
configure the Zone Name Text Length.   (Refer to 
FUNC 3.7.2 Zone Name Text Length.)

Note:

! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, None will 
be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When “0” is entered, None will be configured. 

! When the setting value of Zone Name Text Length is 
increased, the text length at CH/GID Name or Zone-CH/GID 
Number is decreased by the corresponding amount. 

" Sub LCD Display
Configure the content that is normally displayed on 
the Sub LCD.  Select the desired Sub LCD Display 
option from the pulldown menu.  (Refer to FUNC 3.6 
Sub LCD.)

" Display Character
Configure the content that is normally displayed on 
the main display.  Select the desired Display 
Character option from the pulldown menu.  (Refer to 
FUNC 3.7.5 Display Character.)

" Time Format
Configure whether or not to configure the clock 
display format to the 12-hour clock or the 24-hour 
clock.  Select  the desired Time Format from the 
pulldown menu. 

" Data Format
Configure the order that month and day are displayed. 
Select the desired Date Format from the pulldown 
menu. 

Range None/1 - 12

Step 1

Default None

Range

None Nothing appears on the 
display.

Zone Number Displays the zone number.

CH/GID Number Displays the CH/GID 
number. 

OST List Number Displays the OST List 
number.

Default None

Range
CH/GID Name Displays the CH/GID name. 

Zone-CH/GID 
Number

Displays the zone number 
and CH/GID number. 

Default CH/GID Name

Range
12H Displays in the 12-hour clock 

format.

24H Displays in the 24-hour clock 
format.

Default 12H

Range
Day/Month Displays the date in day/month 

order.

Month/Day Displays the date in month/day 
order.

Default Day/Month
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" Mic Sense
Configure the Mic Gain during regular operation. 
Select the desired Mic Sense option from the 
pulldown menu.  (Refer to FUNC 1.12 Mic Sense 
Control.) 

" LCD Brightness (TK-7180/ 8180 only)
Configure the brightness of the backlight LED on the 
LCD.  Select the desired LCD Brightness option from 
the pulldown menu.  (Refer to FUNC 3.4.2 LCD 
Brightness.)

" Mode Reset Timer
Configure the operation standby time after the 
transceiver enters each mode.  The original mode is 
returned to if no key is pressed within the time set 
here. 
Enter a value for Mode Reset Timer directly in the edit 
box or click the spin button to configure the Mode 
Reset Timer. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, Off will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Transceiver Password
Configure the password to prevent unauthorized 
persons from using the transceiver.  The transceiver 
can be operated by entering the correct password. 
Enter the Transceiver Password directly in the edit 
box to configure the Transceiver Password.  (Refer to 
FUNC 5.1 Transceiver Password.) 

Note: A maximum of 6-digit numbers can be entered.  

" Data Password Button
Click “Data Password” to open the Data Password 
window. 

" Data Password Window
In the Data Password window, Read Authorization 
Password and Overwrite Password can be 
configured. 
# Read Authorization Password
Configure the password for protecting internal data on 
the transceiver, for example, to prevent the operating 
frequency from being read.  When data is read, using 
the KPG-89D, from a transceiver configured with a 
Read Authorization Password, the Read Authorization 
Password must be entered on the PC.  If the 
password does not match, the data configured on the 
transceiver cannot be read. 
Enter the Read Authorization Password directly in the 
edit box to configure the Read Authorization 
Password.  (Refer to FUNC 5.2 Read Authorization 
Password.)    

Note:

! A maximum of 6-digit numbers can be entered. 

! When a Read Authorization Password is configured on the 
master side of the transceiver, the Cloning cannot be 
initiated unless the password matches. 

# Overwrite Password
Configure the password for protecting internal data on 
the transceiver, for example, to prevent the frequency 
data from being read.  When writing data to the 
transceiver configured with an Overwrite Password 
using the KPG-89D, the Overwrite Password must be 
entered on the PC.  Data cannot  be written to the 
transceiver if the password does not match. 
Enter the Overwrite Password directly in the edit box 
to configure the Overwrite Password.  (Refer to FUNC 
5.3 Overwrite Password.)   

Note:

! A maximum of 6-digit numbers can be entered. 

! Entered values appear as “*”. 

Range Normal/ High

Default Normal

Range High/ Low/ Off

Default High

Range Off/ 1 - 300

Step 1

Default Off

Range Blank/ 0 - 999999

Default Blank

Range Blank/ 0 - 999999

Default Blank

Range Blank/ 0 - 999999

Default Blank
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" Confirmation
Enter the password configured to Overwrite Password 
for confirmation when the Overwrite Password is being 
configured. 

Note:

! A maximum of 6-digit numbers can be entered. 

! Entered values appear as “*”. 

! When no number is entered in the Overwrite Password 
edit box, the Confirmation display will be skipped. 

! An error message appears when the value entered at the 
Confirmation display differs from the Overwrite Password. 

" Power Switch Status Memory 
(TK-7180/ 8180 only)
Configure whether or not to retains the power ON/OFF 
status. 

" Scrambler Status Memory
Configure the status memory operation of the 
Scrambler Code.  When Scrambler Status Memory is 
enabled, the Scrambler enable or disable status is 
retained.  (Refer to FUNC 29.1.2 Scrambler Status 
Memory (Scrambler), 29.1.4 Scrambler Status 
Memory (SC20-460 Scrambler).) 

" Off-hook Decode (TK-7180/ 8180 only)
Configure whether or not to disable QT/DQT and 
Optional Signaling linked with Mic Hook On/Off, and 
disable mute by Carrier Squelch.  (Refer to FUNC 
18.5 Off-hook Decode.)   

" Signal Strength Indicator
Configure whether or not to display the transceiver’s 
receiving state.  (Refer to FUNC 3.5.1 Signal Strength 
Indicator.)   

" Auto Backlight (TK-2180/ 3180 only)
Configure to enable or disable the Auto Backlight 
function.  When the Auto Backlight function is 
enabled, the backlight LED lights by pressing any key 
other than the PTT switch and the Volume Control.  
(Refer to FUNC 3.4.1 Backlight.)   

" Horn Alert Logic Signal (TK-7180/ 8180 
only)
Configure activation of the Horn Alert port when the 
Horn Alert function is activated.  Enter a value for 
Horn Alert Logic Signal directly in the edit box or click 
the spin button to configure the Horn Alert Logic 
Signal.  (Refer to FUNC 9.4.1 Horn Alert Logic 
Signal.)  

Range Blank/ 0 - 999999

Default Blank

Range
Check (Enable) Retains the power ON/

OFF status. 

Uncheck (Disable) Does not retain the power 
ON/OFF status. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables Scrambler Status 

Memory. 

Uncheck (Disable) Disables Scrambler Status 
Memory. 

Default Unchecked (Disabled)

Range

Check (Enable)

Enables QT/DQT 
Signaling Squelch 
regardless of Mic Hook 
On/Off status. 
Optional Signaling is 
activated in accordance 
with the Audio Control 
configuration. 

Uncheck (Disable)

Squelch opens when a 
Carrier is received if Mic 
Hook is Off. 
Optional Signaling is 
activated in accordance 
with the Audio Control 
configuration when Mic 
Hook is On. 

Default Checked (Enabled)

Range
Check (Enable) Displays the receiving 

state. 

Uncheck (Disable) Does not display the 
receiving state. 

Default Checked (Enabled)

Range
Check (Enable) Enables the Auto Backlight 

function.

Uncheck (Disable) Disables the Auto 
Backlight function.

Default Unchecked (Disabled)
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Note:

! Only numbers and “U” and “P” can be entered. 

! When “U” or “P” is entered, Until Reset will be configured. 

! When “U” or “P” is entered, the second character cannot be 
entered. 

! When the entire content of the edit box is deleted, Until 
Reset will be automatically configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Horn Alert Mode (TK-7180/ 8180 only)
Configure to enable or disable the Horn Alert function.  
Select the desired Horn Alert Mode option from the 
pulldown menu.  (Refer to FUNC 9.4.3 Horn Alert 
Mode.) 

" Off-hook Horn Alert (TK-7180/ 8180 only)
Configure whether to activate the Horn Alert linked 
with Mic Hook when the Horn Alert is activated.  
(Refer to FUNC 9.4.2 Off-hook Horn Alert.)  

" Ignition Sense (TK-7180/ 8180 only)
Configures whether or not to automatically turn the 
transceiver ON/OFF according to the status of Ignition 
On/Off.  (Refer to FUNC 8 Ignition Sense.)  

Note: A warning message appears when writing data under 
the following conditions: 

• The Ignition Sense checkbox is checked.

• “Ignition only” is selected from the Ignition Sense 
Type pulldown menu.

" Ignition Sense Type (TK-7180/ 8180 only)
Configures activation of Ignition Sense.  Select the 
desired Ignition Sense Type from the pulldown menu.  
(Refer to FUNC 8.1 How to Use the Ignition Sense 
Terminal.)    

Range

Until Reset

Horn Alert port remains 
active until the Optional 
Signaling matching state is 
reset. 

1 - 30 s Horn Alert port remains 
active for configured time. 

Pulse

Horn Alert port remains 
active 3 times at 500 ms 
intervals. 
Horn Alert port is active for 
1 second, inactive for 500 
ms and active for 1 second 
only when the Fix ID is 
received. 

Step 1 s

Default Until Reset

Range

Current

Horn Alert standby state is disabled 
when the transceiver is turned OFF 
even with the Horn Alert in a standby 
state.  When the transcevier is turned 
ON, the transceiver always starts up 
with the Horn Alert disabled. 

Status 
Memory

Remains Horn Alert standby state.  Turn 
the transceiver OFF when the Horn Alert 
is in the standby state.  Then turn the 
transceiver ON again, the Horn Alert 
starts up with the standby state.

Startup The transceiver always starts up with the 
Horn Alert in the standby state. 

Default Current

Range
Check (Enable) Activates Horn Alert linked 

with Mic Hook. 

Uncheck 
(Disable)

Deactivates Horn Alert linked 
with Mic Hook. 

Default Checked (Enabled)

Range
Check (Enable) Enables Ignition Sense. 

Uncheck (Disable) Disables Ignition Sense. 

Default Unchecked (Disabled)

Range

Ignition only

When the Ignition Sense terminal 
becomes a High state, the 
transceiver is automatically turned 
ON, and turned OFF when it 
becomes a Low state.  The 
transceiver cannot be turned ON/
OFF by pressing the Power switch. 

Ignition&SW

The transceiver can be turned OFF 
by pressing the Power switch even if 
the car engine is running 
(namelyIgnition Sense terminal is in 
a High state).  However, the state of 
the Power switch is not retained.
The transceiver is turned ON when 
the state of the Ignition Sense 
terminal varies from Low to High. 

Default Ignition&SW
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Note:

! Ignition Sense Type can be configured only when the 
Ignition Sense checkbox is checked. 

! A warning message appears when writing data under the 
following conditions: 

• The Ignition Sense checkbox is checked.

• “Ignition only” is selected in the Ignition Sense Type 
pulldown menu. 

" Timed Power-off (TK-7180/ 8180 only)
Configure the time that the transceiver power is 
automatically turned OFF after the car engine is 
turned Off (Ignition Sense terminal is in a Low state).  
Enter the Timed Power-off time directly in the edit box 
or click the spin button to configure the Timed Power-
off.  (Refer to FUNC 8.2 Timed Power-off.)   

Note:

! A maximum of 2-digit numbers can be entered. 

! The hour value also spins down when the spin button is 
clicked when the minute value is “00”. 

! The hour value also spins up when the spin button is clicked 
when the minute value is “50”. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! When the entire content of the edit box is deleted, the lower 
limit value will be configured. 

! A value less than a single step is discarded. 

! Timed Power-off can be configured only when the Ignition 
Sense checkbox is checked. 

6.7.2 Common-Page 2 Tab

In the Common-Page 2 tab, tone volume, various 
modes, Proceed Tone, and activation at transceiver 
startup can be configured . 

Figure 6-24   Common-Page 2 tab

" Tone Volume Offset
Configure how small or large the volume level of the 
standard tone is to be shifted from the fixed Volume 
position.  Enter a value for Tone Volume Offset directly 
in the edit box or click the spin button to configure the 
Tone Volume Offset.  (Refer to FUNC 4.4 Tone 
Volume Offset.)    

Note:

! Only “0” to “5”, “+” and “-” can be entered between the 
number “0” and “5”. 

! When any number other than “0” is entered, the value is 
prefixed with “+”. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Power-on Tone
Configure the volume of the tone to sound when the 
transceiver is turned ON.  Enter a value for Power-on 
Tone directly in the edit box or click the spin button to 
configure the Power-on Tone.  (Refer to FUNC 4.5 
Tone Volume.)

Range 0 h 0 min - 8 h 00 min

Step
[h] 1 h

[min] 10 min

Default 0 h 10 min

Range -5 - +5

Step 1

Default 0

Range

Off Does not emit the Power-on Tone.

Current Power-on Tone volume is linked 
with the Volume control. 

1 - 31
The tone sounds at a fixed volume.  
The larger the numerical value, the 
louder the volume becomes. 

Selectable

The tone volume changes linked 
with the PF Fixed Volume level.  
(Refer to FUNC 4.6 Selectable 
Tone Level.)   

Step 1

Default Current
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Note:

! Only numbers and “C” and “S” can be entered.  “C” and “S” 
can be entered only for the 1st digit. 

! When “C” is entered, Current will be configured. 

! When “S” is entered, Selectable will be configured. 

! When the entire content of the edit box is deleted or 0 is 
entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Control Tone
Configure the volume of the tone to sound when any 
key is pressed.  Enter a value directly in the edit box 
or click the spin button to configure the Control Tone.  
(Refer to FUNC 4.4 Tone Volume.)  

Note:

! Only numbers and “C” and “S” can be entered.  “C” and “S” 
can be entered only for the 1st digit. 

! When “C” is entered, Current will be configured. 

! When “S” is entered, Selectable will be configured. 

! When the entire content of the edit box is deleted or 0 is 
entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Warning Tone
Configure the Warning Tone volume to sound.  Enter a 
value directly in the edit box or click the spin button to 
configure the Warning Tone.  (Refer to FUNC 4.5 Tone 
Level.) 

Note:

! Only numbers and “C” and “S” can be entered.  “C” and “S” 
can be entered only for the 1st digit. 

! When “C” is entered, Current will be configured. 

! When “S” is entered, Selectable will be configured. 

! When the entire content of the edit box is deleted or 0 is 
entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Alert Tone
Configure the volume level of the tone to sound when 
the transceiver receives a called by Optional 
Signaling.  Enter a value directly in the edit box or click 
the spin button to configure the Alert Tone.  (Refer to 
FUNC 4.5 Tone Volume.)  

Note:

! Only numbers and “C” and “S” can be entered.  “C” and “S” 
can be entered only for the 1st digit. 

! When “C” is entered, Current will be configured. 

! When “S” is entered, Selectable will be configured. 

! When the entire content of the edit box is deleted or 0 is 
entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

Range

Off Does not emit Control Tone. 

Current Control Tone volume is linked with 
the Volume control. 

1 - 31

Emit Control Tone at a fixed 
volume level.  The larger the 
numerical value, the louder the 
volume becomes. 

Selectable

The tone volume changes linked 
with the PF Fixed Volume level.  
(Refer to FUNC 4.6 Selectable 
Tone Level.)   

Step 1

Default Current

Range

Off Does not emit Warning Tone. 

Current Warning Tone volume is linked with 
the Volume control. 

1 - 31

Emits Warning Tone at a fixed 
volume level.  The larger the 
numerical value, the louder the 
volume becomes. 

Selectable

Warning Tone volume is linked with 
the PF Fixed Volume level.  (Refer 
to FUNC 4.6 Selectable Tone 
Level.)   

Step 1

Default Current

Range

Off Does not emit Alert Tone. 

Current Alert Tone volume is linked with the 
Volume control. 

1 - 31
Emits Alert Tone at a fixed volume.  
The larger the numerical value, the 
louder the volume becomes. 

Selectable
Alert Tone volume is linked with the 
PF Fixed Volume level.  (Refer to 
FUNC 4.6 Selectable Tone Level.)    

Step 1

Default Current
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" Sidetone
Configure the volume of Sidetone to sound when 
talking becomes possible or when tranmission ends.  
Enter a value directly in the edit box or click the spin 
button to configure the Sidetone.  (Refer to FUNC 4.5 
Tone Volume.)  

Note:

! Only numbers and “C” and “S” can be entered.  “C” and “S 
can be entered only for the 1st digit. “

! When “C” is entered, Current will be configured. 

! When “S” is entered, Selectable will be configured. 

! When the entire content of the edit box is deleted or 0 is 
entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Locator Tone
Configure the volume of Locator Tone to sound at start 
and end of automatic transmission in Emergency 
Mode.  Enter a value directly in the edit box or click 
the spin button to configure the Locator Tone.  (Refer 
to FUNC 4.5 Tone Volume.)    

Note:

! Only numbers and “C” and “S” can be entered.  “C” and “S” 
can be entered only for the 1st digit. 

! When “C” is entered, Current will be configured. 

! When “S” is entered, Selectable will be configured. 

! When the entire content of the edit box is deleted or 0 is 
entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Low Volume Level (Fixed Volume)
Configure the Low Volume Level when the volume is 
changed by pressing the PF Fixed Volume key.  Enter 
a value for Low Volume Level directly in the edit box or 
click the spin button to configure the Low Volume 
Level.  (Refer to FUNC 4.6 Selectable Tone Level.)    

Note:

! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" High Volume Level (Fixed Volume)
Configure the High Volume Level when the volume is 
changed by pressing the PF Fixed Volume key.  Enter 
a value for High Volume Level directly in the edit box 
or click the spin button to configure the Low Volume 
Level.  (Refer to FUNC 4.6 Selectable Tone Level.)    

Note:

! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Maximum Volume (TK-2180/ 3180 only)
Configure the Maximum Volume.  The Maximum 
Volume function restricts the volume level not to  
exceed the configured volume even if the Volume is 
increased. 
Enter a value for Maximum Volume directly in the edit 
box or click the spin button to configure the Maximum 
Volume.  (Refer to FUNC 4.3 Maximum Volume.)    

Note:

Range

Off Does not emit Sidetone.

Current Sidetone volume is linked with the 
Volume control. 

1 - 31
Emits Sidetone at a fixed volume.  
The larger the numerical value, the 
louder the volume becomes. 

Selectable

The tone volume changes linked 
with the PF Fixed Volume level.  
(Refer to FUNC 4.6 Selectable 
Tone Level.)    

Step 1

Default Current

Range

Off Does not emit Locator Tone. 

Current Locator Tone volume is linked with 
the Volume control. 

1 - 31

Emits Locator Tone at a fixed 
volume.  The larger the numerical 
value, the louder the volume 
becomes. 

Selectable

The tone volume changes linked 
with the PF Fixed Volume level.  
(Refer to FUNC 4.6 Selectable 
Tone Level.)   

Step 1

Default Current

Range 1 - 31 (High Volume Level  or less )

Step 1

Default 10

Range (Low Volume Level  or more ) 1 - 31

Step 1

Default 31

Range 0 - 31

Step 1

Default 31
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! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Minimum Volume Type
Configures activation of Minimum Volume.  Select the 
desired Minimum Volume Type from the pulldown 
menu. 

" Minimum Volume
The Minimum Volume function differs between the TK-
2180/ 3180 and TK-7180/ 8180 transceivers.  Enter a 
value for Minimum Volume directly in the edit box or 
click the spin button to configure the Minimum 
Volume.  (Refer to FUNC 4.2 Minimum Volume.)   
# TK-2180/ 3180

Configure the minimum volume to be retained 
even if the Volume control is turned down fully.  
When “0“ is configured, the transceiver mutes 
when the Volume is turned down fully. 

# TK-7180/ 8180
• When Minimum Volume Type is configured 

to Preset:
Configure the volume when the transceiver is 
turned ON again after the transceiver is turned 
OFF with the Volume control turned down fully. 

• When Minimum Volume Type is configured 
to Lowest Limit:
Configure the minimum volume even if the 
Volume control is turned down fully.  When “0“ 
is configured, the receiving tone is switched Off 
when the Volume control is turned down fully. 

Note:

! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Panel Test
Configure whether or not to enable Panel Test Mode.

" Panel Tuning
Configure whether or not to enable Panel Tuning 
Mode. 

" Clone
Configure whether or not to enable Clone Mode. 

" Firmware Programming
Configure whether or not to enable Firmware 
Programming Mode. 

" Firmware Version Information
Configure whether or not to enable to display the 
Firmware Version of the transceiver

Range Preset/ Lowest Limit

Default Preset

Range 0 - 31

Step 1

Default
TK-2180/ 3180 0

TK-7180/ 8180 8

Range
Check (Enable) Enables Panel Test Mode. 

Uncheck (Disable) Disables Panel Test Mode. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables Panel Tuning 

Mode. 

Uncheck (Disable) Disables Panel Tuning 
Mode. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables Clone Mode. 

Uncheck (Disable) Disables Clone Mode. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables Firmware 

Programming Mode. 

Uncheck (Disable) Disables Firmware 
Programming Mode. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables display of the 

Firmware Version.

Uncheck (Disable) Disables display of the 
Firmware Version.

Default Checked (Enabled)
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" Clock Adjustment
Configure whether or not to enable Clock Adjustment 
Mode.  (Refer to FUNC 30.4 Adjustment Time.) 

" Message Type (Power-on)
Configure the type of message to display when the 
transceiver is turned ON.  Select the desired Message 
Type from the pulldown menu.  (Refer to FUNC 3.7.6 
Power-on Text, 30.2 Time Display at Power ON.)    

" Text (Power-on)
Configure the message to be appeared when the 
transceiver is turned ON.  Enter the desired text message 
directly in the edit box.    (Refer to FUNC 3.7.6 Power-on 
Text.)

Note: Text (Power-on) can be configured only when “Off” or 
“Clock” is selected from the Message Type pulldown 
menu. 

6.7.3 Common-Page 3 Tab

In the Common-Page 3 tab, the battery and PTT ID 
options can be configured.

Figure 6-25   Common-Page 3 Tab

" Battery Saver (TK-2180/ 3180 only)
Configure Battery Saver.  The Battery Saver function 
turns Off the receiver circuit intermittently to save 
battery consumption.  (Refer to FUNC 1.13 Battery 
Saver.)    
Select the desired Battery Saver option from the 
pulldown menu. 

Note: Short is 400 ms, Medium is 800 ms and Long is 1600 
ms for the receiver circuit shut down period. 

" Battery Warning (TK-2180/ 3180 only)
Configure whether or not to emit a beep or blink the 
LED when the battery power is low.  Select the 
desired Battery Warning option from the pulldown 
menu.  (Refer to FUNC 3.5.2 Battery Status/Warning.)   

Range
Check (Enable) Enables Clock Adjustment 

Mode. 

Uncheck (Disable) Disables Clock Adjustment 
Mode. 

Default Unchecked (Disabled)

Range

Off Nothing appears on the display.

Text The text string set at “Text (Power-
on)” is displayed.

Clock Displays the time. 

Default Off

Range A maximum of 12-character text string

Available 
Characters

(space) ! “ # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default Blank

Range Off/ Short/ Medium/ Long

Default Off

Range

Off
Transmits as usual and the 
battery warning does not appear 
regardless of the battery voltage. 

While 
Transmitting

Battery level is checked when 
radio is transmitting. 

Always Battery level is checked 
regardless of condition of radio. 

Always w/
Beep

Battery level is checked 
regardless of condition of radio.
Beep souds when level of 
battery is low

Default While Transmitting
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" Battery Status (TK-2180/ 3180 only)
Configure the Battery Status.  When the Battery Status 
function is enabled, the battery status is displayed in 
four stages according to the remaining battery 
capacity.  (Refer to FUNC 3.5.2 Battery Status/
Warning.)    

" PTT ID Type
Configure the PTT ID type.  Select the desired PTT ID 
Type from the pulldown menu.  (Refer to FUNC 14.1 
PTT ID Type.)    

Note: “ANI Board” cannot be selected from the PTT ID Type 
pulldown menu when an item other than “ANI Board” is 
selected in the Extended Function window > the 
Optional board pulldown menu.  (Refer to 6.15.2 
Optional Board Tab (TK-7180/ 8180 only).)    

" Beginning of Transmit
Configure the ID codes to transmit in the BOT when 
“DTMF” is currently selected in the PTT ID Type 
pulldown menu.  Enter the ID codes directly in the edit 
box to transmit the ID.  (Refer to FUNC 14.1.1 
Beginning of Transmit.)    

Note: Beginning of Transmit cannot be configured when 
“FleetSync” or “ANI Board” is currently selected from the 
PTT ID Type pulldown menu. 

" End of Transmit
Configure the ID codes to transmit at the EOT when 
“DTMF” is currently selected in the PTT ID Type 
pulldown menu.  Enter the ID codes directly in the edit 
box to transmit the ID.  (Refer to FUNC 14.1.2 End of 
Transmit.)   

Note: End of Transmit cannot be configured when “FleetSync” 
or “ANI Board” are currently selected from the PTT ID 
Type pulldown menu. 

" Function
Configure Function to assign to COM port 0 - 2.  
Select the desired Function option from the COM port 
0 - 2 pulldown menu.  (Refer to FUNC 7 
Communications Port.)    
# TK-2180/ 3180

Table 6-3   Available Functions for COM Ports

Note: Nothing can be configured to the COM port 1 edit box 
when “VGS-1” is currently selected from the Extended 
Function window > the Optional Board pulldown 
menu. 

# TK-7180/ 8180

Table 6-4   Available Functions for COM Ports

Note:

! “GPS” cannot be selected in the COM Port 0 edit box. 

! “Data” and “Data + GPS Data Output” cannot be configured 
simultaneously. 

! Nothing can be configured to the COM port 1 edit box when 
“VGS-1” is currently selected in the Extended Function 
window > the Optional Board pulldown menu. 

Range
Check (Enable) Displays the remaining battery 

capacity. 

Uncheck (Disable) Does not display the 
remaining battery capacity. 

Default Checked (Enabled)

Range DTMF/ FleetSync/ ANI Board

Default DTMF

Range A maximum of 16-digit DTMF code

Available 
Codes # * A B C D 0 1 2 3 4 5 6 7 8 9

Default Blank

Range A maximum of 16-digit DTMF code

Available 
Codes # * A B C D 0 1 2 3 4 5 6 7 8 9

Default Blank

Range
COM port

COM port 0 COM port 1

None Enables as the KPG-
89D COM port. The port is disabled.

Data Enables as the KPG-89D/FleetSync COM port. 

Range
COM port

COM port 0 COM port 1 COM port 2

None
Enables as 
the KPG-89D 
COM port. 

Operation is restricted.

Data Enables as the KPG-89D/ FleetSync COM 
port. 

GPS - Operates as the COM port of 
the GPS receiver unit. 

Data + GPS 
Data Output

Enables as the KPG-89D/ FleetSync COM 
port. 
Outputs GPS position data to the PC. 
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" Polarity
Configure whether or not to invert the data logic of 
COM port 0 - 2.  Select the desired Polarity option 
from the pulldown menu. 

6.7.4 Conventional Tab

In the Conventional tab, the Conventional Group 
configuration can be changed. 

Figure 6-26   Conventional Tab

" Busy LED
Configure whether or not to light the Busy LED when 
the transceiver is receiving a carrier.  (Refer to FUNC 
3.1 Busy LED.)   

" PTT Release Tone
Configure whether or not to emit the PTT Release 
Tone.  The PTT Release Tone function notifies the  
end of conversation to a user when conversation ends 
and the PTT switch is released.  (Refer to FUNC 4.8 
PTT Release Tone.)  

" Restricted ID in TA
Configure whether or not to restrict the transmission of 
the PTT ID even if the PTT switch is pressed in Talk 
Around Mode.  (Refer to FUNC 14.3 Restricted ID in 
TA.)    

" Squelch Level
Configure the Squelch Level.  The Squelch Level is 
the value to allow the transceiver to detect a carrier 
sfrom the received signal.  When the received signal 
is weak, set a loose Squelch level.  When there are 
unwanted weak signals, set a tight Squelch Level to 
adjust the communications state.  (Refer to FUNC 1.6 
Squelch Level.)    
Enter a value directly in the edit box or click the spin 
button to configure the Squelch Level. 

Note:

! Only 0 to 9 can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

" VOX Function (TK-2180/ 3180 only)
Configure whether or not to activate the VOX function 
after the transceiver is turned ON.  (Refer to FUNC 28 
VOX.)  

Range
Invert Inverts the data logic of the COM 

port.

Normal Does not invert the data logic of the 
COM port.

Default Normal

Range
Check (Enable) Lights the Busy LED.

Uncheck (Disable) Does not light the Busy 
LED.

Default Checked (Enabled)

Range
Check (Enable) Emits PTT Release Tone. 

Uncheck (Disable) Does not emit PTT 
Release Tone. 

Default Unchecked (Disabled)

Range
Check (Enable) Does not send the PTT ID 

in the Talk Around Mode.

Uncheck (Disable) Sends the PTT ID in the 
Talk Around Mode.

Default Unchecked (Disabled)

Range 0 - 9

Step 1

Default 5

Range
Check (Enable) Activates the VOX 

function.

Uncheck (Disable) Deactivates the VOX 
function.

Default Unchecked (Disabled)
Version: 1.11 Field Programming Reference 55



6 EDIT MENU
" VOX Gain Level (TK-2180/ 3180 only)
Configure the microphone sensitivity when the VOX 
function is in use.  Enter a value directly in the edit box 
or click the spin button to configure the VOX Gain 
Level.  (Refer to FUNC 28.1.1 VOX Gain Level.)   

Note:

! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" VOX Delay Time (TK-2180/ 3180 only)
Configure the time that the transceiver holds 
transmission after the VOX function is used for 
transmission.  This item is used to continue the 
transmission without interrupting.  (Refer to FUNC 
28.1.2 VOX Delay Time.)  
Select the desired VOX Delay Time from the pulldown 
menu. 

" Cancel Operation (TK-2180/ 3180 only)
Configure Cancel Operation.  The Cancel Operation 
function disables the VOX function when the PTT 
switch is pressed while the VOX function is enabled.  
(Refer to FUNC 28.1.4 Cancel Operation.)    

" VOX Proceed Tone (TK-2180/ 3180 only)
Configure whether or not to emit a tone to notify the  
start of transmission to a user when the VOX function 
is used for a transmission.  (Refer to FUNC 28.1.5 
VOX Proceed Tone.) 

" TX Inhibit while Receiving 
(TK-2180/ 3180 only)
Configure whether or not to transmit using the VOX 
function while the speaker does not mute.  (Refer to 
FUNC 28.1.3 TX Inhibit while Receiving.)   

" PTT Proceed Tone (Conventional)
Configure whether or not to emit the PTT Proceed 
Tone when the transceiver is ready for conversation 
after the PTT switch is pressed.  (Refer to FUNC 4.9 
PTT Proceed Tone.)    

" Proceed Tone Delay Time (Conventional)
Configure the time that the PTT Proceed Tone sounds 
from the speaker.  This item is used to restrict the start 
of the transmission from the transmitter being cut off 
on the receiver.  (Refer to FUNC 4.10 Proceed Tone 
Delay Time.)   
Enter a value for Proceed Tone Delay Time directly in 
the edit box or click the spin button to configure the 
Proceed Tone Delay Time. 

Range 1 - 10

Step 1

Default 5

Range 0.3/ 0.5/ 1.0/ 1.5/ 2.0/ 3.0 s

Default 0.5 s

Range

Check (Enable)
Disables the VOX function 
when the PTT switch is 
pressed.

Uncheck (Disable)
Does not disable the VOX 
function when the PTT 
switch is pressed.

Default Unchecked (Disabled)

Range

Check (Enable)
Emits Proceed Tone when 
transmission starts using 
the VOX function. 

Uncheck (Disable)

Does not emit Proceed 
Tone when transmission 
starts using the VOX 
function. 

Default Unchecked (Disabled)

Range
Check (Enable) VOX is not used while the 

speaker is not muted.

Uncheck (Disable) VOX is used even while 
the speaker is not muted.

Default Unchecked (Disabled)

Range
Check (Enable) Emits the PTT Proceed 

Tone. 

Uncheck (Disable) Does not emit the PTT 
Proceed Tone. 

Default Unchecked (Disabled)

Range 0 - 6000 ms

Step 1 ms

Default 0 ms
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Note:

! A maximum of 4-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! The Proceed Tone Delay Time can be configured only when 
the PTT Proceed Tone checkbox is checked. 

" OST Status Memory
Configure whether or not to store the OST codes 
currently selected for each channel on the transceiver 
even if the channel is changed or the transceiver is 
turned OFF.  (Refer to FUNC 19.1 OST Status 
Memory.)    

" Tone Off
Configure to enable or disable the Tone Off function.  
The Tone Off function enables selection of “No Tone”.  
(Refer to FUNC 19.2 Tone Off.)   

" OST Name (OST List)
Configures the name of QT/DQT Encode/Decode 
pairs for OST.  Directly enter a value to the No. 1 to 
No. 40 edit box to configure the OST Name.  (Refer to 
FUNC 19.4 OST Table.) 

" QT/DQT Dec (OST List)
Configure the QT/DQT to standby for.  Select the 
desired QT/DQT Dec option from the No. 1 to No. 40 
pulldown menus, or enter a value in the edit box to 
configure QT/DQT Dec.  (Refer to FUNC 19.4 OST 
Table.)   

# When selecting from the pulldown menu:

# When entering directly in the edit box:

Note:

! A maximum of 5-digit QT and DQT having numbers and “N”, 
“D”, “I” and “.” (period) can be entered. 

! When only numbers and “.” (period) are entered, the entry is 
configured as a QT tone. 

! When a text string starting with “D” is entered, the entry is 
configured as a DQT code. 

! When the entire content of the edit box is deleted, None will 
be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" QT/DQT Enc (OST List)
Configure the QT/DQT for calling the other party. 
Directly enter a value to the No. 1 to No. 40 edit box to 
configure the QT/DQT Enc.  (Refer to FUNC 19.4 
OST Table.)  
# When selecting from the pulldown menu:

# When entering directly in the edit box:

Note:

! A maximum of 5-digit QT and DQT having numbers and “N“, 
“D”, “I” and “.” (period) can be entered. 

Range
Check (Enable) Stores the OST codes.

Uncheck (Disable) Does not store the OST 
codes.

Default Unchecked (Disabled)

Range
Check (Enable) Enables Tone Off.

Uncheck (Disable) Disables Tone Off.

Default Checked (Enabled)

Range A maximum of 12-character text string

Available 
Characters

(space) ! “ # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default Blank

Range

QT 67.0 - 250.3 Hz

DQT (Normal) D023N - D754N

DQT (Inverse) D023I - D754I

Default None

Range

QT 67.0 - 254.1 Hz

DQT (Normal) D000N - D777N

DQT (Inverse) D000I - D777I

Step
QT 0.1 Hz

DQT 1

Default None

Range

QT 67.0 - 250.3 Hz

DQT (Normal) D023N - D754N

DQT (Inverse) D023I - D754I

Default None

Range

QT 67.0 - 254.1 Hz

DQT (Normal) D000N - D777N

DQT (Inverse) D000I - D777I

Step
QT 0.1 Hz

DQT 1

Default None
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! When only numbers and “.” (period) are entered, the entry is 
configured as a QT tone. 

! When a text string starting with “D” is entered, the entry is 
configured as a DQT code. 

! When the entire content of the edit box is deleted, None will 
be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Standard QT Button
When “Standard QT” is clicked, 39 tones for QT 
specified in EIA-603 can be configured to OST Name, 
QT/DQT Dec and QT/DQT Enc.  The table below 
shows the available tones. 

Table 6-5   Values Configured by the Standard QT Button

6.7.5 Trunking Tab

In the Trunking tab, the Trunking System configuration 
can be changed. 

Figure 6-27   Trunking tab

" System Search
Configure how the transceiver automatically searches 
for available systems automatically.  Select the 
desired search method from the pulldown menu.  
(Refer to FUNC 17.5 System Search.)

" Transpond Delay Time
Configure the time from receiving of the Group ID 
configured with Transpond until transmission of the 
Transpond.  Enter a value for Transpond Delay Time 
directly in the edit box or click the spin button to 
configure the Transpond Delay Time.  (Refer to FUNC 
15.4.1 Transpond Delay Time.)  

No. OST Name QT/DQT Dec. QT/DQT Enc.

1 67.0 67.0 67.0

2 69.3 69.3 69.3

3 71.9 71.9 71.9

4 74.4 74.4 74.4

5 77.0 77.0 77.0

6 79.7 79.7 79.7

7 82.5 82.5 82.5

8 85.4 85.4 85.4

9 88.5 88.5 88.5

10 91.5 91.5 91.5

11 94.8 94.8 94.8

12 97.4 97.4 97.4

13 100.0 100.0 100.0

14 103.5 103.5 103.5

15 107.2 107.2 107.2

16 110.9 110.9 110.9

17 114.8 114.8 114.8

18 118.8 118.8 118.8

19 123.0 123.0 123.0

20 127.3 127.3 127.3

21 131.8 131.8 131.8

22 136.5 136.5 136.5

23 141.3 141.3 141.3

24 146.2 146.2 146.2

25 151.4 151.4 151.4

26 156.7 156.7 156.7

27 162.2 162.2 162.2

28 167.9 167.9 167.9

29 173.8 173.8 173.8

30 179.9 179.9 179.9

31 186.2 186.2 186.2

32 192.8 192.8 192.8

33 203.5 203.5 203.5

34 210.7 210.7 210.7

35 218.1 218.1 218.1

36 225.7 225.7 225.7

37 233.6 233.6 233.6

38 241.8 241.8 241.8

39 250.3 250.3 250.3

40 None None

Range None/ Manual/ Auto

Default None

No. OST Name QT/DQT Dec. QT/DQT Enc.
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Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" TX Inhibit Time
Configure the time that transmission is restricted after 
the TX Inhibit ID is received.  Enter a value for TX 
Inhibit Time directly in the edit box or click the spin 
button to configure the TX Inhibit Time.  (Refer to 
FUNC 17.1.18 Transmit Inhibit (Block IDs).)   

Note:

!  A maximum of 2-digit numbers and only “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 0.5 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded. 

" Clear to Talk
Configure whether or not to emit the Delay Tone when 
the transceiver attempts to connect to the repeater 
more than 3 times by pressing the PTT witch, and/or 
emit the Busy Tone when all repeaters are busy.  
(Refer to FUNC 17.6 Clear to Talk.)    

" Free System Ringback
Configure whether or not to emit the Ringer Tone to 
notify a user when the link is established to the 
repeater and the PSTN is allowed.  (Refer to FUNC 
17.4.3 Free System Ringback.)  

" ARQ Mode
Configure to enable or disable the ARQ Mode 
function.  The ARQ function stops data 
communications in the Trunking System by a one-time 
link.  (Refer to FUNC 17.7 ARQ Mode.)    

" Dispatch (PTT Release Tone)
Configure whether or not to emit the PTT Release 
Tone when the Dispatch ID transmission ends.  (Refer 
to FUNC 4.8 PTT Release Tone.)   

" Telephone (PTT Release Tone)
Configure whether or not to emit the PTT Release 
Tone when the Telephone ID transmission is ended.  
(Refer to FUNC 4.8 PTT Release Tone.)   

" PTT Proceed Tone (Trunking)
Configure whether or not to emit the PTT Proceed 
Tone when the transceiver is ready for conversation 
after the PTT switch is pressed.  (Refer to FUNC 4.9 
PTT Proceed Tone.) 

Range 0 - 300 s

Step 1 s

Default 3 s

Range 0.5 - 8.0 s

Step 0.5 s

Default 5.0 s

Range
Check (Enable) Emits the Tone.

Uncheck (Disable) Does not emit the Tone.

Default Checked (Enabled)

Range
Check (Enable) Enables the Free System 

Ringback function.

Uncheck (Disable) Disables the Free System 
Ringback function.

Default Unchecked (Disabled)

Range
Check (Enable) Enables ARQ Mode.

Uncheck (Disable) Disables ARQ Mode.

Default Unchecked (Disabled)

Range
Check (Enable) Emits PTT Release Tone. 

Uncheck (Disable) Does not emit PTT 
Release Tone. 

Default Unchecked (Disabled)

Range
Check (Enable) Emits PTT Release Tone. 

Uncheck (Disable) Does not emit PTT 
Release Tone. 

Default Unchecked (Disabled)

Range
Check (Enable) Emits PTT Proceed Tone. 

Uncheck (Disable) Does not emit PTT 
Proceed Tone. 

Default Checked (Enabled)
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" Proceed Tone Delay Time (Trunking)
Configure the time that the Proceed Tone sounds in 
the transmitting transceiver.  This function is used on 
the receiver to avoid eliminating the begining of 
transmission.  (Refer to FUNC 4.10 Proceed Tone 
Delay Time.)    
Enter a value for Proceed Tone Delay Time directly in 
the edit box or click the spin button to configure the 
Proceed Tone Delay Time. 

Note:

! A maximum of 4-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! The Proceed Tone Delay Time can be enabled only when 
the Proceed Tone checkbox is checked. 

6.7.6 VGS-1 Tab

In the VGS-1 tab, the VGS function can be configured. 
The VGS-1 tab can be configured only when “VGS-1” is 
selected in the Extended Function window > the 
Optional Board pulldown menu. 

Figure 6-28   VGS-1 Tab

" Auto Recording
Configure the max recording time for Auto Recording.  
The Auto Recording function automatically records 
the transmitted or received voices.  (Refer to FUNC 
31.1 Auto Recording.)   

Enter a value directly in the edit box or click the spin 
button to configure the Auto Recording. 

Note:

! Only 30 can be entered. 

! When the entire content of the edit box is deleted, Disable 
will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! The Auto Recording function cannot be used when Disable 
is configured in the Auto Recording edit box. 

! A maximum of 300 seconds total recording time is available 
for all of Auto Recording, Voice Memo and Auto Reply 
Message. 

" Voice Memo (Manual Recording)
Configure the max recording total time for Voice 
Memo.  The Voice Memo function manually records 
the transmitted or received voices.  (Refer to FUNC 
31.2 Voice Memo.) 
Enter a value for Voice Memo directly in the edit box 
or click the spin button to configure the Voice Memo. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, Disable 
will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded. 

! The Voice Memo function cannot be used when Disable is 
configured in the Voice Memo edit box. 

! A maximum of 300 seconds total recording time is available 
for all of Auto Recording, Voice Memo and Auto Reply 
Message. 

" Auto Reply Message
Configure the max recording total time for Auto Reply 
Message.  The Auto Reply Message function enables 
a user to record a Voice Message even if he is away 
from the transceiver.  (Refer to FUNC 31.3 Auto Reply 
Message.)  
Enter a value directly in the edit box or click the spin 
button to configure the Auto Reply Message. 

Range 0 - 6000 ms

Step 1 ms

Default 0 ms

Range Disable/ 30

Default Disable

Range Disable/ 30 - 300 s

Step 30 s

Default Disable

Range Disable/ 30 - 300 s

Step 30 s

Default Disable
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Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, Disable 
will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded. 

! The Auto Reply Message function cannot be used when 
Disable is configured in the Auto Reply Message edit box. 

! A maximum of 300 seconds total recording time is available 
for all of Auto Recording, Voice Memo and Auto Reply 
Message. 

" Stores the latest received messages
Configure the recording method when Voice Memo is 
used.  (Refer to FUNC 31.2 Voice Memo (Manual 
Recording).) 

Note: Stores the latest received messages cannot be 
configured when Disable is configured in the Voice 
Memo edit box.

" Zone CH/GID Guide (Voice Guide)
Configure whether or not to announce the selected 
Zone-CH/GID Number when the Zone-CH/GID is 
changed.  (Refer to FUNC 31.5 Voice Guide.) 

" Function Guide (Voice Guide)
Configure whether or not to announce the configured 
Key Function when the PF key on the transceiver is 
pressed.  (Refer to FUNC 31.5 Voice Guide.)    

" GPS Data Storage (TK-7180/ 8180 only)
Configure whether or not to store FleetSync GPS 
data.  (Refer to FUNC 31.6 GPS Data Storage.)  

Note: GPS Data Storage can be configured only when “GPS” 
is configured in the COM port 2 pulldown menu on the 
Common-Page 3 tab.

" Data Storage Cycle (TK-7180/ 8180 only)
Configure the interval time that the FleetSync GPS 
data is written to the VGS-1.  Enter the Data Storage 
Cycle directly in the edit box or click the spin button to 
configure the Data Storage Cycle.  (Refer to FUNC 
31.6 GPS Data Storage.)  

Note:

! A maximum of 4-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! Data Storage Cycle can be configured only when the GPS 
Data Storage checkbox is checked.

Range

Check (Enable)

New recording data will be 
overwritten to old 
recording data.   
Messages in old recorded 
channels are erased. 

Uncheck (Disable)

New recording data cannot 
be written when all 
recording channels are 
full. 

Default Checked (Enabled)

Range
Check (Enable) Announces the Zone-CH/

GID Number.

Uncheck (Disable) Does not announce the 
Zone-CH/GID Number.

Default Unchecked (Disabled)

Range
Check (Enable) Announces the Key 

Function.

Uncheck (Disable) Does not announce the 
Key Function.

Default Unchecked (Disabled)

Range
Check (Enable) Stores GPS data.

Uncheck (Disable) Does not store GPS data.

Default Unchecked (Disabled)

Range 1 - 3600 s

Step 1 s

Default 60 s
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6.8 Key Assignment Window

In the Key Assignment window, assign functions to the 
transceiver’s PF keys. 
The Key Assignment window has the following tabs, and 
the tab sheet can be switched by clicking the tab title. 
• General tab
• Top/Side tab (TK-2180/ 3180 only)
• Front tab (TK-2180/ 3180 only)
• Panel tab (TK-7180/ 8180 only)
• Mic Key tab
• Call tab
• Direct CH/GID tab

6.8.1 Available Functions to the PF 
Keys

The following functions can be assigned to the PF keys.

Table 6-6   Available Functions

Name of 
Function Description

None No function.  When the None key is 
pressed, the Key-entry Error Tone sounds. 

2-tone

When the PF 2-tone key is pressed, the 2-
tone code can be selected from the 2-tone 
Encode List. Then, when the PTT switch or 
[Side 2]/ ["] is pressed, the 2-tone code is 
sent.  (Refer to FUNC 21 2-tone.)

Auto Reply 
Message

When the PF Auto Reply Message key is 
pressed, the Auto Reply Message function 
is activated or deactivated when the VGS-1 
is installed.  (Refer to FUNC 31.3 Auto 
Reply Message.) 

Auto Telephone

When the PF Auto Telephone key is 
pressed, the LTR system is automatically 
connected to the PSTN line to make a call.  
(Refer to FUNC 17.1.14 Auto Telephone 
Search.)

Autodial

When the PF Autodial key is pressed, 
Autodial List appears and a user can select 
the desired DTMF code.  The DTMF code 
can also be entered directly.  Then, when 
the PTT switch or [Side 2]/ ["] is pressed, 
the DTMF code is sent. (Refer to FUNC 20 
DTMF.) 

Autodial 
Programming

When the PF Autodial Programming key 
is pressed, the DTMF Autodial List can be 
configured, changed, or erased.  (Refer to 
FUNC 20.4.2 DTMF Autodial 
Programming.)

AUX

When the PF AUX key is pressed, the AUX 
Output terminal is toggled between activa 
and inactive.  The port output changes when 
the AUX key is pressed, and external 
devices connected to the AUX port can be 
controlled. 
This function is available only for the TK-
2180/ 3180 transceivers.

AUX A

When the PF AUX A key is pressed, the 
AUX A Output terminal is toggled between 
activa and inactive.  The port output 
changes when the AUX A key is pressed, 
and external devices connected to the AUX 
A port can be controlled. 
This function is available only for the TK-
7180/ 8180 transceivers.

AUX B

When the PF AUX B key is pressed, the 
AUX B Output terminal is toggled between 
activa and inactive.  The port output 
changes when the AUX B key is pressed, 
and external devices connected to the AUX 
B port can be controlled. 
This function is available only for the TK-
7180/ 8180 transceivers.

Call 1/2/3/4/5/6

When one of the PF Call 1 - PF Call 6 keys 
is pressed, the assigned FleetSync Status, 
the DTMF code or 2-tone code is sent.  
(Refer to FUNC 1.11 Call Key.)   

CH/GID Down

When the PF CH/GID Down key is pressed, 
the CH/GID number is decreased in steps of 
1.  Holding down the key to decrease the 
CH/GID number in steps of 1 at the 200 ms 
intervals.  (Refer to FUNC 2.5 Changing CH/
GID.)    

CH/GID Recall

When the PF CH/GID Recall key is 
pressed, the Last Called Zone-CH/GID is 
called during the scan.  (Refer to FUNC 
23.7.16 CH/GID Recall.)    

CH/GID Up

When the PF CH/GID Up key is pressed, 
the CH/GID number is increased insteps of 
1.  Holding down the key for at least one 
second to increase the CH/GID number in 
steps of 1 at the 200 ms intervals.  (Refer to 
FUNC 2.5 Changing CH/GID.)

Channel Entry
Specify the channel number directly using 
the Keypad.  (Refer to FUNC 2.6 Channel 
Entry.) 

Clock
When the PF Clock key is pressed, the 
current time is appears.  (Refer to FUNC 30 
Clock Function.)  

Direct CH/GID 1 - 
Direct CH/GID 5

When one of the PF Direct CH/GID 1 -  PF 
Direct CH/GID 5 keys is pressed, the 
channel is changed to the configured CH/
GID.  (Refer to FUNC 2.8 Direct CH/GID.)   

Display 
Character

When the PF Display Character key is 
pressed, the CH/GID Name or Zone-CH/
GID Number appears on the main display.  
(Refer to FUNC 3.7.5 Display Character.)    

Name of 
Function Description
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Emergency
When the PF Emergency key is pressed, 
the transceiver enters Emergency Mode.  
(Refer to FUNC 24 Emergency Mode.)    

Fixed Volume

Each time the PF Fixed Volume key is 
pressed, the tone level varies High, Low, 
Off, and returns to High.  (Refer to FUNC 4 
Sound.)

Function

When the PF Function key is pressed, the 
transceiver waits for another key entry.  If 
Mode Reset Timer is activated and the next 
key is not pressed before the Mode Reset 
Timer expires, Function Mode resets.  
(Refer to FUNC 26 Function port.)  

Home CH/GID
When the PF Home CH/GID key is pressed, 
the channel is changed to Home CH/GID.  
(Refer to FUNC 2.7 Home CH/GID.)

Horn Alert
When the PF Horn Alert key is pressed, the 
Horn Alert function is enabled.  (Refer to 
FUNC 9 Horn Alert.)  

Key Lock

When the PF Key Lock key is pressed, the 
Key Lock function is enabled.  This function 
is available only for the TK-2180/ 3180 
transceivers.  (Refer to FUNC 1.9 Key 
Lock.)

Backlight

When the PF Backlight key is pressed, the 
backlight LED lights.  This function is 
available only for the TK-2180/ 3180 
transceivers.  (Refer to FUNC 3.4.1 
Backlight.)

LCD Brightness

When the PF LCD Brightness key is 
pressed, the LCD Brightness can be 
adjusted.  This function is available only for 
the TK-7180/ 8180 transceivers. (Refer to 
FUNC 3.4.2 LCD Brightness.)   

Low 
Transmission 

Power

The tranmission power changes as follows 
while the PF Low Transmission Power key 
is pressed:
• Low Transmission Power
• High Transmission Power

Monitor

When the PF Monitor key is pressed, the 
QT/DQT is temporalily forced to cancel and 
the Squelch is controlled only by incoming 
signals.  (Refer to FUNC 18.6 Monitor.)   

Monitor 
Momentary

While the PF Monitor Momentary key is 
pressed, the QT/DQT is temporarily 
defeated and the Squelch is controlled only 
by incoming signals. (Refer to FUNC 18.6 
Monitor.)   

OST
When the PF OST key is pressed, the 
Encode/Decode code pair of QT/DQT can 
be changed.  (Refer to FUNC 19 OST.)  

Playback

When the PF Playback key is pressed, the 
recorded data plays back and new voice 
message can be stored to the VGS-1.  
(Refer to FUNC 31 VGS.) 

Public Address

When the PF Public Address key is 
pressed, the Public Address function is 
enabled or disabled.  (Refer to FUNC 4.12 
Public Address.)    

Name of 
Function Description

Scan When the PF Scan key is pressed, the scan 
starts or stops.  (Refer to FUNC 23 Scan.)  

Scan Delete/Add

When the PF Scan Delete/Add key is 
pressed, selected Zone-CH/GID will be 
deleted/ added from the Scan List.  (Refer to 
FUNC 23.7.1 Scan Del/Add.)    

Scrambler

When the PF Scramber key is pressed, the 
Voice Scrambler function is enabled or 
disabled.  When the PF Scrambler key is 
held down for 1 second, the Scrambler 
codes can be selected from 1 - 16.  (Refer to 
FUNC 29 Voice Scrambler.)

Selcall

When the PF Selcall key is pressed, the ID 
number can be selected from ID List or 
entere the value directly.  Then, when the 
PTT switch or [Side 2]/ ["] is pressed, the 
Selcall can be made.  (Refer to FUNC 
22.1.2 Selective Call.)

Selcall+Status

When the PF Selcall+Status key is 
pressed, the ID Status and Status number 
can be selected from the ID Status List  or 
entere the value directly.  Then, when the 
PTT switch or [Side 2]/ ["] is pressed, the 
Status is transmitted.  (Refer to FUNC 22.2 
Selective Call.)

Send the GPS 
data

When the PF Send GPS key is pressed, the 
GPS data received via the COM port is 
transmitted manually to the Base station.  
(Refer to FUNC 22.6 GPS.) 

Speaker 
Attenuation

When the PF Speaker Attenuation key is 
pressed, the volume is lowered temporarily.  
(Refer to FUNC 4.11 SP Attenuation.)    

Squelch Level

When the PF Squelch Level key is 
pressed, the Squelch tighness can be 
changed.  (Refer to FUNC 18.8 Squelch 
Level.)    

Squelch Off
When the PF Squelch Off key is pressed, 
the Squelch is disabled and signals can be 
heard.  (Refer to FUNC 18.7 Squelch.)  

Squelch Off 
Momentary

The Squelch is disabled and signals can be 
heard while the PF Squelch Off 
Momentary key is pressed.  (Refer to 
FUNC 18.7 Squelch.)   

Status

When the PF Status key is pressed, the 
Status number can be selected from Status 
List or entere the value directly.  Then, when 
the PTT switch or [Side 2]/ ["] is pressed, 
the Status is transmitted.  (Refer to FUNC 
22.3 Status Message.)  

Talk Around
When the PF Talk Around key is pressed, 
the Talk Around function is enabled or 
disabled.  (Refer to FUNC 13 Talk Around.)   

Telephone 
Disconnect

When the PF Telephone Disconnect key is 
pressed, the call that was being made is 
disconnected.  (Refer to FUNC 17.4 
Telephone InterConnect.)   

Name of 
Function Description
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6.8.2 General Tab

In the General tab, the Key Assignment function can be 
configured. 

Figure 6-29   General Tab

" Keypad
Configure the type of Keypad.  Select the desired 
Keypad option from the pulldown menu. 

" Keypad Operation
Configure how the key is to be used.  Select the 
desired Keypad Operation from the pulldown menu.  
(Refer to FUNC 1.10 Keypad Operation.)   

Transceiver 
Password

When the PF Transceiver Password key is 
pressed, the transceiver cannot be used 
without entering the password, and the 
transceiver waits for the password.  (Refer 
to FUNC 5.1 Transceiver Password.)   

Volume Down

When the PF Volume Down key is pressed, 
Volume is decreased in steps of 1.  When 
the key is held down for 1 second, volume is 
decreased in steps of 1 at 100 ms intervals. 
This function is available only for the TK-
7180/ 8180 transceivers.  (Refer to FUNC 
2.2 Adjusting the Volume.) 

Volume Up

When the PF Volume Up key is pressed, 
Volume is increased in steps of 1.  When the 
key is held down for 1 second, volume is 
increased in steps of 1 at 100 ms intervals. 
This function is available only for the TK-
7180/ 8180 transceivers.  (Refer to FUNC 
2.2 Adjusting the Volume.)  

VOX

When the PF VOX key is pressed, the VOX 
Gain Level can be configured.  When the PF 
VOX key is held down for 2 seconds, the 
VOX function can be turned On or Off. 
This function is available only for the TK-
2180/ 3180 transceivers.  (Refer to FUNC 
28 VOX.)    

Zone Down

When the PF Zone Down key is pressed, 
the Zone number is decreased in steps of 1.  
Holding down the key for 1 second or more, 
the Zone number is decreased in steps of 1 
at 200 ms intervals.  (Refer to FUNC 2.4 
Changing the Zone.)  

Zone Up

When the PF Zone Up key is pressed, the 
Zone number is increased in steps of 1.  
Holding down the key for 1 second or more, 
the Zone number is increased in steps of 1 
at 200 ms intervals.  (Refer to FUNC 2.4 
Changing the Zone.)  

Name of 
Function Description

Range
TK-2180/ 3180 None/ 12 key

TK-7180/ 8180 None/ 12 key (Mic)/ 16 key 
(Mic)

Default None
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Note: No function can be assigned when “None”  is selected in 
the Keypad pulldown menu. 

" List Selection Key (Selector)
Configure whether or not to perform mode specific 
operations when Selector, [ ]/ [ ] are pressed in the 
respective mode. 

6.8.3 Top/Side Tab 
(TK-2180/ 3180 only)

In the Top/Side tab, select the function to assign to 
Selector or the AUX/ Side keys from the Function and 
2nd Function pulldown menus. 

Figure 6-30   Top/Side Tab

" Selector
Configure the function to assign to the Selector. 
Select the desired Selector option from the pulldown 
menu. 

" AUX/ Side 1/ Side 2 (Function/2nd Function)
Select the function to assign to the PF keys from the 
Function and 2nd Function pulldown menu. 

Note:

! The 2nd Function pulldown menu can be configured only 
when “Function” in Key Function List is selected from the 
Function pulldown menus in each tab. 

! When a PF key is selected, the selected PF key in the Key 
Image window appears in red. 

Range

None No function is configured. 

Channel Entry
When the Channel Entry key is 
pressed, channels can be 
specified directly. 

OST
When the OST key is pressed, 
OST List 1 to 40 can be specified 
directly. 

DTMF (Autodial)
When the DTMF (Autodial) key 
is pressed, the DTMF codes can 
be selected and transmitted. 

DTMF (Keypad 
Auto PTT)

Each time the DTMF (Keypad 
Auto PTT) key is pressed, the 
DTMF code can be transmitted 
directly. 

FleetSync 
(Selcall)

When the FleetSync (Selcall) 
key is pressed, the Fleet/ ID 
number can be entered directly, 
or the stored Selcall List can be 
selected.  Then, when the PTT 
switch or [Side 2]/ ["] is 
pressed, the Selcall is 
transmitted. 

FleetSync 
(Status)

When the FleetSync (Status) 
key is pressed, the  Status 
number is entered directly, or the 
stored Status List is selected.  
Then, when the PTT switch or 
[Side 2]/ ["] is pressed, the 
Status is sent. 

FleetSync 
(Selcall + Status)

When the FleetSync (Selcall + 
Status) key is pressed, the 
Fleet/ID or Status number is 
entered directly, or the stored 
Selcall/ Status List is selected.  
Then, when the PTT switch or 
[Side 2]/ ["] is pressed, the 
Status is sent. 

Default None

Range
Check (Enable) Performs mode specific 

operations.

Uncheck (Disable) Does not perform mode  
specific operations.

Default Unchecked (Disabled)

Range

None
No function.  When Selector 
is rotated, the Key-entry 
Error Tone sounds. 

Zone Up/Down

When Selector is rotated, 
the Zone number is 
increased or decreased in 
steps of 1. 

CH/GID Up/Down
When Selector is rotated, the 
CH/GID number is increased 
or decreased in steps of 1. 

Default Zone Up/Down

Range Refer to 6.8.1 Available Functions to the PF 
Keys.

Default
Function

AUX:   None
Side 1:  Squelch Off Momentary
Side 2:  Lamp

2nd Function None
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6.8.4 Front Tab (TK-2180/ 3180 only)

In the Front tab, select the function to assign to front keys 
from the Function and 2nd Function pulldown menu. 

Figure 6-31    Front Tab

Note:

! The 2nd Function pulldown menu can be configured only 
when “Function” in Key Function List is selected from the 
Function pulldown menus in each tab. 

! 0 - 9, “*” and “#” cannot be configured when “None” is 
selected in the General tab > the Keypad pulldown menu. 

! When a PF key is selected, the selected PF key in the Key 
Image window appears in red. 

6.8.5 Panel Tab (TK-7180/ 8180 only)

In the Panel tab, select the function to assign to panel 
keys from the Function and 2nd Function pulldown 
menu. 

Figure 6-32   Panel Tab

Note:

! The 2nd Function pulldown menu can be configured only 
when “Function” in Key Function List is selected for the 
Function pulldown menus in each tab. 

! When a PF key is selected, the selected PF key in the Key 
Image window appears in red. 

6.8.6 Mic Key Tab

In the Mic Key tab, select the function to assign to the 
mic key from the Function and 2nd Function pulldown 
menu. 

Figure 6-33   Mic Key Tab

Range Refer to 6.8.1 Available Functions to the PF 
Keys.   

Default
Function

S:   None
A:   None
B:   CH/GID Down
C:   CH/GID Up
0 - 9:  None
*:  None
#:  None

2nd Function None

Range Refer to 6.8.1 Available Functions to the PF 
Keys.

Default
Function

Left Up:  Volume Up
Left Down:  Volume Down
Triangle:  None
S:   Squelch Off Momentary
A:   None
B:   CH/GID Down
C:   CH/GID Up
Square:  None
Right Up:  Zone Up
Right Down:  Zone Down

2nd Function None
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# TK-2180/ 3180

# TK-7180/ 8180

Note:

! The 2nd Function pulldown menu can be configured only when 
“Function” in Key Function List is selected from the Function 
pulldown menus in each tab. 

! 0 - 9, “*”, “#”, A, B, C, and D cannot be configured when “None” 
is selected in the General tab > the Keypad pulldown menu 
(TK-7180/ 8180 transceivers). 

! A, B, C, and D cannot be configured when “12 Key” is selected 
in the General tab > the Keypad pulldown menu (TK-7180/ 
8180 transceivers). 

! When a PF key is selected, the selected PF key in the Key 
Image window appears in red. 

6.8.7 Call Tab

In the Call tab, configure the number that is configured to 
the list corresponding to each signaling on the PF Call 1 - 
PF Call 6 keys. 

Figure 6-34   Call Tab

" Signaling (Call 1 - Call 6)
Configure the signaling of the PF Call 1 - PF Call 6 
keys.  Select the desired Call 1 - 6 Signalling format 
from the pulldown menu.  (Refer to FUNC 1.11 Call 
Key.)    

Note:

! The Signaling pulldown menu can be configured only when 
“Call 1” - “Call 6” in the Key Function List is selected from the 
Function pulldown menus in each tab. 

! “None” is selected in the List Number pulldown menu when the 
Signaling pulldown menu configuration is changed. 

" List Number (Call 1 - Call 6)
Configure the number to the corresponding list for 
each signaling.  Select the desired Call 1 - 6 List 
Number from the pulldown menu.  (Refer to FUNC 
1.11.Call Key.)    

Note:  Only numbers configured to the list are displayed.

6.8.8 Direct CH/GID Tab

In the Direct CH/GID tab, the PF Direct CH/GID 1 - PF 
Direct CH/GID 6 keys can be configured. 

Figure 6-35   Direct CH/GID Tab

Range Refer to 6.8.1 Available Functions to the PF 
Keys. 

Default
Function PF 1:  None

PF 2:  None

2nd Function None

Range Refer to 6.8.1 Available Functions to the PF 
Keys.

Default
Function

0 - 9:  None
*:  None
#:  None
A:  None
B:  None
C:  None
D:  None

2nd Function None

Range DTMF/ 2-tone/ FleetSync (Status)

Default FleetSync (Status)

Range
DTMF/2-tone None/ 1 - 32

FleetSync 
(Status) None/ 1 - 90

Default None
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" Operator Selectable
Configure whether or not to allow a user to change the 
Direct CH/GID using the PF Direct CH/GID 1 - PF 
Direct CH/GID 6 keys.  (Refer to FUNC 2.8 Direct CH/
GID.)    

" Recall
Configure whether or not the original CH/GID can be 
recalled the same PF Direct CH/GID 1 - PF Direct 
CH/GID 6 key is pressed again after the channel is 
changed to a new channel using the PF Direct CH/
GID 1 - PF Direct CH/GID 6 keys.  (Refer to FUNC 
2.8 Direct CH/GID.)    

" Zone (Direct CH/GID 1 - Direct CH/GID 6)
Configure new Zone to be changed when one of the 
PF Direct CH/GID 1 - PF Direct CH/GID 6 keys is 
pressed.  Enter the Zone number directly in the Direct 
CH/GID 1 - 6 edit boxes, or select it from the pulldown 
menu.  (Refer to FUNC 2.8 Direct CH/GID.)    

Note:

! The Zone pulldown menu can be configured only when 
“Direct CH/GID 1” - “Direct CH/GID 6” in Key Function List is 
selected from the Function pulldown menus. 

! None is configured in the CH/GID pulldown menu when the 
Zone pulldown menu configuration is changed. 

! When the entire content of the edit box is deleted, None will 
be configured. 

! When an unavailable zone is entered, an error message 
appears and the value returns to its original value. 

! When the Zone pulldown menu is available, and either 
“Close” is clicked or writing data with “None” selected from 
the CH/GID pulldown menu, an error message appears. 

" CH/GID (Direct CH/GID 1 - Direct CH/GID 6)
Configure the CH/GID to move to when one of the PF 
Direct CH/GID 1 - PF Direct CH/GID 6 keys is 
pressed.  Select the desired Direct CH/GID 1 - 6 
numbers from the pulldown menu.  (Refer to FUNC 
2.8 Direct CH/GID.)  

Note:

! When the entire content of the edit box is deleted, None will 
be configured. 

! When an unavailable CH/GID is entered, an error message 
appears, and the value returns to its original value. 

! When the Zone pulldown menu can be configured, and 
either “Close” is clicked or writing data with “None” selected 
from the CH/GID pulldown menu, an error message 
appears. 

6.9 Scan Information Window

In the Scan Information window, various scan functions 
can be configured.

Figure 6-36   Scan Information Window

Range
Check (Enable) Allows a user to change  

Direct CH/GID. 

Uncheck (Disable) Does not allows a user to 
change Direct CH/GID. 

Default Unchecked (Disabled)

Range

Check (Enable)

The original CH/GID is 
recalled when the same PF 
Direct CH/GID 1 - PF Direct 
CH/GID 6 key is pressed 
again. 

Uncheck (Disable)

The original CH/GID 
cannot be recalled when 
the same PF Direct CH/GID 
1 - PF Direct CH/GID 6 key 
is pressed again. 

Default Unchecked (Disabled)

Range None/ Existing Zone

Default None

Range None/ Existing CH/GID

Default None
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6.9.1 Priority 1

To configure Priority 1 channel, select the desired Priority 
1 option from the pulldown menu.  (Refer to FUNC 23.7.4 
Priority 1/Priority 1 Zone-CH.)    

Note: “Selected” cannot be configured in the Priority 1 pulldown 
menu when “Selected” is already configured in the Priority 
2 pulldown menu. 

6.9.2 Priority 2

To configure Priority 2, select the desired Priority 2 option 
from the pulldown menu.  (Refer to FUNC 23.7.5 Priority 
2/Priority 2 Zone-CH.) 

Note: “Selected” cannot be configured in the Priority 2 pulldown 
menu when “Selected” is already configured in the Priority 
1 pulldown menu. 

6.9.3 Priority 1 Zone-CH

Configure the Zone-CH/GID to be used as Priority 1.  
Enter a value for Zone-CH/GID directly in the edit box or 
select it from the pulldown menu.  (Refer to  FUNC 23.7.4 
Priority 1/Priority 1 Zone-CH.) 

Note:

! This function cannot be configured when an item other than 
“Fixed” or “Operator Selectable” is selected from the Priority 1 
pulldown menu. 

! A maximum of 3-digit numbers can be entered.  When “0” is 
entered, 1 will be configured. 

! When the entire content of the edit box is deleted, None will be 
configured. 

! When None is configured in the Zone edit box, None will be 
configured also in the CH/GID edit box. 

! When an unavailable Zone-CH/GID is entered, an error 
message appears and the value returns to its original value. 

! When a value is configured in the Zone edit box, and either 
“Close” is clicked or writing data with the CH/GID edit box in a 
“None” state, an error message appears. 

! If the same Zone number is configured in the Zone Information 
window > the Zone Type pulldown menu that the Trunking 
System is selected, both Zone and CH/GID edit boxes are 
configured as None.

6.9.4 Priority 2 Zone-CH

Configure the Zone-CH/GID to be used as Priority 2.  
Enter a value for Zone-CH/GID directly in the edit box or 
select it from the pulldown menu.  (Refer to FUNC 23.7.5 
Priority 2/Priority 2 Zone-CH.) 

Note:

! This function cannot be configured when an item other than 
“Fixed” or “Operator Selectable” is selected from the Priority 2 
pulldown menu. 

! A maximum of 3-digit numbers can be entered.  When “0” is 
entered, 1 will be configured.

! When the entire content of the edit box is deleted, None will be 
configured. 

! When None is configured in the Zone edit box, None will be 
configured also in the CH/GID edit box.

! When an unavailable Zone-CH/GID is entered, an error 
message appears and the value returns to its original value. 

! When a value is configured in the Zone edit box, and either 
“Close” is clicked or writing data with the CH/GID edit box in a 
None state, an error message appears. 

Range

None Priority 1 is not assigned. 

Fixed

The channel configured in the 
Priority 1 Zone-CH pulldown 
menu is used as Priority 1.  
(Refer to 6.9.3 Priority 1 Zone-
CH.)

Selected The current channel is set to 
Priority 1. 

Operator 
Selectable

A user can configure Priority 1.  
To configure Priority 1, press and 
hold the PF Scan key for 2 
seconds. 

Default None

Range

None Priority 2 is not assigned. 

Fixed

The channel configured in the 
Priority 2 Zone-CH pulldown 
menu is used as Priority 2.  
(Refer to 6.9.3 Priority 1 Zone-
CH.) 

Selected The current channel is set to 
Priority 2. 

Operator 
Selectable

A user can configure Priority 2.  
To configure Priority 2, press and 
hold the PF Scan key for 2 
seconds.

Default None

Range None/ Zone-CH/GID of existing Conventional 
Group

Default None

Range None/ Zone-CH/GID of existing Conventional 
Group

Default None
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! If the same Zone number is configured in the Zone Information 
window > the Zone Type pulldown menu that the Trunking 
System is selected, both Zone and CH/GID edit boxes are 
configured as None. 

6.9.5 Revert CH/GID

Configure the Zone-CH/GID to be used for the 
transmission when the PTT switch is pressed during the 
scan.  Select the desired Revert CH/GID Type from the 
pulldown menu.  (Refer to FUNC 23.7.6 Revert CH/GID.) 

Note:

! “Priority 1” or “Priority 1 + Talk Back” cannot be selected from 
the Revert CH/GID pulldown menu when None or Selected is 
configured in the Priority 1 pulldown menu. 

! “Last Called” will be configured when “None” or “Selected” is 
selected from the Priority 1 pulldown menu while “Priority 1” or 
“Priority 1 + Talk Back” is selected for the Revert CH/GID 
pulldown menu. 

! “Priority 2” or “Priority 2 + Talk Back” cannot be selected for the 
Revert CH/GID pulldown menu when None or Selected is 
configured in the Priority 2 pulldown menu. 

! “Last Called” is configured when “None” or “Selected” is 
selected from the Priority 2 pulldown menu while “Priority 2” or 
“Priority 2 + Talk Back” is selected from the Revert CH/GID 
pulldown menu. 

6.9.6 Dropout Delay Time

Configure the delay time to resume scanning after the 
transceiver stops receiving.  Enter a value for Dropout 
Delay Time directly in the edit box or click the spin button 
to configure the Dropout Delay Time.  (Refer to FUNC 
23.7.7 Dropout Delay Time.) 

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.9.7 Dwell Time

The scan is paused when the PTT switch is pressed.  For 
the Dwell Time, configure the time until the scan is 
resumed after transmission ends.  (Refer to  FUNC 23.7.8 
Dwell Time.) 
Enter a value for Dwell Time directly in the edit box or 
click the spin button to configure the Dwell Time.  

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

Range

Last Called

Transmits on the last called 
Zone-CH/GID when the PTT 
switch is pressed during the 
scan. 
Transmits on the current Zone-
CH/GID when the PTT switch is 
pressed while the scan is 
paused. 

Last Used

Transmits on the last transmitted 
Zone-CH/GID when the PTT 
switch is pressed during the 
scan. 
Transmits on the current Zone-
CH/GID when the PTT switch is 
pressed while the scan is 
paused. 

Selected

Transmits on the new CH/GID 
after the Zone-CH/GID is 
changed regardless of the 
scanning status. 

Selected + 
TalkBack

Transmits on the new Zone-CH/
GID after the Zone-CH/GID is 
changed during the scan. 
Transmits on the current Zone-
CH/GID while the scan is 
paused. 

Priority 1
Transmits by Priority 1 
regardless of the scanning 
status. 

Priority 1 + 
TalkBack

Transmits by Priority 1 during the 
scan. 
Transmits on the current Zone-
CH/GID while the scan is 
paused. 

Priority 2
Transmits by Priority 2 
regardless of the scanning 
status. 

Priority 2 + 
TalkBack

Transmits by Priority 2 during the 
scan. 
Transmits on the current Zone-
CH/GID while the scan is 
paused. 

Default Last Called

Range 0 - 300 s

Step 1 s

Default 3 s

Range 0 - 300 s

Step 1 s

Default 3 s
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6.9.8 Look Back Time A

Configure the time to send the Priority Channel is 
inspected from the normal channel when no carrier is 
detected on the Priority Channel during the Priority Scan.  
Configure the shorter interval time than Look Back Time 
B because there is a possibility that the transceiver 
always waits the Priority Channel signal.  (Refer to FUNC 
23.7.9 Look Back.) 
Enter a value for Look Back Time A directly in the edit box 
or click the spin button to configure the Look Back Time 
A. 
 

Note:

!  A maximum of 3-digit frequency and “.” (period) can be entered. 

! When the entire content of the edit box is deleted, 0.50 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded. 

! The Look Back Time A edit box cannot be configured when 
“None” is selected from the Priority 1 and Priority 2 pulldown 
menus. 

6.9.9 Look Back Time B

Configure the time to scan the Priority Channel from the 
normal channel when incoming QT/DQT does not match 
own QT/DQT even though a carrier is detected on the 
Priority Channel during the Priority Scan.  (Refer to FUNC 
23.7.9 Look Back.) 
Enter a value for Look Back Time B directly in the edit box 
or click the spin button to configure the Look Back Time 
B.  

Note:

!  A maximum of 3-digit frequency and “.” (period) can be entered. 

! When the entire content of the edit box is deleted, 0.50 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded. 

! The Look Back Time B edit box cannot be configured when 
“None” is selected from the Priority 1 and Priority 2 pulldown 
menus. 

6.9.10 Scan Type

To configure the scan options of the transceiver, select 
the desired Scan Type from the pulldown menu.  (Refer to 
FUNC 23.7.10 Scan Type.) 

6.9.11 AC Control

Configure whether or not to disable QT/DQT on the 
Priority Channel and the Squelch is controlled by a carrier 
during the Priority Scan.  (Refer to FUNC 23.7.11 AC 
Control.) 

Range 0.50 - 5.00 s

Step 0.05 s

Default 0.50 s

Range 0.50 - 5.00 s

Step 0.05 s

Default 2.00 s

Range

Single

Scans Add CH/GID within the 
zone when the scan starts.  The 
Priority Channel also is scanned 
when the Priority Channel is 
configured. 

Multi

Scans Add CH/GID of all zones 
configured as Add.  The Priority 
Channel is also scanned when 
the Priority Channel is 
configured. 

List

Scans the Add CH/GID 
configured in Scan List of the 
zone when the scan starts.  
Priority Channel is also scanned 
when the Priority Channel is 
configured. 

Default Single

Range

Check (Enable)

QT/DQT on the Priority 
Channel is disabled and 
the Squelch is controlled 
by a carrier. 

Uncheck (Disable)

QT/DQT on the Priority 
Channel is disabled and 
the Squelch is not 
controlled by a carrier. 

Default Unchecked (Disabled)
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6.9.12 Priority 1 Temporary Delete/
Add

Configure to allow the Temporary Delete/Add operations 
on Priority 1 when the PF Scan Del/Add key is pressed 
while the scan is paused on Priority 1. 

Note: Priority 1 Temporary Delete/Add cannot be configured when 
“None” is selected in the Priority 1 pulldown menu. 

6.9.13 Priority 2 Temporary Delete/
Add

Configure to allow the Temporary Delete/Add operations 
on Priority 2 when the PF Scan Del/Add key is pressed 
while the scan is paused on Priority 2. 

Note: Priority 2 Temporary Delete/Add cannot be configured when 
“None” is selected in the Priority 2 pulldown menu. 

6.9.14 Off-hook Scan 
(TK-7180/ 8180 only)

Configure the Off-hook Scan function.  Scanning options 
can be configured in the Off-hook Scan function 
depending on the Mic Hook status. 

6.9.15 Revert CH/GID Display

Configure whether or not to display Revert Zone-CH/GID 
during the scan. 

6.9.16 Priority Channel Stop Tone

Configure whether or not to emit the Priority Channel Stop 
Tone when a channel is changed or a carrier is received, 
and the transceiver stops on a Priority Channel. 

Range
Check (Enable) Temporary Delete/Add is 

allowed on Priority 1. 

Uncheck (Disable) Temporary Delete/Add is 
not allowed on Priority 1. 

Default Unchecked (Disabled)

Range
Check (Enable) Temporary Delete/Add is 

allowed on Priority 2. 

Uncheck (Disable) Temporary Delete/Add is 
not allowed on Priority 2. 

Default Unchecked (Disabled)

Range

Check (Enable)

The scan starts by 
pressing the PF Scan key 
regardless of the On-hook 
or Off-hook status. 

Uncheck (Disable)

Scanning starts when the  
PF Scan key is pressed in 
the On-hook state.  
However, in the Off-hook 
state, an error occurs and 
the scan cannot be 
started. 
When the On-hook state is 
changed to Off-hook in 
Scan Mode, scanning is 
paused on Revert CH/GID.  
Scanning is resumed 
when it becomes the On-
hook state. 

Default Checked (Enabled)

Range

Check (Enable) Displays Revert Zone-CH/
GID. 

Uncheck (Disable)
Revert Zone-CH/GID is 
not displayed and “SCAN” 
appears. 

Default Unchecked (Disabled)

Range
Check (Enable) Emits the Priority Channel 

Tone.

Uncheck (Disable) Does not emit the Priority 
Channel Tone.

Default Unchecked (Disabled)
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6.9.17 Power-on Scan

Configure whether or not to start the scan when the 
transceiver is turned ON. 

6.10 DTMF Window

In the DTMF window, configure the DTMF-signaling 
options.
The DTMF window has the following tabs.  The tab sheet 
can be selected by clicking each tab. 
• Encode tab
• Decode tab
• Autodial List tab

6.10.1 Encode Tab

In the Encode tab, configure the DTMF Encode options. 

Figure 6-37   Encode Tab

" DTMF Speed
Configure the DTMF automatic transmission speed 
when it is used for PTT ID, Autodial or Store & Send.  
Enter a value directly in the edit box or click the spin 
button to configure the DTMF Speed.  (Refer to FUNC 
20.2.1 DTMF Speed.) 

Note:

! A maximum of 2-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 6 will be 
configured. 

! When a value other outside the available range is entered, 
the value is configured as follows:

• 6 will be configured when “0” to “5” or “7” is entered.

• 8 will be configured when “9” is entered.

• 10 will be configured when “11” - “14” is entered.

• 15 will be configured when “16” or more is entered.

" First Digit Delay Time
Configure the First Digit Delay Time function.  The 
First Digit Delay Time function is a delay time to 
transmit the DTMF codes when the PTT switch is 
pressed.  (Refer to FUNC 20.2.2 First Digit Delay 
Time.) 
Enter a value for First Digit Delay Time directly in the 
edit box or click the spin button to configure the First 
Digit Delay Time. 

Note:

! A maximum of 4-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded.

" First Digit Time
The First Digit Time function adjusts the time length of 
the first DTMF digit.  (Refer to FUNC 20.2.3 First Digit 
Time.) 
Enter a value for First Digit Time directly in the edit 
box or click the spin button to configure the First Digit 
Time. 

Range

Check (Enable) Starts the scan when the 
transceiver is turned ON. 

Uncheck (Disable)
Does not start the scan  
when the transceiver is 
turned ON.

Default Unchecked (Disabled)

Range 6/ 8/ 10/ 15 digit/s

Default 6 digit/s

Range 0 - 1000 ms

Step 50 ms

Default 200 ms

Range 0/ 100/ 500/ 1000 ms

Default 0 ms
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Note:

! A maximum of 4-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value other outside the available range is entered, 
values are configured as follows:

• 0 will be configured when “1” - “99” is entered.

• 100 will be configured when “101”  - “499” is entered.

• 500 will be configured when “501”  -  “999” is entered.

• 1000 will be configured when “1001” or more is entered.

" * and # Digit Time
Configure * and # Digit Time.  * and # Digit Time are 
the transmission extended time of the * Tone and # 
Tone when the DTMF code is automatically 
transmitted.  (Refer to FUNC 20.2.4 * and # Digit 
Time.) 
Enter a value for First Digit Time directly in the edit 
box or click the spin button to configure the First Digit 
Time. 

Note:

! A maximum of 4-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value other outside the available range is entered, 
values are configured as follows:

• 0 will be configured when “1” - “99” is entered.

• 100 will be configured when “101”  - “499” is entered.

• 500 will be configured when “501”  -  “999” is entered.

• 1000 will be configured when “1001” or more is entered.

" DTMF Hold Time
Configure the time to return to receive after the key is 
released while using Keypad Auto PTT.   Enter a value 
for DTMF Hold Time directly in the edit box or click the 
spin button to configure the DTMF Hold Time.  (Refer 
to FUNC 20.2.5 DTMF Hold Time.) 

Note:

!  A maximum of 2-digit number and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, Off will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded.

" D Code Assignment
Configure whether to use the [D] key as the DTMF D 
Code, or to use it as a pause during the transmission 
of Store & Send, Auto Telephone or PTT ID.  Enter a 
value directly in the edit box or click the spin button to 
configure the D Code Assignment.  (Refer to FUNC 
20.2.6 D Code Assignment.) 

Note:

!  A maximum of 2-digit numbers and “D” can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When “D” is entered, the D Code will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Sidetone
Configure whether or not to monitor the DTMF 
transmission tone through the speaker while the 
DTMF code is transmitted.  (Refer to FUNC 20.2.7 
DTMF Sidetone.) 

" Manual Dialing
Configure to enable or disable the Manual Dialing 
function.  Manual Dialing allows you to transmits the 
DTMF tone corresponding to the key when [0] - [9], 
[*], [#] on the Mic Keypad are pressed while 
transmitting by pressing the PTT switch.  (Refer to 
FUNC 20.1.1 Manual Dialing.) 

" Store & Send
Configure to enable or disable the Store & Send 
function.  With the Store & Send function, the desired 
DTMF codes can be transmitted using a keypad.   A 
series of DTMF code can be entered and then it can 
be transmitted later.  A maximum of 30 digits can be 
transmitted in a single Store & Send operation.  (Refer 
to FUNC 20.1.2 Store & Send.) 

Range 0/ 100/ 500/ 1000 ms

Default 0 ms

Range Off/ 0.5 - 2.0 s

Step 0.5 s

Default 2.0 s

Range D Code/ 1 - 16 s

Step 1 s

Default D Code

Range
Check (Enable) Emits the DTMF 

transmission tone. 

Uncheck (Disable) Does not emit the DTMF 
transmission tone. 

Default Checked (Enabled)

Range
Check (Enable) Enables Manual Dialing. 

Uncheck (Disable) Disables Manual Dialing. 

Default Checked (Enabled)
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" Auto Telephone
Configure to enable or disable the Auto Telephone 
function.  If Auto Telephone is enabled, the Auto 
Telephone function can be used when the transceiver 
enters Autodial Mode.  (Refer to FUNC 20.2.8 Auto 
Telephone.) 

6.10.2 Decode Tab

In the Decode tab, the DTMF decode options can be 
configured. 

Figure 6-38   Decode Tab

" Code (Decode)
Configure the standby code for individual calling. 
Enter the desired codes directly to the No. 1 and No. 2 
edit boxes.  (Refer to FUNC 20.3.1 1st Code/2nd 
Code.) 

" Transpond (Decode)
Configure whether or not to enable Transpond when 
the standby code matches.  From the Transpond No. 
1 or No. 2 pulldown menu, select the desired option.  
(Refer to FUNC 20.3.2 Decode Response.) 

" Alert Tone (Decode)
Configure the Alert tone when the standby codes 
match.  Enter a value directly in the Alert Tone No. 1 
or No. 2 edit box or click the spin button to configure 
the Alert Tone.  (Refer to FUNC 20.3.2 Decode 
Response.) 

Note:

! Only 1 to 8 can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When “0” is entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Stun Code
Configure the Stun standby code.  Enter the desired 
string directly in the edit box to configure the Stun 
Code.  (Refer to FUNC 20.3.3 Stun.) 

Range
Check (Enable) Enables Store & Send. 

Uncheck (Disable) Disables Store & Send. 

Default Unchecked (Disabled)

Range
Check (Enable) Enables Auto Telephone. 

Uncheck (Disable) Disables Auto Telephone. 

Default Unchecked (Disabled)

Range A maximum of a 10-digit string

Available 
Codes # * 0 1 2 3 4 5 6 7 8 9 A B C D

Default
Decoder 1 159D

Decoder 2 A68*

Range
Yes Enables Transpond when the 

standby code matches. 

No Disables Transpond when the 
standby code matches. 

Default No

Range Off/ 1 - 8

Step 1

Default
Decoder 1 1

Decoder 2 2

Range A maximum of a 10-digit string

Available 
Codes # * 0 1 2 3 4 5 6 7 8 9 A B C D

Default Blank
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" Stun Code Response
Configure transceiver action when the Stun Codes 
matches.  Select the desired Stun Code Response 
option from the pulldown menu.  (Refer to FUNC 
20.3.3 Stun.) 

Note: The Stun Code Response cannot be configured when 
the Stun Code edit box is a blank. 

" Auto Reset Timer (Auto Reset)
Configure the time to reset the DTMF match state  
automatically.  Enter the time directly in the edit box or 
click the spin button to configure the Auto Reset 
Timer.  (Refer to FUNC 20.3.4 Auto Reset Timer.) 

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, Off will be 
configured. 

! When “0” is entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" LED (Auto Reset)
Configure whether or not to turn Off the Selective Call 
Alert LED after Auto Reset Timer expires.  (Refer to 
FUNC 20.3.4 Auto Reset Timer.) 

Note: The LED (Auto Reset) cannot be configured when Off is 
configured to the Auto Reset Timer edit box. 

" Alert (Auto Reset)
Configure whether or not to stop emitting the Alert 
Tone after Auto Reset Timer expires.  (Refer to FUNC 
20.3.4 Auto Reset Timer.) 

Note: Alert (Auto Reset) cannot be configured when Off is 
configured to the Auto Reset Timer edit box. 

" Monitor (Auto Reset)
Configure whether or not to reset the DTMF match 
state after the Auto Reset Timer is expires.  (Refer to 
FUNC 20.3.4 Auto Reset Timer.) 

Note: Monitor (Auto Reset) cannot be configured when Off is 
configured to the Auto Reset Timer edit box. 

" Clear to Transpond
Configure to enable or disable the Clear to Transpond 
function.  The Clear to Transpond function waits for 
sending Transpond until the channel becomes free, 
while other users are using the channel.  (Refer to 
FUNC 20.3.5 Clear to Transpond.) 

" Selective Call Alert LED
Configure whether or not to make Selcall Alert LED 
blink when the code is received.  (Refer to FUNC 
20.3.6 Selective Call Alert LED.) 

Range

TX Inhibit Restricts the transmission. 

Transceiver 
Inhibit

Restricts the transmission 
and receiving.  All 
transceiver operations are 
restricted.  When the PTT 
switch is pressed, the 
Warning Tone sounds.  If a 
key is pressed, the Key-entry 
Error Tone sounds. 

Default TX Inhibit

Range Off/ 1 - 300 s

Step 1 s

Default 10 s

Range

Check (Enable)
Selective Call Alert LED is 
turned out after Auto 
Reset Timer expires. 

Uncheck (Disable)
Selective Call Alert LED is 
not turned out after Auto 
Reset Timer expires. 

Default Checked (Enabled)

Range

Check (Enable)
Stops emitting Alert Tone 
after Auto Reset Timer 
expires. 

Uncheck (Disable)
Does not stop emitting 
Alert Tone after Auto 
Reset Timer expires. 

Default Checked (Enabled)

Range
Check (Enable) Resets the DTMF match 

state. 

Uncheck (Disable) Does not reset the DTMF 
match state. 

Default Checked (Enabled)

Range
Check (Enable) Enables Clear to 

Transpond. 

Uncheck (Disable) Disables Clear to 
Transpond. 

Default Unchecked (Disabled)

Range
Check (Enable) Makes Selcall Alert LED 

blink. 

Uncheck (Disable) Does not make Selcall 
Alert LED blink. 

Default Checked (Enabled)
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6.10.3 Autodial List Tab

In the Autodial List tab, the Autodial List options can be 
configured. 

Figure 6-39   Autodial List Tab

" DTMF Name (Autodial List)
Configure the name of the DTMF code to be used for 
the Autodial function.  Enter the code to the No. 1 to 
No. 32 edit boxes to configure the DTMF Name.  
(Refer to FUNC 20.4.1 Autodial List.) 

" Code (Autodial List)
Configure the DTMF code to be used for autodialing.  
Directly enter the code to the No. 1 to No. 32 edit 
boxes to configure the code.  (Refer to FUNC 20.4.1 
Autodial List.) 

6.11 2-tone Window

In the 2-tone window, the 2-tone Signaling options can be 
configured.
The 2-tone window has the following tabs.  Each tab can 
be selected by clicking the tab title. 
• Encode tab
• Decode (2-tone 1) tab
• Decode (2-tone 2) tab
• Decode (2-tone 3) tab
• Decode (2-tone 4) tab

6.11.1 Encode Tab

In the Encode tab, 2-tone Encode options can be 
configured. 

Figure 6-40   Encode Tab

" Duration of 1st Tone
Configure the 1st Tone Encode time when the 2-tone 
in the 2-tone Encode Memory List is transmitted.  
Usually, 1 second is configured.  (Refer to FUNC 
21.2.1 Duration of 1st Tone.) 
Enter the time directly in the edit box or click the spin 
button to configure the Duration of 1st Tone. 

Note:

!  A maximum of 2-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 0.5 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

Range A maximum of a 12-digit string

Available 
Codes

(space) ! “ # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default Blank

Range A maximum of a 16-digit string

Available 
Codes # * 0 1 2 3 4 5 6 7 8 9 A B C D

Default Blank

Range 0.5 - 1.5 s

Step 0.1 s

Default 1.0 s
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" Duration of 2nd Tone
Configure the 2nd Tone Encode time when the 2-tone 
in the 2-tone Encode Memory List is transmitted.  
Usually, 3 seconds are configured.   (Refer to FUNC 
21.2.2 Duration of 2nd Tone.) 
Enter the time directly in the edit box or click the spin 
button to configure the Duration of 2nd Tone. 

Note:

!  A maximum of 2-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 1.0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Duration of Single Tone
Configure the Single Tone Encode time when the 
Single Tone in the 2-tone Encode Memory List is 
transmitted.  Usually, 5 seconds are configured  (Refer 
to FUNC 21.2.3 Duration of Signal Tone.) 
Enter the time directly in the edit box or click the spin 
button to configure the Duration of Single Tone. 

Note:

!  A maximum of 3-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 3.0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" Gap Time
Configure the 1st Tone and 2nd non-modulation time 
when the 2-tone in the 2-tone Encode Memory List is 
transmitted.  Usually, 0 ms is configured.  (Refer to 
FUNC 21.2.4 Gap Time.) 

Enter the time directly in the edit box or click the spin 
button to configure Gap Time. 

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded.

" First Tone Delay Time
Configure the Delay Time to transmit the first tone 
when transmitting 2-tone.  (Refer to FUNC 21.2.5 First 
Tone Delay Time.) 
Enter the time directly in the edit box or click the spin 
button to configure the First Tone Delay Time. 

Note:

! A maximum of 4-digit numbers can be entered. 

! When the entire content of the edit box is deleted, 0 will be 
configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A value less than a single step is discarded.

" Sidetone
Configure whether or not to emit the 2-tone 
transmission tone from the speaker while the 2-tone is 
transmitted.  (Refer to FUNC 21.2.6 Sidetone.) 

" Single Tone (2-tone Encode Memory List)
Configure the code transmitted by List number to be 
defined as a Single Tone format for each List number.  
Select the desired Single Tone from the No. 1 to No. 
20 pulldown menus.  (Refer to FUNC 21.2.7 2-tone 
Encode Memory List.) 

Range 1.0 - 4.0 s

Step 0.1 s

Default 3.0 s

Range 3.0 - 10.0 s

Step 0.1 s

Default 5.0 s

Range 0 - 500 ms

Step 100 ms

Default 0 ms

Range 0 - 1000 ms

Step 50 ms

Default 200 ms

Range
Check (Enable) Emits the 2-tone 

transmission tone. 

Uncheck (Disable) Does not emit the 2-tone 
transmission tone. 

Default Checked (Enabled)
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" 2-tone Name (2-tone Encode Memory List)
Configures the name for each List number.  Enter the 
name to the No. 1 to No. 32 edit boxes to configure 
the 2-tone Name.  (Refer to FUNC 21.2.7 2-tone 
Encode Memory List.) 

" 1st Tone (2-tone Encode Memory List)
Configure the 1st Tone frequency.  Enter the desired 
frequency to the No. 1 to No. 32 edit boxes to 
configure the 1st Tone frequency.  (Refer to FUNC 
21.2.7 2-tone Encode Memory List.) 

Note:

!  A maximum of 5-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, a blank 
will be configured.  A blank is also configured to the 2nd 
Tone edit box. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" 2nd Tone (2-tone Encode Memory List)
Configure the 2nd Tone frequency.  Enter the desired 
frequency to the No. 1 to No. 32 edit boxes to 
configure the 2nd Tone frequency.  (Refer to FUNC 
21.2.7 2-tone Encode Memory List.) 

Note:

!  A maximum of 5-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, a blank 
will be configured.  “Yes” is selected to the Single Tone. 

! 2nd Tone cannot be configured when “Yes” is selected in the 
Single Tone pulldown menu.

! 2nd Tone can be configured only when the 1st Tone edit box 
is configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

6.11.2 Decode Tab

In the Decode tab, the 2-tone Signaling Decode 
options can be configured.  2-tone 1, 2-tone 2, 2-tone 
3, and 2-tone 4 can be configured as Optional 
Signaling to each Conventional Group channel. 

Figure 6-41   Decode Tab

" Call Format (Decoder 1 - 4)
Configure the combination of 2-tone code to be 
decoded.  Select the desired Call Format from the 
Call Format No. 1 to No. 4 edit boxes.  (Refer to 
FUNC 21.3.1 Decoder 1 - 4.) 

Range
Yes Defines the code as a Single Tone. 

No Does not define the code as a Single 
Tone. 

Default No

Range A maximum of a 12-digit string

Available 
Characters

(space) ! “ # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default List 1 2-TONE 1

List 2 - 32 Blank

Range Blank/ 288.5 - 3106.0 Hz

Step 0.1 Hz

Default List 1 321.7 Hz

List 2 - 32 Blank

Range Blank/ 288.5 - 3106.0 Hz

Step 0.1 Hz

Default List 1 928.1 Hz

List 2 - 32 Blank

Range
None/ A-B/ A-C/ A-D/ B-A/ B-C/ B-D/ C-A/ C-B/ 
C-D/ D-A/ D-B/ D-C/ Long A/ Long B/ Long C/ 
Long D

Default Decoder 1 A-B

Decoder 2 - 4 None
Version: 1.11 Field Programming Reference 79



6 EDIT MENU
Table 6-7   Call Format

Note:

! “None” cannot be selected from the Call Format pulldown 
menu of Decoder 1. 

! Items except “None” cannot be selected at the same time 
from the Call Format pulldown menu. 

" Transpond (Decoder 1 - 4)
Configure whether or not to enable Transpond when 
the standby code matches.  Select the desired 
Transpond option from the Transpond No. 1 to No. 4 
edit boxes.  (Refer to FUNC 21.3.1 Decoder 1 - 4.) 

Note: Transpond cannot be configured when “None” is 
selected from the Call Format edit box. 

" Alert Tone (Decoder)
Configure Alert Tone when the standby code matches.  
Enter the Alert Tone number directly in the Alert Tone 
No. 1 to No. 4 edit boxes or click the spin button to 
configure Alert Tone number.  (Refer to FUNC 21.3.1 
Decoder 1 - 4.) 

Note:

! Only 0 to 8 can be entered. 

! When the entire content of the edit box is deleted, 1 will be 
configured. 

! When “0“ is entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! Alert Tone cannot be configured when “None“ is selected 
from the Call Format pulldown menu. 

" A Tone
Configure the tone signal frequency to wait for.  Enter 
the A Tone frequency directly in the edit box or click 
the spin button to configure the A Tone frequency.  
(Refer to FUNC 21.3.2 A Tone/ B Tone/ C Tone/ D 
Tone.) 

Note:

!  A maximum of 5-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 288.5 will 
be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! A Tone can be configured when one of the following values 
is selected from the Call Format pulldown menu. 

• A-B

• A-C

• A-D

• B-A

• C-A

• D-A

• Long A

A-B Waits for A Tone and B 
Tone

Usually, the transceiver 
waits for the First Tone 
for 1 second and the 
Second Tone for 3 
seconds. 

A-C Waits for A Tone and C 
Tone

A-D Waits for A Tone and D 
Tone

B-A Waits for B Tone and A 
Tone

B-C Waits for B Tone and C 
Tone

B-D Waits for B Tone and D 
Tone

C-A Waits for C Tone and A 
Tone

C-B Waits for C Tone and B 
Tone

C-D Waits for C Tone and D 
Tone

D-A Waits for D Tone and A 
Tone

D-B Waits for D Tone and B 
Tone

D-C Waits for D Tone and C 
Tone

Long A Waits for A Tone
The transceiver waits for 
the Single Tone for 5 
seconds or longer. 

Long B Waits for B Tone

Long C Waits for C Tone

Long D Waits for D Tone

Range
Yes Enables Transpond when the 

standby code matches. 

No Disables Transpond when the 
standby code matches. 

Default No

Range Off/ 1 - 8

Step 1

Default

Decoder 1 1

Decoder 2 2

Decoder 3 6

Decoder 4 7

Range 288.5 - 3106.0 Hz

Step 0.1 Hz

Default 321.7 Hz
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" B Tone
Configure the tone signal frequency to wait for.  Enter 
the B Tone frequency directly in the edit box or click 
the spin button to configure the B Tone frequency.  
(Refer to FUNC 21.3.2 A Tone/ B Tone/ C Tone/ D 
Tone.) 

Note:

!  A maximum of 5-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 288.5 will 
be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! B Tone can be configured when one of the following values 
is selected from the Call Format pulldown menu. 

• B-A

• B-C

• B-D

• A-B

• C-B

• D-B

• Long B

" C Tone
Configure the tone signal frequency to wait for.  Enter 
the C Tone frequency directly in the edit box or click 
the spin button to configure the C Tone frequency.  
(Refer to FUNC 21.3.2 A Tone/ B Tone/ C Tone/ D 
Tone.) 

Note:

!  A maximum of 5-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 288.5 will 
be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! C Tone can be configured when one of the following values 
is selected from the Call Format pulldown menu. 

• C-A

• C-B

• C-D

• A-C

• B-C

• D-C

• Long C

" D Tone
Configure the tone signal frequency to wait for.  Enter 
the D Tone frequency directly in the edit box or click 
the spin button to configure the D Tone frequency.  
(Refer to FUNC 21.3.2 A Tone/ B Tone/ C Tone/ D 
Tone.) 

Note:

!  A maximum of 5-digit numbers and “.” (period) can be 
entered. 

! When the entire content of the edit box is deleted, 288.5 will 
be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

! D Tone can be configured when one of the following values 
is selected from the Call Format pulldown menu. 

• D-A

• D-B

• D-C

• A-D

• B-D

• C-D

• Long D

" Clear to Transpond
Configure to enable or disable the Clear to Transpond 
function.  The Clear to Transpond function waits for 
sending Transpond until the channel becomes free, 
while other users are using the channel.  (Refer to 
FUNC 21.3.4 Clear to Transpond.) 

" Selective Call Alert LED
Configure whether or not to make Selcall Alert LED 
blink when the code is received.  (Refer to FUNC 
20.3.6 Selective Call Alert LED.) 

Range 288.5 - 3106.0 Hz

Step 0.1 Hz

Default 928.1 Hz

Range 288.5 - 3106.0 Hz

Step 0.1 Hz

Default 600.9 Hz

Range 288.5 - 3106.0 Hz

Step 0.1 Hz

Default 2043.8 Hz

Range
Check (Enable) Enables Clear to 

Transpond. 

Uncheck (Disable) Disables Clear to 
Transpond. 

Default Unchecked (Disabled)

Range
Check (Enable) Makes Selcall Alert LED 

blink. 

Uncheck (Disable) Does not make Selcall 
Alert LED blink. 

Default Checked (Enabled)
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" Auto Reset Timer
Configure the duration to automatically reset the 2-
tone matching status.  Enter a value for Auto Reset 
Timer directly in the edit box or click the spin button to 
configure the Auto Reset Timer.  (Refer to FUNC 
21.3.3 Auto Reset Timer.) 

Note:

! A maximum of 3-digit numbers can be entered. 

! When the entire content of the edit box is deleted, Off will be 
configured. 

! When “0” is entered, Off will be configured. 

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or lower limit value of the 
range. 

" LED (Auto Reset)
Configure whether or not to turn Off the Selective Call 
Alert LED after Auto Reset Timer expires.  (Refer to 
FUNC 21.3.3 Auto Reset Timer.) 

Note: The LED (Auto Reset) cannot be configured when Off is 
configured to the Auto Reset Timer edit box. 

" Alert Tone (Auto Reset)
Configure whether or not to stop emitting Alert Tone 
after Auto Reset Timer expires.  (Refer to FUNC 
21.3.3 Auto Reset Timer.) 

Note: The Alert Tone (Auto Reset) cannot be configured when 
Off is configured to the Auto Reset Timer edit box.

" Monitor (Auto Reset)
Configure whether or not to reset the DTMF matching 
status after Auto Reset Timer expires.  (Refer to 
FUNC 21.3.3 Auto Reset Timer.) 

Note: Monitor (Auto Reset) cannot be configured when Off is 
configured to the Auto Reset Timer edit box. 

6.12 FleetSync Window

You can configure the FleetSync function in the 
FleetSync window.
This window consists of the following tabs and you can 
switch the window by clicking the tabs.
• General 1 Tab
• General 2 Tab
• Parameter Tab
• ID List Tab
• Status List Tab
• GPS Tab
• Target Tab

6.12.1 General 1 Tab

This General 1 tab allows you to configure the general 
FleetSync functions.

Figure 6-42   General 1 Tab

Range Off/ 1 - 300 s

Step 1 s

Default 10 s

Range

Check (Enable)
Selective Call Alert LED is 
turned Off after Auto Reset 
Timer expires. 

Uncheck (Disable)
Selective Call Alert LED is 
not turned Off after Auto 
Reset Timer expires. 

Default Checked (Enabled)

Range

Check (Enable)
Stop emitting Alert Tone 
after Auto Reset Timer 
expires. 

Uncheck (Disable)
Does not stop emitting 
Alert Tone after Auto 
Reset Timer expires. 

Default Checked (Enabled)

Range
Check (Enable) Resets the 2-tone 

matching status. 

Uncheck (Disable) Does not reset the 2-tone 
matching status. 

Default Checked (Enabled)
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" Fleet (Own)
Configure the Fleet of the FleetSync ID.  Configure the 
Fleet by directly entering value in the edit box or 
clicking the spin buttons.  (Refer to FUNC 22.9.1 Own 
Fleet/ ID.)

Note:

! Only 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.  The ID (Own) edit box will be left blank.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

! If the ID (Own) edit box is blank when the value is entered, 
the ID (Own) edit box is configured to “1000”.

! The error message appears when trying to write data while 
the Fleet (Own) edit box is configured to a blank if one of 
the following pulldown menu is configured as FleetSync.

• The Optional Features window > the Common-Page 3 
tab > the PTT ID Type pulldown menu

• The Emergency Information window > the Emergency 
ID pulldown menu

" ID (Own)
Configure the ID of the FleetSync ID.  Configure the 
ID (OWN) by directly entering value in the edit box or 
clicking the spin buttons.  (Refer to FUNC 22.9.1 Own 
Fleet/ ID.)

Note:

! Only 4-digit numbers can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.  The Fleet (Own) edit box will be also left 
blank.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

! If the Fleet (Own) edit box is a blank when the value was 
entered, the Fleet (Own) edit box is configured to “100”.

! The error message appears when trying to write data while 
the ID (Own) edit box is configured to a blank if one of the 
following pulldown menu is configured as FleetSync.

• The Optional Features window > the Common-Page 3 
tab > the PTT ID Type pulldown menu

• The Emergency Information window > the Emergency 
ID pulldown menu

" Unit ID Encode Block (Start/ End)
This function allows a user to configure the range of 
the FleetSync ID that can be called by the transceiver.  
Configure the Unit ID Encode Block by entering the 
number in Start and End edit boxes.  (Refer to FUNC 
22.9.2 Unit ID Encode Block.)

Note:

! Only 4-digit numbers can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

! If the End edit box is a blank or the value configured to the 
box is smaller than the value configured to the Start edit 
box, the End edit box is configured to “4999”.

! If the value configured to the Start box is largerthan the 
value configured to the End edit box, the same value as the 
Start edit box is configured to the End edit box.

! If the Start edit box is configured to a blank, the Start edit 
box is configured to “1000”.

" FleetSync Baud Rate
The function allows you to select the desired data 
communication speed of the MSK Modem in the 
FleetSync system.  Select the desired FleetSync Baud 
Rate from the pulldown menu.  (Refer to FUNC 22.9.4 
FleetSync Baud Rate.)

Range Blank/ 100 - 349

In steps of 1

Default Blank

Range Blank/ 1000 - 4999

In steps of 1

Default Blank

Range Blank/ 1000 - 4999

In steps of 1

Default Blank

Range

1200 bps

Enables data communication at 
1200 bps.  This configuration is 
recommended for normal 
communications.

2400 bps

Enables data communication at 
2400 bps.
With this configuration, a user 
can transmit more data in shorter 
time as compared with 1200 bps. 
However, errors are more likely 
to occur as communications are 
performed at high speeds.
The data communications area 
is smaller than 1200 bps.

Default 1200 bps
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" Emergency Status Response
You can configure the transceiver's operation after 
receiving the Emergency Status.  Select the desired 
Emergency Status Response from the pulldown 
menu.  (Refer to FUNC 22.3.14 Emergency Status 
Response.)

Note:

! You cannot select “Horn” for the TK-2180/ 3180 
transceivers.

! If the TK-2180/ TK-3180 is selected in the Model 
Information window > the Model Name pulldown menu, the 
Horn will be configured to None.

" Message Display Type
This function allows you to configure the display when 
receiving the Status/ Short Message.  You can select 
the desired Message Display Type from the pulldown 
menu.  (Refer to FUNC 22.9.19 Message Display 
Type.)

" PC Interface Protocol
Configure the PC Interface Protocol.  Select the 
desired PC Interface Protocol from the pulldown 
menu.  (Refer to FUNC 22.9.25 PC Interface 
Protocol.)

Note: The same PC Interface Protocol as the TK-280/ 780/ 
7150 is used for the Ver. 1.

" FleetSync II
You can configure the FleetSync II format to be used 
for data communications.  The FleetSync II is a new 
FleetSync format utilizing FEC (Forward Error 
Correction) technology.  This format corrects errors in 
order to perform more reliable data communications 
than conventional data communications.  (Refer to 
FUNC 22.9.6 FleetSync II.)

" Manual Dialing
You can enable or disable the Manual Dialing function.  
When this function is enabled, you can directly enter 
the Fleet/ID using the [ ]/ [ ] keys.  (Refer to FUNC 
22.9.7 Manual Dialing.)

" Status 80 - 99 (Special)
You can enable or disable the Status 80 - 99 (Special) 
transmission.  (Refer to FUNC 22.3.13 Status 80 - 99 
(Special).)

" Selective Call Alert LED
This function makes the Selcall Alert LED blink when 
receiving a code.  (Refer to FUNC 20.3.6 Selective 
Call Alert LED.)

Range

None The transceiver works as normal.

Alert Tone

Alert Tone configured in the 
Emergency Status sounds when 
receiving the Emergency Status.  
Press any key other than Volume 
Up/ Down to stop the Alert Tone.

Horn

The Horn Alert terminal is activated 
when receiving the Emergency 
Status.  The operation of the Horn 
varies depending on the Horn Alert 
configuration.

Default None

Range
Fixed

“STM/ SDM” appears on the display 
when receiving a call.  A user can 
scroll the message when the 
message is longer than 13 
characters.

Alternate “STM/SDM” and Selcall ID appears 
alternatively when receiving a call.

Default Alternate

Range
Ver.1 The Ver. 1 is used as the PC 

Interface Protocol.

Ver.2 The Ver. 2 is used as the PC 
Interface Protocol.

Default Ver.1

Range

Check (Enable)
The FleetSync II format is 
used for data 
communications.

Uncheck (Disable)
The FleetSync format is 
used for data 
communications.

Default Unchecked (Disabled)

Range
Check (Enable) The Manual Dialing 

function is enabled.

Uncheck (Disable) The Manual Dialing 
function is disabled.

Default Checked (Enabled)

Range

Check (Enable)
The Status 80 - 99 
(Special) transmission is 
enabled.

Uncheck (Disable)
The Status 80 - 99 
(Special) transmission is 
disabled.

Default Unchecked (Disabled)

Range
Check (Enable) The Selcall Alert LED 

blinks.

Uncheck (Disable) The Selcall Alert LED does 
not blink.

Default Unchecked (Disabled)
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" Interfleet Call
You can enable or disable the Interfleet Call.  This 
function allows a user to make a call using the 
FleetSync ID having the different Fleet.  It also 
prevents Interfleet IDs from being used inadvertently.  
(Refer to FUNC 22.9.6 3 Interfleet Call.)

" PTT ID Sidetone
This function allows the transceiver to emit the 
FleetSync ID transmission tone when sending the 
FleetSync ID.  (Refer to FUNC 22.1.2 PTT ID 
Sidetone.)

" Caller ID Display
This function allows the transceiver to display the 
received PTT ID.  (Refer to FUNC 22.1.1 Caller ID 
Display.)

" Group ID
You can enable or disable the Group Call.  (Refer to 
FUNC 22.9.8 Group ID.)

" Group ID (1 - 10)
You can configure the Divisional ID.  You can 
configure a maximum of 10 divisions.  You can 
configure the Group ID by directly entering the value 
in the edit box.  (Refer to FUNC 22.9.8 Group ID.)

Note:

! Only 4-digit numbers can be entered.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

! You cannot configure the Divisional ID if the Group ID 
checkbox is not checked.

! Both calling and called radio is needed this setting.

! 80, 140, 150 and 160 series don’t support this function.

! This group ID is supported interfleet call. 

6.12.2 General 2 Tab

This General 2 tab allows you to configure the general 
function of the FleetSync function.

Figure 6-43   General 2 Tab

" Auto Reset Timer (Auto Reset)
You can figure the duration from the time when the 
FleetSync matches to the time when the status is 
reset.  Configure the Auto Reset Timer by directly 
entering value in the edit box or clicking the spin 
buttons.  (Refer to FUNC 22.9.5 Auto Reset Timer.)

Note:

! A maximum of 3-digit number can be entered.

! When the entire content of the edit box is deleted, Off will be 
configured.

Range
Check (Enable) The Interfleet Call function 

is enabled.

Uncheck (Disable) The Interfleet Call function 
is disabled.

Default Checked (Enabled)

Range

Check (Enable) The FleetSync ID 
transmission tone sounds.

Uncheck (Disable)
The FleetSync ID 
transmission tone does not 
sound.

Default Checked (Enabled)

Range
Check (Enable) The received PTT ID 

appears on the display.

Uncheck (Disable) No PTT ID appears on the 
display.

Default Checked (Enabled)

Range
Check (Enable) The Group Call function is 

enabled.

Uncheck (Disable) The Group Call function is 
disabled.

Default Unchecked (Disabled)

Range Blank/ 1000 - 4999

In steps of 1

Default Blank

Range Off/ 1 - 300 s

In steps of 1 s

Default 10 s
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! When 0 is entered in the edit box, Off will be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" LED (Auto Reset)
Configure the Selective Call Alert LED to stop blinking 
when the Auto Reset Timer expires.  (Refer to FUNC 
22.9.5 Auto Reset Timer.)

Note: You cannot configure the LED when the Auto Reset 
Timer edit box is configured to Off.

" LCD (Auto Reset)
Configure the display to return to the channel display 
when the Auto Reset Timer expires.  (Refer to FUNC 
22.9.5 Auto Reset Timer.)

Note: You cannot configure the LCD when the Auto Reset 
Timer edit box is configured to Off.

"  Monitor (Auto Reset)
Configure the match status of the Selective Call to be 
reset when the Auto Reset Timer expires.  (Refer to 
FUNC 22.9.5 Auto Reset Timer.)

Note: You cannot configure the Monitor function when the 
Auto Reset Timer edit box is configured to Off.

"  Alert Tone (Auto Reset)
Configure the Alert Tone to stop sounding when the 
Auto Reset Timer expires.  (Refer to FUNC 22.9.5 
Auto Reset Timer.)

Note:  You cannot configure the Alert Tone when the Auto 
Reset Timer edit box is configured to Off.

"  Stores the latest received messages
This function allows you to configure the method to 
store Caller ID, Status Message and Short Message.  
(Refer to FUNC 22.7.1 Stores the latest received 
message.)

" Status Message Stack
You can configure the Stack Memory to store the 
status message.  (Refer to FUNC 22.3.4 Status 
Message Stack.)

Range

Check (Enable)

The Selective Call Alert 
LED stops blinking when 
the Auto Reset Timer 
expires.

Uncheck (Disable)

The Selective Call Alert 
LED does not stops 
blinking even if the Auto 
Reset Timer expires.

Default Checked (Enabled)

Range

Check (Enable)
The display returns to the 
channel display when the 
Auto Reset Timer expires.

Uncheck (Disable)

The display does not 
return to the channel 
display even if the Auto 
Reset Timer expires.

Default Checked (Enabled)

Range

Check (Enable) This match status of the 
Selective Call is reset.

Uncheck (Disable)
This match status of the 
Selective Call does not 
reset.

Default Checked (Enabled)

Range

Check (Enable)
The Alert Tone to stops 
sounding when the Auto 
Reset Timer expires.

Uncheck (Disable)
The Alert Tone sounds 
even if the Auto Reset 
Timer expires.

Default Checked (Enabled)

Range

Check (Enable)

The transceiver stacks a 
maximum of 15 received 
messages.  When the 
transceiver receives the 
16th message, it deletes 
the first message and 
stacks 2nd - 16th 
messages (always last 15 
messages).

Uncheck (Disable)

The transceiver stacks a 
maximum of 15 received 
messages.  When the 
transceiver receives the 
16th message, it does not 
stack the 16th messages.

Default Checked (Enabled)

Range

Check (Enable) The Stack Memory stacks 
the status message.

Uncheck (Disable)
The Stack Memory does 
not stack the status 
message.

Default Checked (Enabled)
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" Short Message Stack
You can configure the Stack Memory to store the short 
message.  (Refer to FUNC 22.4.3 Short Message 
Stack.)

" Caller ID Stack
You can configure the Stack Memory to store the 
Caller ID.  (Refer to FUNC 22.7.2 Caller ID Stack.)

" Message Memory
This function allows the transceiver to stack Caller ID, 
Status Message, and Short Message even if the 
transceiver is turned OFF.  (Refer to FUNC 22.7.4 
Message Memory.)

" ID/ Message Stack with Time Stamp
This function allows the transceiver to stack Caller ID, 
Status Message, and Short Message with the time 
stamp.  (Refer to FUNC 22.7.3 ID/ Message Stack 
with Time Stamp.)

" Individual Call (Alert Tone)
You can configure the Alert Tone to be emitted from 
the transceiver when it receives an individual call.  You 
can select one of eight tones configured in the 
Special Alert Tone window.  (Refer to FUNC 22.9.20 
Alert Tone (Individual).)
Configure the Individual Call by directly entering value 
in the edit box or clicking the spin buttons.

Note:

! Only 1 to 8 can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “1”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Other Selective Calls (Alert Tone)
You can configure the tone to be emitted when the 
transceiver receives other Selective Calls other than 
Individual ID.  You can select one of eight tones 
configured in the Special Alert Tone window.  (Refer 
to FUNC 22.9.21 Alert Tone (Other Selective Calls).)
Configure the Other Selective Calls by directly 
entering value in the edit box or clicking the spin 
buttons.

Note:

! Only 1 to 8 number can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “1”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Paging Call (Alert Tone)
You can configure the tone to be emitted from the 
transceiver when it receives an Paging Call.  You can 
select one of eight tones configured in the Special 
Alert Tone window.  (Refer to FUNC 22.9.22 Alert 
Tone (Status/Short Message Call).)
Configure the Paging Call by directly entering value in 
the edit box or clicking the spin buttons.

Range

Check (Enable) The Stack Memory stacks 
the short message.

Uncheck (Disable)
The Stack Memory does 
not stack the short 
message.

Default Checked (Enabled)

Range
Check (Enable) The Stack Memory stacks 

the Caller ID.

Uncheck (Disable) The Stack Memory does 
not stack the Caller ID.

Default Unchecked (Disabled)

Range

Check (Enable)
The message is stored 
even if the transceiver is 
turned OFF.

Uncheck (Disable)
The message is deleted 
when the transceiver is 
turned OFF.

Default Unchecked (Disabled)

Range
Check (Enable) The Time Stamp is 

stacked.

Uncheck (Disable) The Time Stamp is not 
stacked.

Default Unchecked (Disabled)

Range 1 - 8

In steps of 1

Default 3

Range 1 - 8

In steps of 1

Default 4

Range 1 - 8

In steps of 1

Default 8
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Note:

! Only 1 to 8 can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “1”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Status/Short Message Call (Alert Tone)
You can configure the tone to be emitted from the 
transceiver when it receives an Status/ Short Message 
Call.  You can select one of eight tones configured in 
the Special Alert Tone window.  (Refer to FUNC 
22.9.22 Alert Tone (Status/Short Message Call).)
Configure the Status/ Short Message Call by directly 
entering value in the edit box or clicking the spin 
buttons.

Note:

! Only 1 to 8 can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “1”.

!  When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Emergency Response (Alert Tone)
You can configure the Tone to be emitted when the 
Emergency Response is configured to Alert.  You can 
select one of eight tones configured in the Special 
Alert Tone window.  (Refer to FUNC 22.9.23 Alert 
Tone (Emergency Response).)
Configure the Emergency Response by directly 
entering value in the edit box or clicking the spin 
buttons.

Note:

! Only 1 to 8 can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “1”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Status Message Serial Output
This function allows the transceiver to send the Status 
Message and the caller’s Fleet and ID from the 
transceiver’s COM port when the transceiver receives 
a Status Message.  (Refer to FUNC 22.3.6 Status 
Message Serial Output.)

Note: The Status Message Serial Output function cannot be 
configured if “Data” is not selected in the Optional 
Features window > the Common-Page 3 tab > COM 
port 0 - COM port 2.

" Short Message Serial Output
This function allows the transceiver to send the Short 
Message and the caller’s Fleet and ID from the 
transceiver’s COM port when it receives a Short 
Message.  (Refer to FUNC 22.4.5 Short Message 
Serial Output.)

Note: The Short Message Serial Output function cannot be 
configured if “Data” is not selected in the Optional 
Features window > the Common-Page 3 tab > COM 
port 0 - COM port 2.

" Unit ID Serial Output
This function allows the transceiver to send the 
received Fleet and ID from the transceiver’s COM port 
when it receives a PTT ID.  (Refer to FUNC 22.9.17 
Unit ID Serial Output.)

Note: The Unit ID Serial Output function cannot be configured 
if “Data” is not selected in the Optional Features 
window > the Common-Page 3 tab > COM port 0 - 
COM port 2.

Range 1 - 8

In steps of 1

Default 5

Range 1 - 8

In steps of 1

Default 6

Range

Check (Enable)
The transceiver sends the 
Status Message from the 
COM port.

Uncheck (Disable)
The transceiver does not 
send the Status Message 
from the COM port.

Default Checked (Enabled)

Range

Check (Enable)
The transceiver sends the 
Status Message from the 
COM port.

Uncheck (Disable)
The transceiver does not 
send the Status Message 
from the COM port.

Default Checked (Enabled)

Range

Check (Enable)
The transceiver sends the 
Status Message from the 
COM port.

Uncheck (Disable)
The transceiver does not 
send the Status Message 
from the COM port.

Default Checked (Enabled)
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" J Command Serial Output
The function allows the transceiver to send the 
command when the transceiver status is changed 
(transmission, receiving, and a function is enabled or 
disabled, etc.).  You can configure the transceiver to 
send the command from the COM port.  (Refer to 
FUNC 22.9.17 Unit ID Serial Output.)

Note: The J Command Serial Output function cannot be 
configured if “Data” is not selected in the Optional 
Features window > the Common-Page 3 tab > COM 
port 0 - COM port 2.

6.12.3  Parameter Tab

This Parameter tab allows you to configure the 
parameters used in FleetSync.

Figure 6-44   Parameter Tab

" GTC Count
You can configure the number of times for the 
transceiver to send the GTC.  GTC (Go To Channel) is 
a message that allows the transmitting party to take 
the receiving party to the data channel.  (Refer to 
FUNC 22.9.9 GTC Count.)
Configure the GTC Count by directly entering value in 
the edit box or clicking the spin buttons.

Note:

! Only 0 to 5 can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Number of Retries
If the transceiver does not receive the ACK for the 
Maximum ACK Wait Time, it resends data.  You can 
configure the number of retries.  Configure the 
number of retries by directly entering value in the edit 
box or clicking the spin buttons.  (Refer to FUNC 
22.9.10 Number of Retries)

Note:

! Only 0 to 8 can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Transmit Busy Wait Time
You can configure the maximum time for the 
transceiver to withhold the FleetSync data 
transmission.  The transmission is cancelled when the 
line is busy even if the Transmit Busy Wait Time 
expires.  (Refer to FUNC 22.9.11 Transmit Busy Wait 
Time.)
Configure the Transmit Busy Wait Time by directly 
entering value in the edit box or clicking the spin 
buttons.

Note:

! A maximum of 3-digit numbers and “.” (period) can be 
entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “0.5”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Maximum ACK Wait Time
You can configure the wait time for receiving the ACK 
after ending data transmission.  Configure the 
Maximum ACK Wait Time by directly entering value in 
the edit box or clicking the spin buttons.  (Refer to 
FUNC 22.9.12 Maximum ACK Wait Time.)

Range

Check (Enable)
The transceiver sends the 
Status Message from the 
COM port.

Uncheck (Disable)
The transceiver does not 
send the Status Message 
from the COM port.

Default Unchecked (Disabled)

Range 0 - 5

In steps of 1

Default 2

Range 0 - 8

In steps of 1

Default 2

Range 0.5 - 60.0 s

In steps of 10.0 s

Default 0.1 s
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Note:

! A maximum of 3-digit numbers and “.” (period) can be 
entered.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

! When the entire content of the edit box is deleted, this 
duration will be configured to “0.5”.

" ACK Delay Time
You can configure the duration between the time when 
the transceiver receives data and the time when it 
sends the ACK.  Configure the ACK Delay Time by 
directly entering value in the edit box or clicking the 
spin buttons.  (Refer to FUNC 22.9.13 ACK Delay 
Time.)

Note:

! A maximum of 3-digit numbers and “.” (period) can be 
entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “0.1”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

" Transmit Delay Time (Receive Capture)
The Transmit Delay Time is the duration to transmit 
unmodulated signal prior to the data transmission.  
Configure the Transmit Delay Time by directly 
entering value in the edit box or clicking the spin 
buttons.  (Refer to FUNC 22.9.14 Transmit Delay Time 
(Receive Capture).)

Note:

! A maximum of 3-digit numbers and “.” (period) can be 
entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “0.0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Data Transmit Modulation Delay Time
You can configure the duration between the time when 
the transceiver starts transmitting and the time when it 
starts modulating the MSK data.  Configure the Data 
Transmit Modulation Delay Time by directly entering 
value in the edit box or clicking the spin buttons.  
(Refer to FUNC 22.9.15 Data Transmit Modulation 
Delay Time.)

Note:

! A maximum of 4-digit numbers can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" Random Access (Contention)
You can enable or disable the Random Access 
function.  This function allows you to randomize the 
transmission start time for each transceiver to transmit 
the data when the channel becomes free.  (Refer to 
FUNC 22.9.16 Random Access (Contention).)

" Status Message on Data Zone-CH/GID
You can enable or disable the Status Message On 
Data Zone-CH/GID function.  This function allows the 
transceiver to automatically change to the Data Zone-
CH/GID to send the Status Message.  (Refer to FUNC 
22.3.5 Status Message On Data Zone-CH/ GID.)

Range 0.5 - 60.0 s

In steps of 0.1 s

Default 2.0 s

Range 0.1 - 60.0 s

In steps of 0.1 s

Default 0.5 s

Range 0.0 - 25.0 s

In steps of 0.1 s

Default 0.0 s

Range 0 - 6000 ms

In steps of 1 ms

Default 400 ms

Range
Check (Enable) The Random Access 

function is enabled.

Uncheck (Disable) The Random Access 
function is disabled.

Default Checked (Enabled)

Range

Check (Enable)
The Status Message On 
Data Zone-CH/ GID 
function is enabled.

Uncheck (Disable)
The Status Message On 
Data Zone-CH/ GID 
function is disabled.

Default Unchecked (Disabled)
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" Short Message on Data Zone-CH/GID
You can enable or disable the Short Message On Data 
Zone-CH/GID function.  This function allows the 
transceiver to automatically change the channel to the 
Data Zone-CH/GID to send the Short Message.  
(Refer to FUNC 22.4.4 Short Message On Data Zone-
CH/GID.)

" Long Message on Data Zone-CH/GID
You can enable or disable the Long Message On Data 
Zone-CH/GID function.  This function allows the 
transceiver to automatically change to the Data Zone-
CH/GID to send the Long Message.  (Refer to FUNC 
22.5.3 Long Message On Data Zone-CH/GID.)

" Data Transmit with QT/DQT
You can configure the QT/DQT configured to the 
channel used for data transmission.  (Refer to FUNC 
25.1.4 Data Transmit with QT/DQT.)

6.12.4 ID List Tab

This ID List tab allows you to configure the FleetSync ID 
used in FleetSync.

Figure 6-45   ID List Tab

" Fleet
Configure the Fleet of the FleetSync ID.  Configure the 
Fleet by directly entering value in the No. 1 to No. 100 
edit boxes of Fleet or clicking the spin buttons.  (Refer 
to FUNC 22.2.3 ID List.)

Note:

! Only 3-digit numbers and “.” can be entered.

! When the entire content of the edit box is deleted, all 
relevant numbers will be deleted.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

" ID
Configure the ID of the FleetSync ID.  Configure the 
ID by directly entering value in the No. 1 to No. 100 
edit boxes of ID or clicking the spin buttons.  (Refer to 
FUNC 22.2.3 ID List)

Note:

! Only 4-digit numbers and “.” can be entered.

! When the entire content of the edit box is deleted, all 
relevant numbers will be deleted.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.

Range

Check (Enable)
The Short Message On 
Data Zone-CH/ GID 
function is enabled.

Uncheck (Disable)
The Short Message On 
Data Zone-CH/ GID 
function is disabled.

Default Unchecked (Disabled)

Range

Check (Enable)
The Long Message On 
Data Zone-CH/ GID 
function is enabled.

Uncheck (Disable)
The Long Message On 
Data Zone-CH/ GID 
function is disabled.

Default Unchecked (Disabled)

Range
Check (Enable) The QT/DQT is replaced.

Uncheck (Disable) The QT/DQT is not 
replaced.

Default Checked (Enabled)

Range Blank/ ALL (0)/ 100 - 349

In steps of 1

Default Blank

Range Blank/ ALL (0)/ 1000 - 4999

In steps of 1

Default Blank
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" ID Name
You can configure the caller’s ID name.  Configure the 
ID Name by directly entering value in the No. 1 to No. 
100 edit boxes of ID Name or clicking the spin 
buttons.  (Refer to FUNC 22.2.3 ID List.)

Note:

! When the entire content of the edit box is deleted, a blank 
will be configured.

! You must configure the Fleet edit box and the ID edit box 
are configured before configuring the ID Name. 

" TX Inhibit
You can enable and disable the transmission to the 
receiving party.  Select the desired TX Inhibit option 
from the pulldown menu.  (Refer to FUNC 22.2.3 ID 
List.)

Note: You must configure the Fleet edit box and the ID edit 
box before configuring the TX Inhibit function. 

6.12.5 Status List Tab

This tab allows you to configure the Status to use the 
Status Message function.

Figure 6-46   Status List Tab

Table 6-8   Reserved Status List

" Status
You can configure the Status Number.  Configure the 
Status Number by directly entering value in the No. 1 
to No. 90 edit boxes of Status or clicking the spin 
buttons.  (Refer to FUNC 22.3.11 Status List.)

Note:

! Only 2-digit numbers can be entered.

! When the entire content of the edit box is deleted, all 
relevant numbers will be deleted.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

!  You cannot configure the Status Number that is already 
configured.

Range A maximum of 12 characters

Available 
Characters

(space) ! ” # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default ID 001 - ID 100 (The channel number is 
automatically entered.)

Range
Yes The transmission to the caller is 

restricted.

No The transmission to the caller is 
enabled.

Default No

Status Function Operation at the 
receiving party

10 - 79 User Status Normal Status receiving 
Operation

80 Default Status

81 - 87 Undefined

88 Emergency Reset 
Command

This status resets the 
Emergency Status.

89 Horn Alert Activation 
Command

This status activates the 
Horn Alert function.

90
Remote Stun 
Transmission Restriction 
Command

The transceiver transmits 
the ACK and restricts the 
transmission.  In this 
case, the Current Status 
is configured to “93”. 

91

Remote Stun 
Transmission and 
receiving Restriction 
Command

The transceiver transmits 
the ACK and restricts the 
transmission.  In this 
case, the Current Status 
is configured to “94”. 

92 Remote Stun Reset 
Command

The transceiver transmits 
the ACK and disables the 
Stun function.  In this 
case, the Current Status 
is configured to “80”. 

93
Remote Stun 
Transmission Restriction 
Response

-

94

Remote Stun 
Transmission and 
receiving Restriction 
Response

-

95 - 99

Reserved Status for 
Emergency
98: Man Down Status
99: Emergency Status 
other than Man Down

The transceiver transmits 
the ACK/Alert/ Horn/ 
None

Range Blank/ 10 - 90

In steps of 1

Default Blank
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" Status Name
You can configure the Status name.  Configure the 
Status Name by directly entering value in the No. 1 to 
No. 90 edit boxes of Status Name or clicking the spin 
buttons.  (Refer to FUNC 22.3.11 Status List.)

Note:

! When the entire content of the edit box is deleted, a blank 
will be configured.

! You cannot configure the Status Name if the Status edit box 
is not configured. 

" TX Inhibit
You can enable and disable the transmission to the 
receiving party.  You can select the TX Inhibit option 
from the pulldown menu (No. 1 to No. 90).  (Refer to 
FUNC 22.3.11 Status List.)

Note: You cannot configure the TX Inhibit if the Status edit box 
is not configured. 

6.12.6 GPS Tab 
(TK-7180/ 8180 only)

This GPS tab allows you to configure the GPS function

Figure 6-47   GPS Tab

Note: You cannot configure the GPS functions using the GPS tab 
in the TK-2180/ 3180 transceivers. 

" Base Fleet
You can configure the FleetSync ID to send the GPS 
data.  Configure the Base Fleet by directly entering 
value in the edit box or clicking the spin buttons.  
(Refer to FUNC 22.6.1 Base Fleet/ ID.)

Note:

! Only 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

! The Base Fleet cannot be configured if “GPS” is not 
selected in the Optional Features window > the Common-
Page 3 tab > COM port 1 - COM port 2.

" Base ID
You can configure the FleetSync ID to send the GPS 
data.  Configure the Base ID by directly entering value 
in the edit box or clicking the spin buttons.  (Refer to 
FUNC 22.6.1 Base Fleet/ ID.)

Note:

! Only 4-digit numbers can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

! The Base Fleet cannot be configured if “GPS” is not 
selected in the Optional Features window > the Common-
Page 3 tab > COM port 1 - COM port 2.

" GPS Report Mode
This function allows you to select the transmission 
method: Transmit the GPS data automatically or 
transmit after receiving the command.  Select the GPS 
Report Mode from the pulldown menu.  (Refer to 
FUNC 22.6.3 GPS Report Mode.)

Range Enter a maximum of 16 characters.

Available 
Characters

(space) ! ” # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default Blank

Range
Yes The transmission to the caller is 

restricted.

No The transmission to the caller is 
enabled.

Default No

Range Blank/ 100 - 349

In steps of 1

Default Blank

Range Blank/ 1000 - 4999

In steps of 1

Default Blank

Range

Poll

The transceiver sends the GPS data 
when receiving the GPS data 
transmission request from the Base 
station.

Auto
The transceiver sends the GPS data 
with the duration configured in the 
GPS Report Interval.

Default Poll
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Note: The GPS Report Mode cannot be configured if “GPS” is 
not selected in the Optional Features window > the 
Common-Page 3 tab > COM port 1 or COM port 2.

" Number of Times
You can configure the number of times to 
automatically send the GPS data after receiving the 
GPS data request when “Poll” is selected from the 
desired GPS Report Mode pulldown menu.  Configure 
the number of times by directly entering value in the 
edit box or clicking the spin buttons.  (Refer to FUNC 
22.6.4 Number of Times.)

Note:

! Only 2-digit numbers can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “1”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

! The Number of Times cannot be configured if “GPS” is not 
selected in the Optional Features window > the Common-
Page 3 tab > COM port 1 or COM port 2.

" GPS Time Mark
This function allows the transceiver to configure the 
Offset duration to send the GPS data with the UTC 
(Coordinated Universal Time).  Configure the GPS 
Time Mark by directly entering value in the edit box or 
clicking the spin buttons.  (Refer to FUNC 22.6.7 GPS 
Time Mark.)

Note:

! A maximum of 4-digit numbers can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

! The maximum value can be obtained by comparing the 
Ignition On (GPS Report Interval Time) and Ignition Off 
(GPS Report Interval Time), and then subtracting 1 from the 
smaller value.

! When the configured value is longer than the GPS Report 
Interval, the maximum value, which is obtained by 
comparing the Ignition On (GPS Report Interval Time) with 
Ignition Off (GPS Report Interval Time) and subtracting 1 
from the smaller value, will be automatically configured.

! The GPS Time Mark cannot be configured if “GPS” is not 
selected in the Optional Features window > the Common-
Page 3 tab > COM port 1 or COM port 2.

" GPS Message Type
You can configure the Air format to send the GPS 
data.  Select the desired GPS Message Type from the 
pulldown menu.

Note:

! The GPS Message Type cannot be configured if “GPS” is 
not selected in the Optional Features window > the 
Common-Page 3 tab > COM port 1 or COM port 2.

! When “Full” is selected, the same format as the TK-780/ 
7150 is used.

" GPS Report on Data Zone-CH/GID
You can configure the transceiver to automatically 
change the channel to Data Zone-CH/GID to send the 
GPS Report.  (Refer to FUNC 22.6.8 GPS Report On 
Data Zone-CH/GID.)

Note: The GPS Report on Data Zone-CH/GID function cannot 
be configured if “GPS” is not selected in the Optional 
Features window > the Common-Page 3 tab > COM 
port 1 or COM port 2.

" Ignition On (GPS Report Interval Time)
You can configure the interval to send the GPS data 
while the vehicle is moving if the GPS Report Mode is 
configured to “AUTO”.  Configure the Ignition On by 
directly entering value in the edit box or clicking the 
spin buttons.  (Refer to FUNC 22.6.5 GPS Report 
Interval (GPS Data when Ignition On).)

Range 1 - 60

In steps of 1

Default 1

Range 0 - Maximum value of the GPS Report Interval 
Time (a maximum of 3599 s)

In steps of 1 s

Default 0 s

Range Full

This message has the same format 
as the TK-780/7150.  The 
transmission period is approximately 
500 ms.  The transceiver sends the 
GPS data, such as $GPGGA, 
$GPRMC, and $GPGLL.

Short

The transmission period is 
approximately 320 ms.  The 
transceiver sends the GPS data, 
such as $GPGLL.
When the base station receives the 
Short GPS data, a part of data is 
output as a blank data even if the 
$GPGGA and $GPRMC are 
configured to PC serial-out.

Default Full

Range

Check (Enable)
The transceiver sends the 
GPS data using the Data 
Zone-CH/GID.  

Uncheck (Disable)
The transceiver does not 
send the GPS data using 
the Data Zone-CH/GID.  

Default Unchecked (Disabled)

Range 1 - 3600 s

In steps of 1 s

Default 180 s
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Note:

! A maximum of 4-digit numbers can be entered.

! When the entire content of the edit box is deleted, this 
duration will be configured to “1”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.  

! When the entered value is smaller than the value configured 
to the GPS Time Mark edit box, the value, which is one 
second less than the entered value, will be automatically 
configured to the GPS Time Mark.

! The Ignition On function cannot be configured if “GPS” is not 
selected in the Optional Features window > the Common-
Page 3 tab > COM port 1 or COM port 2.

" Ignition Off (GPS Report Interval Time)
You can configure the interval to send the GPS data 
while the car is parked if the GPS Report Mode is 
configured to “AUTO”.  Configure the Ignition Off by 
directly entering value in the edit box or clicking the 
spin buttons.  (Refer to FUNC 22.6.6 GPS Report 
Interval (GPS Data when Ignition Off).)

Note:

! A maximum of 4-digit number can be entered.

! When the entire content of the edit box is deleted, “1” is 
configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range.

! When the entered value is smaller than the value configured 
to the GPS Time Mark edit box, the value, which is one 
second less than the entered value, is automatically 
configured to the GPS Time Mark.

! The Ignition Off function cannot be configured if “GPS” is not 
selected in the Optional Features window > the Common-
Page 3 tab > COM port 1 or COM port 2.

" PTT ID (GPS Combination)
You can configure the transceiver to send the GPS 
data with the PTT ID (FleetSync) of the transceiver.  
(Refer to FUNC 22.6.2 GPS Combination.)

Note: The PTT ID cannot be configured if “GPS” is not selected 
in the Optional Features window > the Common-Page 3 
tab > COM port 1 or COM port 2.

" GPS Report Timing (GPS Combination)

You can configure the timing for the transceiver to 
send the GPS data with the PTT ID (FleetSync).  
Select the desired GPS Report Timing from the 
pulldown menu.  (Refer to FUNC 22.6.2 GPS 
Combination.)

Note:

! The GPS Report Timing cannot be configured if “GPS” is not 
selected in the Optional Features window > the Common-
Page 3 tab > COM port 1 or COM port 2.

! You cannot configure the GPS Report Timing if the PTT ID 
checkbox is not checked.

" Status (GPS Combination)
You can configure the transceiver to send the Status 
Message with the GPS data.  (Refer to FUNC 22.6.2 
GPS Combination.)

Note:

! The Status cannot be configured if “GPS” is not selected in 
the Optional Features window > the Common-Page 3 tab 
> COM port 1 or COM port 2.

! The GPS data will not be contained in the Power On Status 
Message or Power Off Status Message.

" GPS Report Status No. Block (GPS 
Combination)
You can configure the range of the Status Number that 
the transmission restriction is applied when sending 
the GPS data.  Configure the GPS Report Status No. 
Block by directly entering value in the edit box or 
clicking the spin buttons.  (Refer to FUNC 22.6.2 GPS 
Combination.)

Note:

! A maximum of 2-digit numbers can be entered.

! When the entire content of the edit box is deleted, “10” will 
be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

Range 1 - 3600 s

In steps of 1 s

Default 180 s

Range

Check (Enable)
The transceiver sends the 
GPS data with the PTT ID 
(FleetSync).

Uncheck (Disable)
The transceiver does not 
send the GPS data with 
the PTT ID (FleetSync).

Default Unchecked (Disabled)

Range BOT/ EOT/ Both (BOT)/ Both (EOT) /Both

Default BOT

Range

Check (Enable)
The transceiver sends the 
Status Message with the 
GPS data.

Uncheck (Disable)
The transceiver does not 
send the Status Message 
with the GPS data.

Default Unchecked (Disabled)

Range 10 - 80

In steps of 1 

Default
Start 10

End 80
Version: 1.11 Field Programming Reference 95



6 EDIT MENU
! If the value configured to the Start box is largerthan the 
value configured to the End edit box, the same value as the 
Start edit box will be configured to the End edit box.

! If the value configured to the End box is smaller than the 
value configured to the Start edit box, the same value as the 
End edit box will be configured to the Start edit box.

! The GPS Report Status No. Block cannot be configured if 
“GPS” is not selected in the Optional Features window > 
the Common-Page 3 tab > COM port 1 or COM port 2.

" Emergency (GPS Combination)
You can configure the transceiver to send the 
Emergency ID with the GPS data.  (Refer to FUNC 
22.6.2 GPS Combination.)

Note: The Emergency function cannot be configured if “GPS” 
is not selected in the Optional Features window > the 
Common-Page 3 tab > COM port 1 or COM port 2.

" Map Header NMEA 1 ($GPGGA)
A NMEA-0183 standard command.
This function allows the transceiver to send the 
$GPGGA data to the Mapping software.

Note: The Map Header NMEA 1 ($GPGGA) function cannot 
be configured if only “None” is configured in the 
Optional Features window > the Common-Page 3 tab 
> COM port 0 - COM port 2.

" Map Header NMEA 2 ($GPGLL)
A NMEA-0183 standard command.
This function allows the transceiver to send the 
$GPGLL data to the Mapping software.

Note: The Map Header NMEA 2 ($GPGLL) function cannot be 
configured if only “None” is configured in the Optional 
Features window > the Common-Page 3 tab > COM 
port 0 - COM port 2.

Range

Check (Enable)
The transceiver sends the 
Emergency ID with the 
GPS data (FleetSync).

Uncheck (Disable)

The transceiver does not 
send the Emergency ID 
with the GPS data 
(FleetSync).

Default Unchecked (Disabled)

Range

Check (Enable)
The transceiver sends the 
$GPGGA data to the 
Mapping software.

Uncheck (Disable)
The transceiver does not 
send the $GPGGA data to 
the Mapping software.

Default Unchecked (Disabled)

Range

Check (Enable)
The transceiver sends the 
$GPGLL data to the 
Mapping software.

Uncheck (Disable)
The transceiver does not 
send the $GPGLL data to 
the Mapping software.

Default Unchecked (Disabled)
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" Map Header NMEA 3 ($GPRMC)
A NMEA-0183 standard command.
This function allows the transceiver to send the 
$GPRMC data to the Mapping software.

Note: The Map Header NMEA 3 ($GPRMC) function cannot 
be configured if only “None” is configured in the 
Optional Features window > the Common-Page 3 tab 
> COM port 0 - COM port 2.

" Map Header KW 1 ($PKLDS)
You can configure the Map Header KW1 ($PKLDS) to 
send the KENWOOD's unique sentence of the 
$PKLDS data to the Mapping application software. 
The transceiver can abstract the $PKLDS + ID + 
Status data from the received GPS data and send the 
$PKLDS + ID + Status data from the COM port. 

Note: The Map Header KW 1 ($PKLDS) function cannot be 
configured if only “None” is configured in the Optional 
Features window > the Common-Page 3 tab > COM 
port 0 - COM port 2.

" Map Header KW 2 ($PKLID)
You can configure the Map Header KW2 ($PKLID) to 
send the KENWOOD's unique sentence of the 
$PKLID data to the Mapping application software. 
The transceiver can abstract the $PKLID + ID + Status 
data from the received GPS data and send the 
$PKLID + ID + Status data from the COM port.

Note: The Map Header KW 2 ($PKLID) function cannot be 
configured if only “None” is configured in the Optional 
Features window > the Common-Page 3 tab > COM 
port 0 - COM port 2.

" Map Header KW 3 ($PKLSH)
You can configure the Map Header KW3 ($PKLSH) to 
send the KENWOOD's unique sentence of the 
$PKLSH data to the Mapping application software. 
The $PKLSH data is consisting of the $GPGLL data 
and ID. The transceiver can abstract the $PKLSH + ID 
+ Status data from the received GPS data and send 
the $PKLSH + ID + Status data from the COM port.

Note: The Map Header KW 3 ($PKLSH) function cannot be 
configured if only “None” is configured in the Optional 
Features window > the Common-Page 3 tab > COM 
port 0 - COM port 2.

6.12.7 Target Tab

This tab allows you to configure the GPS function.

Figure 6-48   Target Tab

" Target Fleet (Status Message)
You can configure the receiving party’s FleetSync ID 
to send the following Status Messages.  (Refer to 
FUNC 22.3.12 Destination Fleet/ ID (Status 
Message).)
• Status Message transmission using the AUX IN 

terminal
• Power-on Status Message transmission
• Power-off Status Message transmission
• Status Message transmission using the PF keys 

and the PF CALL key

Range

Check (Enable)
The transceiver sends the 
$GPRMC data to the 
Mapping software.

Uncheck (Disable)
The transceiver does not 
send the $GPRMC data to 
the Mapping software.

Default Unchecked (Disabled)

Range

Check (Enable)
The transceiver sends the 
$PKLDS data to the 
Mapping software.

Uncheck (Disable)
The transceiver does not 
send the $PKLDS data to 
the Mapping software.

Default Unchecked (Disabled)

Range

Check (Enable)
The transceiver sends the 
$PKLID data to the 
Mapping software.

Uncheck (Disable)
The transceiver does not 
send the $PKLID data to 
the Mapping software.

Default Unchecked (Disabled)

Range

Check (Enable)
The transceiver sends the 
$PKLSH data to the 
Mapping software.

Uncheck (Disable)
The transceiver does not 
send the $PKLSH data to 
the Mapping software.

Default Unchecked (Disabled)
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Configure the Target Fleet (Status Message) by 
directly entering value in the edit box or clicking the 
spin buttons.

Note:

! A maximum of 3-digit numbers and “.” can be entered.

! When entire content of the edit box is deleted, a blank will be 
configured.

! When A or 0 is entered in the edit box, ALL will be 
configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

! If the Target ID (Status Message) edit box is a blank when 
the value is entered, the Target ID (Status Message) edit 
box will be configured to “1000”.

! An error message appears when trying to write data while 
one of the Target Fleet (Status Message) items is configured 
to a blank.

• The General 1 tab > the Fleet (Own) edit box

• The General 1 tab > the ID (Own) edit box

" Target ID (Status Message)
You can configure the receiving party’s FleetSync ID 
to send the following Status Messages.  (Refer to 
FUNC 22.3.12 Destination Fleet/ ID (Status 
Message).)
• Status Message transmission using the AUX IN 

terminal
• Power-on Status Message transmission
• Power-off Status Message transmission
• Status Message transmission using the PF and PF 

CALL keys
Configure the Target ID (Status Message) by directly 
entering value in the edit box or clicking the spin 
buttons.

Note:

! Only 4-digit numbers and “.” can be entered.

! When entire content of the edit box is deleted, a blank will be 
configured.

! When A or 0 is entered in the edit box, ALL will be 
configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

! If the Target Fleet (Status Message) edit box is blank when 
the value is entered, the Target Fleet (Status Message) 
edit box will be configured to “100”.

! The error message appears when trying to write data while 
one of the Target ID (Status Message) items is configured to 
a blank.

• The General 1 tab > the Fleet (Own) edit box

• The General 1 tab > the ID (Own) edit boxRange Blank/ ALL (0)/ 100 - 349

In steps of 1 

Default Blank

Range Blank/ ALL (0)/ 1000 - 4999

In steps of 1 

Default Blank
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" Power-on/off Status Message (On/ Off)
You can configure the Status Message that is sent 
when the transceiver is turned ON or OFF.  Configure 
this message by directly entering value to the Status 
Message On/ Off edit box.  (Refer to FUNC 22.3.9 
Power-on Status Message and 22.3.10 Power-off 
Status Message.)

Note:

! Only 2-digit numbers can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.

! When a value outside of the range is entered, it is replaced 
with the lower limit value of the range. 

" AUX Input Status Message 1 - 3 (On/ Off) 
(TK-7180/ 8180 only)
This function allows you to configure the Status 
Message that is sent when the status of the AUX IN 
terminal changes.  Configure the Message by directly 
entering value in the High/ Low edit boxes of AUX 
Input Status Message 1 - 3.  (Refer to FUNC 22.3.7 
AUX Input Status Message.)

Note:

! Only 2-digit numbers can be entered.

! When entire content of the edit box is deleted, a blank will be 
configured.

! When a value outside of the range is entered, it is replaced 
with the lower limit value of the range. 

! GPS data is not added eve if GPS convination enables.

" AUX Output Status Message 1 - 3 (On/ Off) 
(TK-7180/ 8180 only)
You can configure the Status No. to switch the status 
of the AUX IN terminal (Low > High or High > Low) 
when receiving the Status Message.  Configure the 
Message by directly entering value in the High/ Low 
edit boxes of AUX Output Status Message 1 - 3.  
(Refer to FUNC 22.3.8 AUX Output Status Message.)

Note:

! Only 2-digit numbers can be entered.

! When the entire content of the edit box is deleted, a blank 
will be configured.

! When a value outside of the range is entered, it is replaced 
with the lower limit value of the range.  

6.13 Special Alert Tone Window

You can configure the Alert Tone in the Special Alert 
Tone window.  You can configure the Alert Tone suitable 
to the environment when receiving a call with the Optional 
Signaling.
The Special Alert Tone window consists of the Alert 
Tone 1 to Alert Tone 8 tabs you can switch the display by 
clicking the tabs.

Figure 6-49   Special Alert Tone Window

Range Blank/ 10 - 99

In steps of 1 

Default Blank

Range Blank/ 10 - 99

In steps of 1 

Default Blank

Range Blank/ 10 - 99

In steps of 1 

Default Blank
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The default Alert Tone of each tab is as follows.

Table 6-9   Default Alert Tone

6.13.1 Cycle

You can configure the number of times for the Alert Tone 
to sound.  Select the desired Alert Tone tab and 
configure the Cycle by directly entering value in the edit 
box or clicking the spin buttons.  (Refer to FUNC 4.7 Alert 
Tone Pattern.)

Note:

! A maximum of 3-digit numbers and “I” can be entered.

! The Alert Tone continues sounding infinitely when configuring to 
“Infinite”.

! When entire content of the edit box is deleted, the edit box will 
be configured to “Infinite”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

6.13.2  Interval

You can configure the timing to repeat the Alert Tone.  
Select the desired Alert Tone tab and configure the 
Interval by directly entering value in the edit box or 
clicking the spin buttons.  (Refer to FUNC 4.7 Alert Tone 
Pattern.)

Note:

! A maximum of 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, this duration 
will be configured to “0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

Item
Alert 
Tone 

1

Alert 
Tone 

2

Alert 
Tone 

3

Alert 
Tone 

4

Alert 
Tone 

5

Alert 
Tone 

6

Alert 
Tone 

7

Alert 
Tone 

8

Cycle 1 1 1 1 Infinite Infinite Infinite Infinite

Interval [s] 0 0 0 0 10 5 5 2

1st 
Tone

Freq. 
(Hz) 2100 770 1630 640 1340 1480 770 1170

Length 
(ms) 100 30 30 50 50 200 30 50

2nd 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone 940 940 700 770 No 

Tone 1480

Length 
(ms) 100 30 30 50 50 200 30 50

3rd 
Tone

Freq. 
(Hz) 2100 770 1630 1340 No 

Tone 1480 770 1170

Length 
(ms) 100 30 30 50 0 200 30 50

4th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone 940 1630 No 

Tone 770 No 
Tone 1480

Length 
(ms) 100 30 30 50 0 200 30 50

5th 
Tone

Freq. 
(Hz) 2100 770 1630 1920 No 

Tone 1480 770 1170

Length 
(ms) 100 30 30 50 0 200 30 50

6th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone 940 No 

Tone
No 

Tone 770 No 
Tone 1480

Length 
(ms) 0 30 30 0 0 200 30 50

7th 
Tone

Freq. 
(Hz)

No 
Tone 770 1630 No 

Tone
No 

Tone
No 

Tone 770 1170

Length 
(ms) 0 30 30 0 0 0 30 50

8th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone 940 No 

Tone
No 

Tone
No 

Tone
No 

Tone 1480

Length 
(ms) 0 30 30 0 0 0 30 50

9th 
Tone

Freq. 
(Hz)

No 
Tone 770 No 

Tone
No 

Tone
No 

Tone
No 

Tone 770 1170

Length 
(ms) 0 30 0 0 0 0 30 50

10th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone 1480

Length 
(ms) 0 30 0 0 0 0 30 50

11th 
Tone

Freq. 
(Hz)

No 
Tone 770 No 

Tone
No 

Tone
No 

Tone
No 

Tone 770 1170

Length 
(ms) 0 30 0 0 0 0 30 50

12th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone 1480

Length 
(ms) 0 30 0 0 0 0 30 50

13th 
Tone

Freq. 
(Hz)

No 
Tone 770 No 

Tone
No 

Tone
No 

Tone
No 

Tone 770 1170

Length 
(ms) 0 30 0 0 0 0 30 50

14th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone 1480

Length 
(ms) 0 0 0 0 0 0 0 50

15th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

Length 
(ms) 0 0 0 0 0 0 0 0

16th 
Tone

Freq. 
(Hz)

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

No 
Tone

Length 
(ms) 0 0 0 0 0 0 0 0

Range Infinite/ 1 - 255

In steps of 1

Default Refer to Table 6-9  Default Alert Tone

Range 0 - 255

In steps of 1

Default Refer to Table 6-9  Default Alert Tone

Item
Alert 
Tone 

1

Alert 
Tone 

2

Alert 
Tone 

3

Alert 
Tone 

4

Alert 
Tone 

5

Alert 
Tone 

6

Alert 
Tone 

7

Alert 
Tone 

8
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6.13.3  Frequency (1st Tone - 16th 
Tone)

You can configure the frequency of the tone.  The 
frequency configured to the Alert Tone appears on the 
Alert Tone Sequence window.  (Refer to FUNC 4.7 Alert 
Tone Pattern.)
Select the desired Alert Tone tab and configure the 
Frequency by directly entering value in the edit box or 
clicking the spin buttons.

Note:

! A maximum of 4-digit numbers can be entered.

! When 0 is entered or the entire content of the edit box is deleted, 
No Tone will be configured.

! Gap will be configured when “No Tone” is selected.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! A value less than 10 Hz is rounded off.

6.13.4  Length (1st Tone - 16th Tone)

You can configure the tone length.  The frequency 
configured to the Alert Tone appears on the Alert Tone 
Sequence window.  (Refer to FUNC 4.7 Alert Tone 
Pattern.)
Select the desired Alert Tone tab and configure the 
Length by directly entering value in the edit box or clicking 
the spin buttons.

Note:

! A maximum of 4-digit numbers can be entered.

! When entire content of the edit box is deleted, this duration will 
be configured to “0”.

! No tone sounds when 0 is selected.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! A value less than 10 ms is rounded off.

6.13.5  Alert Tone Sequence

The configured Cycle, Interval, Frequency, and Length 
appear on the display.

Figure 6-50   Alert Tone Sequence

6.13.6 Alert Test Button

The Alert Test window appears to play back the 
simulated Tone pattern of the Alert Tone Sequence using 
the beep of a PC appears.

Note:

! The “Alert Test” button does not appear on Windows Me/ 98.

! The tone does not sound if a PC is not equipped with a sound 
card.

6.13.7 Alert Test Window

You can play the simulated Tone pattern of the Alert Tone 
Sequence using the beep of a PC.

Figure 6-51   Alert Test Window

Note:

! The “Alert Test” button does not appear on Windows Me and 98.

! The tone does not sound if a PC is not equipped with a sound 
card.

Range No Tone/ 400 - 2500 Hz

In steps of 10 Hz

Default Refer to Table 6-9  Default Alert Tone

Range 0 - 2500 ms

In steps of 10 ms

Default Refer to Table 6-9  Default Alert Tone
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" Alert Tone Select Pulldown Menu
Select the desired Alert Tone Pattern to play.

Note: You cannot select the desired Alert Tone Pattern when 
one of the Alert Tone Patterns is being played back.

" Play Button
The selected Alert Tone Pattern is played back.

Note: You cannot click “Play” when one of the Alert Tone 
Patterns is being played.

" Stop Button
The Alert Tone Pattern stops playing when this “Stop” 
button is pressed.

6.14 Emergency Information 
Window

You can configure the Emergency Mode in the 
Emergency Information window.

Figure 6-52   Emergency Information Window

6.14.1 Emergency CH/GID Type

You can configure the type of the CH/GID that operates in 
Emergency Mode.  Select the desired Emergency CH/
GID Type from the pulldown menu.  (Refer to FUNC 
24.1.1 Emergency CH Type.)

6.14.2 Emergency Zone-CH/GID

You can configure the Emergency Zone-CH/GID used in 
Emergency Mode.  Configure the Emergency Zone-CH/
GID by entering a value in the edit box or selecting from 
the pulldown menu.  (Refer to FUNC 24.1.2 Emergency 
Zone-CH/GID.)

Note:

! You can configure the Emergency Zone-CH/GID when “Fixed” is 
selected from the Emergency CH/GID Type pulldown menu.

! When the entire content of the edit box is deleted, None will be 
configured.

! When the Zone edit box is configured to None, the CH/GID edit 
box will be also configured as None.

!  The error message appears if the entered Zone-CH/GID does 
not exist, and the transceiver returns to the previous value. 

! An error message appears when trying to write data or clicking 
“Close” while a value is configured to the Zone edit box and the 
CH/GID edit box will be configured as None.

! An error message appears when trying to write data or clicking 
“Close” while “Fixed” is selected from the Emergency CH/GID 
pulldown menu and the Emergency Zone-CH/GID edit box will 
be configured as None.

6.14.3  Emergency Cycle

You can configure the number of times to repeat 
emergency transmission and receiving in Emergency 
Mode.  Configure the Emergency Cycle by directly 
entering value in the edit box or clicking the spin buttons.  
(Refer to FUNC 24.1.3 Emergency Cycle.)

Range

Selected
The transceiver transmits or 
receives using the Selected Channel 
when it enters Emergency Mode.

Fixed

The transceiver transmits and 
receives using the Zone-CH/GID 
configured in Emergency Zone-CH/
GID when it enters Emergency 
Mode.

Default Revert

Range None/ Existing Zone-CH/GID

Default None
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Note:

! A maximum of 3-digit numbers and “I” can be entered.

! When the value is configured to 0 or entire content of the edit 
box is deleted, the cycle will be configured to Infinite.

! The transceiver keeps alternating transmission and receiving 
until the PF Emergency key is pressed again or the transceiver 
is turned OFF when “Infinite” is selected.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! You cannot configure the ANI board if the “ANI Board” is 
selected from the Emergency ID pulldown menu.

6.14.4 Duration of Locator Tone 1

This function allows you to configure the duration of the 
Alert Tone to sound before Emergency Mode begins 
automatic transmission.  The tone sounds when the 
transceiver alternates transmission and receiving while it 
repeats automatic transmission and receiving.  (Refer to 
FUNC 24.1.4 Duration of Locator Tone 1.)
Configure the Duration of Locator Tone 1 by directly 
entering value in the edit box or clicking the spin buttons.

Note:

! A maximum of 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, this duration 
will be configured to “0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! You cannot configure the Duration of Locator Tone 1 if “Silent” is 
selected from the Emergency Mode Type pulldown menu.

! You cannot configure the Duration of Locator Tone 1 if “ANI 
Board” is selected from the Emergency ID pulldown menu.

6.14.5 Duration of Transmission

This function configures the transmission duration in 
Emergency Mode.  The transceiver males the automatic 
receiving in Emergency Mode after the Duration of 
Transmission Time expires.  (Refer to FUNC 24.1.5 
Duration of Transmission.)

Configure the Duration of Transmission by directly 
entering value in the edit box or clicking the spin buttons.

Note:

! A maximum of 2-digit numbers can be entered.

! When the value is configured to 0 or entire content of the edit 
box is deleted, the duration will be configured to 1 second.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! You cannot configure the Duration of Transmission if “ANI 
Board” is selected from the Emergency ID pulldown menu.

6.14.6 Duration of Locator Tone 2

This function allows you to configure the duration of Alert 
Tone to sound before Emergency Mode begins automatic 
receiving.  The Tone sounds when the transceiver 
alternates transmission and receiving while it repeats 
automatic transmission and receiving.  (Refer to FUNC 
24.1.6 Duration of Locator Tone 2.)
Configure the Duration of Locator Tone 2 by directly 
entering value in the edit box or clicking the spin buttons.

Note:

! A maximum of 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, this duration 
will be configured to “0”.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range.

! You cannot configure the Duration of Locator Tone 2 if the 
“Silent” is selected from the Emergency Mode Type pulldown 
menu.

! You cannot configure the Duration of Locator Tone 2 if the “ANI 
Board” is selected from the Emergency ID pulldown menu.

6.14.7 Receive Duration

This function configures the receiving duration in 
Emergency Mode.  The transceiver returns to Emergency 
Automatic Transmission Mode after the Receive Duration 
expires.  (Refer to FUNC 24.1.7 Receive Duration.)
Configure the Receive Duration by directly entering value 
in the edit box or clicking the spin buttons.

Range Infinite/ 1 - 200

In steps of 1

Default Infinite

Range 0 - 255 s

In steps of 1 s

Default 5 s

Range 1 - 60 s

In steps of 1 s

Default 20 s

Range 0 - 255 s

In steps of 1 s

Default 5 s
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Note:

! A maximum of 3-digit numbers can be entered.

! When the value is configured to 0 or entire content of the edit 
box is deleted, the duration will be configured to 1 second.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! You cannot configure the Receive Duration if the “ANI Board” is 
selected from the Emergency ID pulldown menu.

6.14.8 Emergency Display

You can configure the items to be displayed in 
Emergency Mode.  Select the desired Emergency Display 
option from the pulldown menu.  (Refer to FUNC 24.1.8 
Emergency Display.)

6.14.9 Emergency Text

The Emergency Text is the text displayed on the main 
display when “Text” is selected in the Emergency 
Display edit box.  Configure the Emergency Text by 
directly entering the characters in the edit box.  (Refer to 
FUNC 24.1.9 Emergency Text.)

Note:

! You cannot configure the Emergency Text if “Selected” is selected 
from the Emergency Display pulldown menu.

! When the entire content of the edit box is deleted, a blank will be 
configured.

6.14.10 Emergency Mode Type

You can configure the transceiver to emit the received 
voice.  Select the desired Emergency Mode Type from 
the pulldown menu.  (Refer to FUNC 24.1.10 Emergency 
Mode Type.)

6.14.11 Emergency Key Delay Time

You can configure the duration from the time when the PF 
Emergency key is pressed to the time when the 
transceiver enters Emergency Mode.  The transceiver 
enters Emergency Mode when the PF Emergency key is 
pressed for the Emergency Key Delay Time.  This delay 
time prevents the transceiver from unintentionally 
entering this mode.
Configure the Emergency Key Delay Time by directly 
entering value in the edit box or clicking the spin buttons.

Note:

! A maximum of 3-digit numbers and “.” (period) can be used.

! When the value is configured to 0 or the entire content of the edit 
box is deleted, the duration will be configured to Off.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

6.14.12 Emergency Mic Sense

This function allows you to configure the Mic Gain in 
Emergency Mode.  Select the desired Emergency Mic 
Sense option from the pulldown menu.  (Refer to FUNC 
1.12 Mic Sense Control.)

Range 1 - 180 s

In steps of 1 s

Default 40 s

Range

Selected
The previous channel appears even 
if the transceiver enters Emergency 
Mode.

Text
A pre-programmed message 
configured as Emergency Text 
appears during Emergency Mode. 

Default Selected

Range A maximum of 12 characters

Available 
characters

(space) ! ” # $ % & ’ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 
9 : ; < = > ? @ [ \ ] ^   ` A B C D E F G H I J K L 
M N O P Q R S T U V W X Y Z a b c d e f g h i j 
k l m n o p q r s t u v w x y z { | } ~

Default Blank

Range
Silent The transceiver mutes the received 

voice in Emergency Mode.

Audible The transceiver emits the received 
voice in Emergency Mode.

Default Silent

Range Off/ 0.1 - 5.0 s

In steps of 0.1 s

Default 1.0 s

Range
Normal The Mic Gain is configured to 

Normal.

High The Mic Gain is configured to High.

Default High
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6.14.13 Emergency LED

This function allows the transceiver to turn On the TX 
LED and BUSY LED to light when the transceiver 
transmits in Emergency Mode.  (Refer to FUNC 24.1.12 
Emergency LED.)

6.14.14 Background Transmission

This function allows the transceiver to overwrite the 
transmitted voice with 1630 Hz tone and emit the tone 
every 1 second in Emergency Mode.  (Refer to FUNC 
24.1.13 Background Transmission.)

Note: You cannot configure the Background Transmission if the 
“ANI Board” is selected from the Emergency ID pulldown 
menu.

6.14.15 Man Down Switch Type 
(TK-2180/ 3180 only)

You can configure the input port to enable the Man Down 
Switch.  Select Man Down Switch Type from the pulldown 
menu.

6.14.16 Man Down Delay Time 
(TK-2180/ 3180 only)

You can configure the duration from the time when the 
Man Down Switch is switched On to the time when the 
Man Down Switch is enabled.  The transceiver enters 
Emergency Mode when the Man Down Switch is enabled.  
You can use the Man Down Delay Time to prevent the 

Emergency function from being activated unintentionally.  
(Refer to FUNC 24.1.14 Man Down Delay Time.)
Configure the Man Down Delay by directly entering value 
in the edit box or clicking the spin buttons.

Note:

! A maximum of 2-digit numbers can be entered.

! When the value is configured to 0 or the entire content of the edit 
box is deleted, the duration will be configured to Off.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! When the configured value is less than the value configured to 
the Man Down Pre-alert edit box, the value, which is 1 second 
less than the duration configured to the Man Down Delay Time 
edit box, is automatically configured.

! You cannot configure the Man Down Delay Time when “Disable” 
is selected in the Man Down Switch Type pulldown menu. 

6.14.17 Man Down Pre-alert 
(TK-2180/ 3180 only)

You can configure the Man Down Pre-alert.  Man Down 
Pre-alert is one of the Alert Tones to sound from the time 
when the Man Down Switch is switched On to the time 
when the Man Down Switch is enabled.
When the Man Down Switch is enabled unintentionally, 
the transceiver emits the Pre-alert before activating the 
Emergency function to notify a user that the switch is 
switched On.  (Refer to FUNC 24.1.15 Man Down Pre-
alert.)
Configure the Man Down Pre-alert by directly entering 
value in the edit box or clicking the spin buttons.  The 
Man Down Pre-alert duration must be less than the Man 
Down Delay Time.

Note:

! A maximum of 2-digit numbers can be entered.

! When the value is configured to 0 or the entire content of the edit 
box is deleted, the duration will be configured to Off.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range. 

! When the value configured to the Man Down Delay Time edit 
box is less than the value configured to the Man Down Pre-alert 
edit box, the value, which is 1 second less than the duration 
configured to the Man Down Delay Time edit box, is 
automatically configured to the Man Down Pre-alert edit box.

Range
Check (Enable) The LED lights.

Uncheck (Disable) The LED does not light.

Default Unchecked (Disabled)

Range

Check (Enable)

The transceiver overwrites 
the transmitted voice with 
1630 Hz tone and emit the 
tone every 1 second in 
Emergency Mode.

Uncheck (Disable)

The transceiver does not 
overwrite the transmitted 
voice with 1630 Hz tone 
and emit the tone every 1 
second in Emergency 
Mode.

Default Unchecked (Disabled)

Range
Disabled The Man Down Switch is disabled.

Internal The internal Man Down Switch is 
enabled.

Default Disabled

Range Off/ 1 - 70 s

In steps of 1 s

Default 10 s

Range Off/ Man Down Delay Time - 1 s (A maximum of 
69 s)

In steps of 1 s

Default Off
Version: 1.11 Field Programming Reference 105



6 EDIT MENU
! You cannot configure the Man Down Pre-alert function when 
“Disable” is selected in the Man Down Switch Type pulldown 
menu. 

6.14.18 Man Down Logic Type

You can configure the logic of the Man Down Switch 
(External Switch).  Select the desired Man Down Switch 
Type from the pulldown menu.  (Refer to FUNC 24.1.16 
Man Down Logic Type.)

Note: You cannot configure the Man Down Logic Type when 
“Disable” is selected in the Man Down Switch Type 
pulldown menu. 

6.14.19 Emergency ID

This function allows you to configure the control type and 
the code to be sent for each time the transceiver starts 
automatic transmission and receiving in Emergency 
Mode.  Select Emergency ID from the pulldown menu.

Note: You cannot configure the ANI board if the “ANI Board” is 
selected in the Function window > Optional Board.

6.14.20 Emergency DTMF ID

You can configure the DTMF code to be sent first in 
Emergency Mode.  Configure the Emergency DTMF ID 
by directly entering value in the edit box.  (Refer to FUNC 
24.1.18 Emergency DTMF ID.)

Note:

! You cannot configure the Emergency DTMF ID if any other than 
the “DTMF” is selected from the Emergency ID pulldown menu.

! An error message appears when trying to write data to the 
transceiver in the following conditions.

• “DTMF” is selected from the Emergency ID pulldown menu.

• The Emergency DTMF ID edit box is configured to a blank.

6.14.21 Emergency Call Fleet

You can configure the Call Fleet to be sent first in 
Emergency Mode.  Configure the Emergency Call Fleet 
by directly entering value in the edit box or clicking the 
spin buttons.  (Refer to FUNC 24.1.19 Emergency Call 
Fleet.)

Note:

! You cannot configure the Emergency Call Fleet if any other than 
the “FleetSync” is selected from the Emergency ID pulldown 
menu.

! A maximum of 3-digit numbers and “.” can be entered.

! When the entire content of the edit box is deleted, a blank will be 
configured.

! When A or 0 is entered in the edit box, ALL will be configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range.

! If the Emergency Call ID edit box is a blank when the value is 
entered, the Emergency Call ID edit box will be configured to 
ALL.

!  An error message appears when trying to write data to the 
transceiver in the following conditions.

• “FleetSync” is selected from the Emergency ID pulldown 
menu.

• The Emergency Call Fleet edit box is configured to a blank.

Range

Active 
Low

The Ext Switch is enabled when the 
input port becomes low.

Active 
High

The Ext Switch is enabled when the 
input port becomes high.

Default Active Low

Range

None
The transceiver transmits and 
receives according to the 
configuration in the KPG-89D.

DTMF

The transceiver transmits and 
receives according to the 
configuration in the KPG-89D.  The 
transceiver sends the DTMF code 
configured at Emergency DTMF ID 
when it transmits in Emergency 
Mode.

FleetSync

The transceiver transmits and 
receives according to the 
configuration in the KPG-89D.  The 
transceiver sends the FleetSync 
Selcall ID first configured in the 
“Emergency Call Fleet” and 
“Emergency Call ID”.

ANI 
Board

The transceiver transmits and 
receives in conjunction with the ANI 
board control.

Default None

Range 16-digit characters

Available 
Codes # * 0 1 2 3 4 5 6 7 8 9 A B C D

Default Blank

Range Blank/ ALL (0)/ 100 - 349

In steps of 1 

Default Blank
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6.14.22 Emergency Call ID

You can configure the Call ID to be sent first in 
Emergency Mode.  Configure the Emergency Call ID by 
directly entering value in the edit box or clicking the spin 
buttons.  (Refer to FUNC 24.1.20 Emergency Call ID.)

Note:

! You cannot configure the Emergency Call ID if any other than 
the “FleetSync” is selected from the Emergency ID pulldown 
menu.

! A maximum of 4-digit numbers and “.” can be entered.

! When the entire content of the edit box is deleted, a blank will be 
configured.

! When A or 0 is entered in the edit box, the edit box will be 
configured to ALL.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of the 
range.

! If the Emergency Call Fleet edit box is a blank when the value 
is entered, the Emergency Call Fleet edit box will be configured 
to ALL.

! An error message appears when trying to write data to the 
transceiver in the following conditions.

• “FleetSync” is selected from the Emergency ID pulldown 
menu.

• The Emergency DTMF ID edit box will be configured to a 
blank.

6.15 Extended Function Window

You can configure the Extended Function in the 
Extended Function window.

6.15.1 Extended Function 
(TK-2180/ 3180 only)

You can configure the Optional Board in the Extended 
Function window.

Figure 6-53   Extended Function Window

" Optional Board
You can configure the installed Optional Board.  
Select the desired Optional Board from the pulldown 
menu.

" OPT1
You can configure the operation of the OPT terminal.  
Select the desired OPT1 option from the pulldown 
menu.

Note:

! You cannot select the desired OPT1 pulldown menu if the 
“Voice Scrambler” or “GPS-1” is selected from the Optional 
Board pulldown menu.

! You cannot select “LOK (Continuous)” from the OPT1 
pulldown menu if “None” is selected from the Optional 
Board pulldown menu.

! The configuration varies depending on the ANI Board is 
used in Conventional Groups or Trunking system.  Refer to 
the ANI Board manual for details.

Range Blank/ ALL (0)/ 1000 - 4999

In steps of 1 

Default Blank

Range None/ Voice Scrambler/ VGS-1/ ANI Board

Default None

Range

COR The transceiver notifies a user 
that it is receiving a carrier. 

TOR

The transceiver notifies a user 
that it received the GID in 
Trunking system and QT/ DQT is 
matched in Conventional 
Groups.

LOK 
(Continuous)

The transceiver notifies a user 
that voice communication is 
active when transmitting in 
Trunking system/ Conventional 
Group.

Default TOR
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6.15.2 Optional Board Tab
(TK-7180/ 8180 only)

This tab allows you to configure the Optional Board.

Figure 6-54   Optional Board Tab

" Optional Board
You can configure the installed Optional Board.  
Select Man Down Switch Type from the pulldown 
menu.

Note: The OPT 1 pulldown menu is configured to “TOR” when 
“None” is selected from the Optional Board pulldown 
menu and “LOK (Continuous)” is selected from the OPT 
1 pulldown menu.

" OPT1
You can configure the operation of the OPT terminal.  
Select the desired OPT1 option from the pulldown 
menu.

Note:

! You cannot select the desired OPT1 pulldown menu if the 
“Voice Scrambler” or “VGS-1” is selected from the Optional 
Board pulldown menu.

! You cannot select “LOK (Continuous)” from the OPT1 
pulldown menu if “None”î is selected from the Optional 
Board pulldown menu.

! The configuration varies depending on the ANI Board is 
used in Conventional Groups or Trunking system.  Refer to 
the ANI Board manual for details.

6.15.3 AUX Tab 
(TK-7180/ 8180 only)

This AUX tab allows you to configure the AUX function

Figure 6-55   AUX Tab

With the selection from the External Device pulldown 
menu, the default AUX function is as follows.

Table 6-10   AUX Default (None)

Table 6-11   AUX Default (KDS-100)

Range None/ Voice Scrambler/ VGS-1/ ANI Board

Default None

Range

COR The transceiver notifies a user 
that it is receiving a carrier. 

TOR

The transceiver notifies a user 
that it received the GID in 
Trunking system and QT/ DQT is 
matched in Conventional 
Groups.

LOK 
(Continuous)

The transceiver notifies a user 
that voice communication is 
active when transmitting in 
Trunking system/ Conventional 
Group.

Default TOR

Pin No. I/O Function Active

DB-25 4-pin Output None Low

DB-25 8-pin Output None Low

DB-25 12-pin Input None Low

DB-25 13-pin Input None Low

DB-25 15-pin Output None Low

DB-25 16-pin Output None Low

DB-25 20-pin Output None Low

DB-25 21-pin Input None Low

DB-25 22-pin Output None Low

DB-25 23-pin Input None Low

DB-25 24-pin Input None Low

Pin No. I/O Function Active

DB-25 4-pin Output None Low

DB-25 8-pin Output LOK Low

DB-25 12-pin Input Mic Mute Low

DB-25 13-pin Input External PTT 
(Data) Low

DB-25 15-pin Output None Low

DB-25 16-pin Output None Low

DB-25 20-pin Output TOR or 
Channel Busy Low
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Table 6-12   AUX Default (KGP-2A/ 2B)

" External Device
You can configure the External Device.  Select the 
desired External Device from the pulldown menu.

Note: All I/O ports and functions will be automatically 
configured when the “KDS-100” or “KGP-2A/2B” is 
selected.   (Refer to Table 6-11  AUX Default (KDS-100),  
Table 6-12  AUX Default (KGP-2A/ 2B))

" I/O
You can configure the input and output of each 
Function port.  Select the desired Pin No. from the I/O 
pulldown menu.

Note:

! You cannot select input or output for Pin No.15 and Pin No.16 
since they are fixed to Output.

! “None” is selected in the function pulldown menu of the Pin No. 
when the I/O pulldown menu is changed.

" Function
You can configure the functions that you can assign to 
each Function port.  Select the desired Pin No. from 
the Function pulldown menu.

Note:

! You cannot select the function that is already assigned to 
other Pin No.

! “Low” is selected in the I/O pulldown menu of the Pin No. 
when the Active pulldown menu is changed.

DB-25 21 pin Input Speaker Mute Low

DB-25 22-pin Input None Low

DB-25 23-pin Input None Low

DB-25 24-pin Input DTC Low

Pin No. I/O Function Active

DB-25 4-pin Output None Low

DB-25 8-pin Output LOK Low

DB-25 12-pin Input Mic Mute Low

DB-25 13-pin Input External PTT 
(Data) Low

DB-25 15-pin Output None Low

DB-25 16-pin Output None Low

DB-25 20-pin Output TOR or 
Channel Busy Low

DB-25 21-pin Input Speaker Mute Low

DB-25 22-pin Input Display Off Low

DB-25 23-pin Input None Low

DB-25 24-pin Input DTC Low

Range None/ KDS-100/ KGP-2A/2B

Default None

Pin No. I/O Function Active

Range Input/ Output

Default
Refer to Table 6-10  AUX Default (None)
Refer to Table 6-11  AUX Default (KDS-100)
Refer to Table 6-12  AUX Default (KGP-2A/ 2B)

Range

Refer to Table 6-13  Assigning Functions to the 
Auxiliary Input Ports
Refer to Table 6-14  Assigning Functions to the 
Auxiliary Output Ports

Default
Refer to Table 6-10  AUX Default (None)
Refer to Table 6-11  AUX Default (KDS-100)
Refer to Table 6-12  AUX Default (KGP-2A/ 2B)
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Table 6-13   Assigning Functions to the Auxiliary Input Ports

Function 
Name Description

Data PTT

The Data PTT is the PTT port for data 
communications.
This terminal changes the channel of the 
transceiver to Data Zone-CH/GID to start the 
transmission.
The transceiver moves to the Data CH/GID to start 
the transmission when the PF Data PTT port 
becomes low.
The transmission ends when the Data PTT port 
becomes High.  The transceiver stands by on the 
data channel during the Data CH/GID Dwell Time.  
The transceiver returns to the Voice channel after 
the Data CH/GID Dwell Time expires.
“REMOTE CTRL” appears on the main display 
when the Data PTT is enabled.
You can assign the following functions to the Data 
PTT port.
" Modulation Line

You can configure the modulation line for the PF 
Data PTT port.  The following modulation lines 
are available.
Mic (the audio line of the Mic located on the front 

of the transceiver)
MI2 Line (the audio modulation line of the D-sub 

connector located on the rear of the transceiver)
DI Line (the data modulation line of the D-sub 

connector)
The normal Modulation Line is the DI line.

" w/QT/DQT
You can configure the QT/DQT configured to the 
Conventional Group channel to be replaced when 
the transceiver transmits the code from the Data 
PTT port.  Normally, only the QT/DQT is replaced.

" w/STE
You can configure the STE (Squelch Tail 
Eliminator) to be transmitted after transmitting the 
QT/DQT code configured in the Conventional 
Group channel using the Data PTT port.  
Normally, the STE is transmitted.

External 
PTT 
(Voice)

External PTT (Voice) is the transmission request 
PTT port for Voice channels.
This port is used for the transmission request from 
the headset or external microphone.
The transceiver starts transmitting when the Ext. 
PTT (Voice) port becomes Low.
The transmission ends the transmission when the 
PF Ext. PTT (Voice) port becomes High.  If the CH/
GID is Data CH/GID, the transceiver moves to the 
lowest Voice CH/GID in the current zone and 
transmits.
You can configure the following functions to the Ext. 
PTT (Voice) port.
" Modulation Line

You can configure the Modulation line for the PF 
Ext. PTT (Voice) port.  The following modulation 
lines are available.
Mic (the audio line of the Mic located on the front 

of the transceiver)
MI2 Line (the audio modulation line of the D-sub 

connector located on the rear of the transceiver)
DI Line (the data modulation line of the D-sub 

connector)
The default modulation line is the MI2 line.

" w/QT/DQT
You can configure the QT/DQT configured to the 
Conventional Group channel to be replaced when 
the transceiver transmits the code from the PF 
Ext. PTT (Voice) port.  Normally, only the QT/DQT 
is replaced.

" w/STE
You can configure the STE (Squelch Tail 
Eliminator) to be transmitted after transmitting the 
QT/DQT code for the Conventional Group 
channel using the PF Ext. PTT (Voice) port.  
Normally, the STE is transmitted.

Function 
Name Description
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External 
PTT 
(Data)

The Data PTT is the PTT port for data 
communications.
You can use the port as follows.
"Using the External PTT (Data) port with DTC

The External PTT port is used for the 
transmission request PTT in ARQ Mode if it is 
used with the DTC.
After activating the DTC, transmit the data 
activating the Ext. PTT (Data) port.

" Using the External PTT (Data) port with CH/GID 
Select A-D

The External PTT port is used as the 
transmission request PTT for an external data 
communication device if it is used without using 
the Direct Channel (DTC) function.  However, the 
transceiver transmits on the current CH/GID 
without moving to the Data Zone-CH/GID.  
“REMOTE CTRL” appears on the main display 
when the External PTT (Data) port is active.

You can configure the following functions to the Ext. 
PTT (Data) port.
" Modulation Line

You can configure the modulation line for the Ext. 
PTT (Data) port.  The following modulation lines 
are available.
Mic (the audio line of the Mic located on the front 

of the transceiver)
MI2 Line (the audio modulation line of the D-sub 

connector located on the rear of the transceiver)
DI Line (the data modulation line of the D-sub 

connector)
The normal Modulation Line is the DI line.

" w/QT/DQT
You can configure the QT/DQT for the 
Conventional Group channel to be replaced when 
the transceiver through the Ext. PTT (Data) port.  
Normally, only the QT/DQT is replaced.

" w/STE
You can configure the STE (Squelch Tail 
Eliminator) to be transmitted after transmitting the 
QT/DQT code configured in the Conventional 
Group channel using the PF Ext. PTT (Data) port.  
Normally, the STE is transmitted.

CH/GID 
Select A-
D

This port is the CH/GID Select port to be used with 
the Remote CH/GID List. 
You can configure the port in the order of Configure 
CH/GID Select A > CH/GID Select B > CH/GID 
Select C > CH/GID Select D.  “REMOTE CTRL” 
appears on the main display when the CH/GID 
Select A - D port is active.

Function 
Name Description

DTC

This port allows the transceiver to move to the Data 
Zone-CH/GID for data communications, and 
activate ARQ Mode.
When performing data transmission in LTR 
Trunking system, the transceiver is normally 
required to link to a repeater prior to each data 
transmission.  Therefore, the data transmission may 
fail when the System is busy and there is no 
available channel in the repeater.  To solve this 
problem, ARQ Mode allows you to complete data 
communications in Trunking system by making a 
single link.
The transceiver does not transmit the EOT after the 
ARQ is once linked.  This function retains the link by 
using the Hang Up Time of the repeater while 
communicating with ACK signals.  With this 
function, you can use the Air Time effectively.
The transceiver enters ARQ Mode when the PF 
DTC port becomes low.  “REMOTE CTRL” appears 
on the main display when the DTC is active.

Speaker 
Mute

The speaker audio output line mutes when this port 
is used.
The transceiver mutes when the PF Speaker Mute 
port becomes Low.  The mute function is disabled 
when this port becomes High.

Mic Mute

The Mic modulation line mutes when this port is 
used.
The Mic Line (Front Mic, MI2) mutes when the PF 
Mic Mute port becomes Low.  The mute function is 
disabled when this port becomes High.

External 
Monitor

This port activates the Monitor function.
The transceiver activates the Monitor function when 
the PF Ext. Monitor port becomes Low.  The 
transceiver disables the Monitor function when the 
PF Ext. Monitor port becomes High.

External 
Hook

This port functions the same as Local Mic Hook.
The Microphone becomes On-hook when the Ext. 
Hook port becomes Low.  The Microphone 
becomes Off-hook status when the port becomes 
High.
You can reset Off-hook Decode, Off-hook Horn 
Alert, Off-hook Scan, and Optional Signaling in the 
same way as the Local Mic Hook.
When both the Local Mic Hook and the External 
Hook are Off-hook, the transceiver is active in Off-
hook status.  If either of them is swiched On, the 
transceiver operates in On-hook status.

Emergen
cy

This port allows the transceiver to activate the 
Emergency function.
You can configure the Emergency Key Delay Time 
to prevent this function from being activated 
unintentionally.  (24 Emergency Function)
The transceiver enters Emergency Mode when the 
PF Emergency port becomes low.  Emergency 
Mode operates according to the Emergency 
Information configuration.

Function 
Name Description
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Table 6-14   Assigning Functions to the Auxiliary Output 
Ports

" Active
You can configure the operation of each Function 
Input or Output port when the port becomes active.  

AUX In 
Status 
Message 
1 - 3

This port is used as the trigger port to send the 
FleetSync Status Message.
The transceiver sends the Status Message to the 
FleetSync configured in Target Fleet/ ID when the 
status of the AUX IN changes (High > Low or Low > 
High).
You can configure 2 statuses (High > Low, Low > 
High) to each port.  These ports are normally used 
as the sensor port for telemetry purposes.

Display 
Off

This port becomes active when the external device 
(KGP-2A) enters Emergency Mode.
The transceiver also enters Emergency Mode when 
the port becomes active.  The transceiver returns to 
the previous channel when the port becomes 
inactive.
This port works according to the following condition.
• Emergency CH/GID
• Emergency Display
• Emergency Text
• Emergency Audio
• Emergency LED
The Panel key does not work while this port is 
active.

Function 
Name Description

LOK

The transceiver notifies a user that voice 
communication is active when transmitting in 
Trunking system/ Conventional Group.
In Trunking system, this port becomes active when 
the transceiver connects to a repeater.  Otherwise, 
this port is inactive.
In Convention Groups, this port becomes active 
(low) upon transmission.  Otherwise, this port is 
inactive.
There are two types of LOK Logic Signals: 
Continuous and Pulse. This port is always low when 
Continuous is selected.  The port becomes active 
for the first 30 ms, then it returns to open level when 
Pulse is selected.

COR

The transceiver notifies a user that it is receiving a 
carrier. 
This port becomes active when receiving a carrier in 
Trunking system or Conventional Group.  
Otherwise, this port is inactive.

TOR

The transceiver notifies a user that it received the 
GID in Trunking system and QT/ DQT is matched in 
Conventional Groups.
This port becomes active when receiving a call with 
GID in Trunking system.  Otherwise, this port is 
inactive.
This port becomes active when receiving a carrier 
on the channel that the QT/DQT Decode is 
configured or QT/DQT Decode is not configured in 
Conventional Groups.  Otherwise, this port is 
inactive.

AUX A
The port output changes in conjunction with the PF 
AUX A port.  A user can control an external device 
connected to the AUX A port.

Function 
Name Description

AUX B
The port output changes in conjunction with the PF 
AUX B port.  A user can control an external device 
connected to the AUX B port.

System 
Busy

The transceiver notifies a user that all repeaters in 
the Trunking system are busy.  This port becomes 
active when no channel is available in the repeater 
in Trunking system.  Otherwise, this port is inactive.

PTT Out

The transceiver notifies a user the PTT switch is 
pressed.  This function is available when an 
optional board or an external device is connected to 
the transceiver.
This port becomes active when the PTT switch is 
pressed.  Otherwise, this port is inactive.

Channel 
Busy

This port notifies a user that the remote control 
request from the external device is rejected. 
This port becomes active in the following conditions.
Otherwise, this port is inactive.
" Transmission

All transmissions (including automatic 
transmission and the transmission using the PTT 
switch)

" Emergency
Emergency Mode status

" During Mode
When selecting FleetSync Selcall List or 
transmitting DTMF Autodial and System Search, 
or LTR Handshake and Public Address

COR or 
Channel 
Busy

This port becomes active when the COR port or 
Channel Busy port is active.  When neither of ports 
is disabled, this port becomes inactive.

TOR or 
Channel 
Busy

This port becomes active when the TOR port or 
Channel busy port is active.  When neither of ports 
is disabled, this port becomes inactive.
This port is used to connect the KDS-100 to the 
transceiver.  With this port, you can restrict the 
transmission request to the KDS-100 when you do 
not want the transceiver to be controlled with an 
external device.

TXS

This port notifies a user that the transceiver is 
transmitting.
This port becomes active during transmission.  
Otherwise, this port is inactive.

AUX Out 
Status 
Message 
1 - 3

This port is used to change the status of the 
transceiver when it receives the FleetSync Status 
Message.
This port switches the Status of the AUX Out port 
(High > Low or Low > High) when the received 
Status Message matches the Status number 
configured to the port.
You can configure 2 statuses (High > Low, Low >  
High) to each port.
This port is normally used to remotely control the 
transceiver by connecting an external device to the 
AUX Out port. 

Function 
Name Description
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Select the desired port from the Pin No. Active 
pulldown menu.

Note:

! “Low” is selected in the Active pulldown menu when the 
“Output” is selected in I/O pulldown menu.

! “Low” is selected in the Active pulldown menu when 
the“Input” is selected in I/O pulldown menu and you cannot 
switch input and output.

" Data Dwell Time (AUX Input)
This function allows you to configure the delay time 
from the time when the PF Data PTT port or PF DTC 
port is activated to the time when the transceiver 
returns to the Voice CH/GID.  (Refer to FUNC 25.1.3 
Data CH/GID Dwell Time.)
Configure the Data Dwell Time by directly entering 
value in the edit box or clicking the spin buttons.

Note:

! A maximum of 3-digit numbers can be entered.

! When the entire content of the edit box is deleted, “0” wll be 
configured.

! When a value outside of the available range is entered, it is 
replaced with the upper limit value or the lower limit value of 
the range. 

! You can configure the Data Dwell Time only if the “Data 
PTT” or “DTC” is selected in a Function pulldown menu of 
Pin No.

" Mic Sense (AUX Input)
You can configure the Mic. Gain of the External PTT.  
(Refer to FUNC 1.12 Mic Sense Control.)
Select the desired Mic Sense option from the 
pulldown menu.

Note: You can configure the Mic Sense only when the 
“External PTT (Voice)” or “External PTT (Data)” is 
selected in a Function pulldown menu of Pin No.

" Data Override (AUX Input)
You can select the priority either voice 
communications or data communications.  (Refer to 
FUNC 25.1.6 Data Override.)

Range High/ Low

Default
Refer to Table 6-10  AUX Default (None)
Refer to Table 6-11  AUX Default (KDS-100)
Refer to Table 6-12  AUX Default (KGP-2A/ 2B)

Range 0 - 300 s

In steps of 1 s

Default 0 s

Range
Normal The Mic Gain is configured to 

Normal.

High The Mic Gain is configured to High.

Default Normal

Range

Check (Enable)

This option gives higher 
priority to the external 
device to make data 
communications.
If the transceiver receives 
the transmission requests 
from the PF Ext. PTT 
(Data) port, PF Data PTT 
port, PF DTC port, or PF 
CH/GID Select A - D port, 
it always cancels the 
current option and 
changes to make data 
communication.
The transceiver moves to 
the Data CH/GID if the 
Data CH/GID is 
configured.
The “Data” appears on the 
main display when the 
transceiver is controlled by 
external devices.  In this 
case, a user cannot use 
any keys on the transceiver 
other than Power switch, 
and the PF Emergency 
key.

Uncheck (Disable)

The transceiver key 
control has the priority.
If the transceiver receives 
the transmission requests 
from the PF Ext. PTT 
(Data) port, PF Data PTT 
port, PF DTC port, or PF 
CH/GID Select A - D port, 
it always ignores 
transmission.

Default Unchecked (Disabled)
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Note: You can configure the Data Override only when the 
following port is selected in a Function pulldown menu 
of Pin No.

• Data PTT

• External PTT (Data)

• CH/GID Select A - D

• DTC

" Front Mic (Mic Mute)
You can enable the Front Mic Mute function when the 
Mic Mute port is active.

Note: You can configure the Front Mic only when the “Mic 
Mute” is selected in a Function pulldown menu of Pin 
No.

" MI2 (Mic Mute)
You can enable the MI2 Mute function when the Mic 
Mute port is active.

Note: You can configure the MI2 only when the “Mic Mute” is 
selected in a Function pulldown menu of Pin No.

" LOK Logic Signal (AUX Output)
You can configure the LOK Active Type.  Select the 
desired LOK Logic Signal from the pulldown menu.

Note: You can configure the LOK Logic Signal only when the 
“LOK” is selected in a Function pulldown menu of Pin 
No.

6.15.4 Remote Zone-CH/GID Tab 
(TK-7180/ 8180 only)

You can configure the Remote CH/GID List.
The Remote CH/GID List allows external devices to 
change the transceiver’s Zone-CH/GID.  The transceiver 
can move to a maximum of 15 Zone-CH/GIDs by using 
CH/GID Select A - CH/GID Select D port.

Figure 6-56   Remote Zone-CH/GID Tab

A error message appears when the Remote Zone-CH/
GID tab is clicked while the Zone-CH/GID is not selected 
in the order starting from “CH/GID Select A” in the AUX 
tab > the Function pulldown menu.

Figure 6-57   Remote Zone-CH/GID Error Message

Following are the configuration in the AUX tab > the 
Function pulldown menu and the target Remote CH/GID 
No. in the Remote CH/GID List.

Table 6-15   When only the CH/GID Select A is Configured.

Range
Check (Enable) The Front Mic is muted

Uncheck (Disable) The Front Mic is not muted

Default Checked (Enabled)

Range
Check (Enable) The MI2 is muted

Uncheck (Disable) The MI2 is not muted

Default Unchecked (Disabled)

Range

Continuous
The port is always low 
when the LOK Logic 
Signal is activated.

Pulse
The port becomes low for 
the first 3 ms, then it 
returns to the open level.

Default Continuous

Target CH/GID
AUX Input Port

CH/GID Select A

Current CH/GID High

Remote CH/GID No.1 Low
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Table 6-16   When CH/GID Select B and CH/GID Select A are
Configured.

Table 6-17   When CH/GID Select C, CH/GID Select B and 
CH/GID Select A are Configured

Table 6-18   When CH/GID Select D, CH/GID Select C, And 
CH/GID Select B and CH/GID Select A are Configured.

" Zone (Remote Zone-CH/GID List)
You can configure the Zone.  Configure the Zone by 
entering a value in the edit box or selecting from the 
pulldown menu.  (Refer to FUNC 27 Remote CH/GID 
List.)

Note:

! A maximum of 3-digit numbers can be entered.  When “0” is 
entered in the edit box, the edit box will be configured to “1”.

! When the entire content of the edit box is deleted, “None” 
will be configured.

! When the Zone edit box is configured to “None”, the CH/GID 
edit box will also be configured to “None”.

! An error message appears if the entered Zone-CH/GID does 
not exist and the transceiver returns to the previous value. 

" CH/GID (Remote Zone-CH/GID List)
You can configure the CH/GID.  Configure the CH/GID 
by entering a value in the edit box or selecting from 
the pulldown menu.  (Refer to FUNC 27 Remote CH/
GID List.)

Target CH/GID
AUX Input Port

CH/GID Select B CH/GID Select A

Current CH/GID High High

Remote CH/GID 
No. 1 High Low

Remote CH/GID 
No. 2 Low High

Remote CH/GID 
No. 3 Low Low

Target CH/GID
AUX Input Port

CH/GID 
Select C

CH/GID 
Select B

CH/GID 
Select A

Current CH/GID High High High

Remote CH/GID 
No. 1 High High Low

Remote CH/GID 
No. 2 High Low High

Remote CH/GID 
No. 3 High Low Low

Remote CH/GID 
No. 4 Low High High

Remote CH/GID 
No. 5 Low High Low

Remote CH/GID 
No. 6 Low Low High

Remote CH/GID 
No. 7 Low Low Low

Target CH/GID
AUX Input Port

CH/GID 
Select D

CH/GID 
Select C

CH/GID 
Select B

CH/GID 
Select A

Current CH/GID High High High High

Remote CH/GID 
No. 1 High High High Low

Remote CH/GID 
No. 2 High High Low High

Remote CH/GID 
No. 3 High High Low Low

Remote CH/GID 
No. 4 High Low High High

Remote CH/GID 
No. 5 High Low High Low

Remote CH/GID 
No. 6 High Low Low High

Remote CH/GID 
No. 7 High Low Low Low

Remote CH/GID 
No. 8 Low High High High

Remote CH/GID 
No. 9 Low High High Low

Remote CH/GID 
No. 10 Low High Low High

Remote CH/GID 
No. 11 Low High Low Low

Remote CH/GID 
No. 12 Low Low High High

Remote CH/GID 
No. 13 Low Low High Low

Remote CH/GID 
No. 14 Low Low Low High

Remote CH/GID 
No. 15 Low Low Low Low

Range None/ Existing Zone-CH/GID

Default None

Range None/ Existing Zone-CH/GID

Default None

Target CH/GID
AUX Input Port

CH/GID 
Select D

CH/GID 
Select C

CH/GID 
Select B

CH/GID 
Select A
Version: 1.11 Field Programming Reference 115



6 EDIT MENU
Note:

! A maximum of 3-digit numbers can be entered.  When “0” is 
entered in the edit box, the edit box will be configured to “1”.

! When the entire content of the edit box is deleted, None will 
be configured.

! When the Zone edit box is configured to “None”, the CH/GID 
edit box will also be configured to “None”.

! An error message appears if the entered Zone-CH/GID does 
not exist and the transceiver returns to the previous value. 

! An error message appears when trying to write data while a 
value is configured to the Zone edit box and the CH/GID edit 
box is configured to None.

! An error message appears if you try to configure the already 
configured Remote Zone-CH/GID. 

6.15.5 Modulation Line Tab
(TK-7180/ 8180 only)

You can make the following configurations for Mic PTT, 
External PTT (Voice), External PTT (Data) and Data PTT.
• Connect to Modulation Line
• w/QT/DQT
• w/STE

Figure 6-58   Modulation Line Tab

The status of the modulation line appears on the top of 
the window.

Figure 6-59   When Connect is Selected.

Figure 6-60   When Disconnect is Selected.

Following are defaults of the modulation line.

Table 6-19   Default Modulation Line 

Note: You cannot configure the modulation line unless the items in 
the AUX tab > the Function pulldown menu are configured. 

" Mic Line
You can enable the Mic Line.  Select the desired Mic 
Line option from the pulldown menu.

" Ml2 Line
You can enable the MI2 Line.  Select the desired MI2 
Line option from the pulldown menu.

" Dl Line
You can enable the DI Line.  Select the desired DI 
Line from the pulldown menu.

" w/QT/DQT
You can configure the QT/DQT in the Conventional 
Group to be replaced.

" w/STE
You can select whether or not to transmit STE 
(Squelch Tail Eliminator) after transmitting the QT/
DQT code configured in the Conventional Group.

PTT
Connect to Modulation Line

Mic Line MI2 Line DI Line

Mic PTT Connect Disconnect Disconnect

Extended PTT 
(Voice) Disconnect Connect Disconnect

Extended PTT 
(Data) Disconnect Disconnect Connect

Data PTT Disconnect Disconnect Connect

Range Connect/ Disconnect

Default Refer to Table 6-19  Default Modulation Line

Range Connect/ Disconnect

Default Refer to Table 6-19  Default Modulation Line

Range Connect/ Disconnect

Default Refer to Table 6-19  Default Modulation Line

Range
Yes The QT/DQT is replaced.

No The QT/DQT is not replaced.

Default Yes

Range
Yes The transceiver transmits the STE.

No The transceiver does not transmit 
the STE.

Default Yes
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6.16 Zone Merge Window

Zone Merge is the function allowing you to store the Zone 
Data in the Source File in order to integrate the Zone 
information.  With this function, you do not need to enter 
the information when making similar configurations 
(Repeater Channel, etc.).
You can also copy the Zone information in the Source file 
to the Data file.
With this function, the Data Zone-CH/GID information 
edited in the Zone Edit window can be stored in the 
Source File.  If a Zone using several Zones is stored, a 
unexpected Data Zone-CH/GID is configured when 
copying the Zone Information in the Source file.  You must 
check the Zone Edit before copying the Zone Information 
in the Source File to the Data File.

Figure 6-61   Zone Merge Window 1

6.16.1 Creating the Source File from 
the Data File

You can create a maximum of 20 Source Files using the 
configured Zone data. You can create a maximum of 20 
source files.
1. Click “Change”.

“Data Zone ->” appears on the display.

Figure 6-62   Zone Merge Window 2

2. Enter the data file No. to be copied on the source file 
in the “Data Zone ->” column.

Figure 6-63   Zone Merge Window 3

3. Click “Copy”.
The Zone information is copied to the source file.

Figure 6-64   Zone Merge Window 4
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6.16.2 Copying the Zone Information 
from the Source File to the Data 
File

1. Click “Change”.
“<- Source Zone” appears on the display.

Figure 6-65   Zone Merge Window 5

2. Enter the source file No. to be copied on the data file 
in the Source Zone column.

Figure 6-66   Zone Merge Window 6

3. Click “Copy”.
The Zone information is copied to the data file.

Figure 6-67   Zone Merge Window 7

6.17 Test Frequency

You can configure the test frequency to test the 
transceiver in this window.  You can configure a maximum 
of 16 channels.

Figure 6-68   Test Frequency Window

6.17.1 Receive/ Transmit

You can configure the test frequency.  Configure the test 
frequency by entering number in the Receive and 
Transmit edit boxes.
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Table 6-20   Test Frequency Range

Table 6-21   Default Test Frequency of the TK-2180/ 7180   

Table 6-22   Default Tuning Frequency of the TK-3180/ 8180 
(450 - 520 MHz)  

Table 6-23   Default Tuning Frequency of the TK-3180/ 8180 
(400 - 470 MHz)   

6.18 Embedded Message 
Window

You can configure the message that is stored in the 
transceiver in the Embedded Message window.  You can 
store a message with a maximum of 64 characters 
(combination of alphabets and numerals) in the 
transceiver.  You can embed the specific information of 
the transceiver, such as the control number and the name 
of the configuration data written in the repeater.
You can read the embedded messages from the 
transceiver using the KPG-89D.  (Refer to 7.1 Read Data 
from the Transceiver.)
The Embedded Message appears on the Open window 
when the configuration data is opened.  (Refer to 4.2 
Open.)

Range Refer to Table 6-20  Test Frequency Range

Default

Refer to Table 6-21  Default Test Frequency of 
the TK-2180/ 7180
Refer to Table 6-22  Default Tuning Frequency 
of the TK-3180/ 8180 (450 - 520 MHz)
Refer to Table 6-23  Default Tuning Frequency 
of the TK-3180/ 8180 (400 - 470 MHz)

Model Market Code Type
Transmit and 

Receive Frequency 
[MHz]

TK-2180/ 7180 K 136 - 174

TK-3180/ 8180 K 450 - 520
400 - 470

Channel No. Receive Frequency 
[MHz]

Transmit Frequency 
[MHz]

1 155.05000 155.10000

2 136.05000 136.10000

3 173.95000 173.90000

4 155.00000 155.00000

5 155.20000 155.20000

6 155.40000 155.40000

7 177.95000 177.90000

8 - -

9 - -

10 - -

11 - -

12 - -

13 - -

14 - -

15 - -

16 - -

Channel No. Receive Frequency 
[MHz]

Transmit Frequency 
[MHz]

1 485.05000 485.10000

2 450.05000 450.10000

3 519.95000 519.90000

4 485.00000 485.00000

5 485.20000 485.20000

6 485.40000 485.40000

7 - -

8 - -

9 - -

10 - -

11 - -

12 - -

13 - -

14 - -

15 - -

16 - -

Channel No. Receive Frequency 
[MHz]

Transmit Frequency 
[MHz]

1 435.05000 435.10000

2 400.05000 400.10000

3 469.95000 469.90000

4 435.00000 435.00000

5 435.20000 435.20000

6 435.40000 435.40000

7 - -

8 - -

9 - -

10 - -

11 - -

12 - -

13 - -

14 - -

15 - -

16 - -

Channel No. Receive Frequency 
[MHz]

Transmit Frequency 
[MHz]
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Figure 6-69   Embedded Message Window

Directly enter the characters in the edit box.

6.19 Embedded Message 
w/Password

You can configure the message and the password to the 
transceivers in the Embedded Message w/Password 
window.  You can configure a message with up to 64 
characters (combination of alphabets and numerals) to 
the repeater.  You can also configure the password to 
protect the message.  You can embed the specific 
information of the transceiver, such as the control number 
and the name of the configuration data written in the 
transceiver.

Figure 6-70   Embedded Message w/Password Window 1

Directly enter the characters in the edit box.

6.19.1 Writing the Configuration Data 
to the Transceiver

You can write the entered message to the transceiver. 
Follow the procedures below to write the message into 
the transceiver.
1. Enter the message.
2. Click “Write”.

The password entry display appears if the password is 
already configured.

Figure 6-71   Embedded Message w/Password Window 2

3. Enter the password and click “OK”.
When the entered password is correct the message is 
written to the transceiver, and the the following 
message appears.

Figure 6-72   Embedded Message w/Password Window 3

Note:

! The following error message appears if no password is 
configured.  Click “OK” on the above display to write the 
message to the transceiver. 

Figure 6-73   Embedded Message 
 w/Password Confirmation Message

Range
A message with a maximum of 64 characters 
and symbols (You can enter a maximum of 32 
characters and symbols in an edit box).)

Default Blank

Range
A message with a maximum of 64 characters 
and symbols (You can enter a maximum of 32 
characters and symbols in an edit box).)

Default Blank
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! The following error message appears when the password is not 
correct.  The Password Entry window closes when entering a 
wrong password three times in a row.

Figure 6-74   Embedded Message
 w/Password Error Message

! When the message is written with the Embedded Message w/
Password function, the message is stored as a separate data 
from the configuration data.

6.19.2 Configuring and Changing the 
Password

You can configure the password and change it. 
Follow the procedures below to write the message into 
the transceiver.
1. Click “Password”.

The Warning message appears.  Click “OK” to open 
the Password Change window.

Figure 6-75   Embedded Message 
 w/Password Warning Message

2. Enter the password.
Enter a maximum of 6 characters in the edit box.
Old Password: Enter the old password in this box.
New Password: Enter the new password.
Confirm: Enter the same password as the New 

Password to confirm it. 

Figure 6-76   Embedded Message w/Password Window 4

3. Click “Write”.
When the entered password is correct the message is 
written to the transceiver, and the the following 
message appears.

Figure 6-77   Embedded Message w/Password Window 5

Note:

! The following error message appears when the old password is 
not correct.

Figure 6-78   Embedded Message 
 w/Password Error Message

! The following error message appears when the new password 
does not match the password entered in the confirm box.

Figure 6-79   Embedded Message 
 w/Password Error Message
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7.1 Read Data from the 

Transceiver

This function allows you to read the configuration data 
from the transceiver with the KPG-36/ 46 programming 
cable by using the KPG-89D.  (Refer to 1.2 Connecting 
the Transceiver to the PC.)
Follow the procedures to read data from the transceiver.
1. You can select one of the following options.

•Select “Program” > “Read Data from the 
Transceiver”.

•Click “ ” icon on the Toolbar.
The Read Data from the Transceiver window 
appears.

Figure 7-1   Read Data from the Transceiver Window 1

2. Click “Read”.
A PC starts reading the configuration data from the 
transceiver.

Figure 7-2   Read Data from the Transceiver Window 2

#If the Data Password is configured to the 
Transceiver:
Click “Read” to open the Input Password window.

 

Figure 7-3   Input Password Window

Enter the password in the Password edit box and 
click “OK”.
A PC starts reading the configuration data from the 
transceiver when the password is correct.

Note:

! Embedded Message appears if the configuration data 
contains embedded message.

! The error message appears when the password is not 
correct.  The Input Password window closes when entering 
a wrong password three times in a row.

! The entered numbers appear as *.

3. Click “OK”.
 

Figure 7-4   Read Data from the Transceiver Window 3

Note:

! A PC cannot read the configuration data from the 
transceiver when the transceiver does not respond even if 
“Read” is clicked.  In this case, you must ensure the power 
of the transceiver and the connection between the PC and 
the transceiver, and then start the operation again.

! An error message appears when the transceiver’s model 
type is different from the model type selected in the KPG-
89D. In this case, you must ensure the transceiver’s model 
type and start the operation again.

! An error message appears when the COM port does not 
open and you cannot read the configuration data from the 
transceiver.  In this case, you must ensure the COM port 
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configuration in the COM port window, and then start the 
operation again.  (Refer to 9.1 COM port.)

7.2 Write Data to the Transceiver

This function allows you to write the configuration data to 
the transceiver connected to the PC with the KPG-36/ 46 
programming cable by using the KPG-89D.  (Refer to 1.2 
Connecting the Transceiver to the PC.)
Follow the procedures to read data from the transceiver.
1. You can select one of the following options.

•Select “Program” > “Write Data to the Transceiver”.
•Click the “ ” icon on the Toolbar.

The Write Data to Transceiver window appears.

Figure 7-5   Write Data to the Transceiver Window 1

2. Check the Adjustment Time checkbox if you want to 
adjust the PC’s clock while writing data to the 
transceiver.  (Refer to 7.2.1 Adjustment Time.)

3. Click “Write”.
The PC starts writing the configuration data to the 
transceiver.

Figure 7-6   Write Data to the Transceiver Window 2

#If the Overwrite Password is configured to the 
transceiver:
Click “Write” to open the Input Password window.

 

Figure 7-7   Input Password Window

#If the Read Authorization Password or Overwrite 
Password is configured to the configuration data:
A warning message appears when clicking “Write”.

 

Figure 7-8   Write Data to the Transceiver Window Warning 
message

Click “OK” to start writing the configuration data to 
the transceiver.
The data writing completion message appears 
when a PC properly writes the confirmation to the 
transceiver.

4. Click “OK”.
 

Figure 7-9   Write Data to the Transceiver Window 3

Note:

! The PC cannot write the configuration data to the transceiver 
when the transceiver does not respond even if “Write” is clicked.  
In this case, you must ensure the power of the transceiver and 
the connection between the PC and the transceiver, and then 
start the operation again.

! An error message appears when the transceiver’s model type is 
different from the model type selected in the KPG-89.  In this 
case, you must ensure the transceiver’s model type and start the 
operation again.
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! An error message appears when the COM port does not open 
and you cannot read the configuration data from the transceiver.  
In this case, you must ensure the COM port configuration in the 
COM port window, and then start the operation again.  (Refer to 
9.1 COM port.)

7.2.1 Adjustment Time

This function allows you to adjust the time when writing 
the data to the transceiver using the KPG-89D.

7.3 Test Mode

You can configure the data used to perform various tests 
and adjustments in the Test Mode window when using the 
transceiver in Test Mode.  In this mode, you can make 
various adjustments, such as checking the RF 
environment of the location and the adjustment of the 
receive frequency, before installing the transceiver.  You 
can start the test without writing data since the Encode/
Decode signaling and the test frequency are already 
configured.  (Refer to 6.17 Test Frequency.)
You can modify the test and other configuration data 
using the KPG-89D.
 

Figure 7-10   Test Mode Window

7.3.1 Test Channel

You can select the channel to test.  Configure the Test 
Channel by directly entering value in the edit box or 
clicking the spin buttons.  (Refer to 6.17 Test Frequency.)
The frequency configured to the selected channel number 
appears in the Frequency window.

Note:

! When all edit boxes are deleted, the previously used value is 
configured.

! You cannot select the number of the channel that is not 
configured in the Test Frequency window.

7.3.2 Test Signaling

You can configure the test signaling.  Configure the Test 
Signaling by directly entering value in the edit box or 
clicking the spin buttons.
The Decode Tone/ Encode Tone configured to the 
selected Signaling Number appears in the Tone window.

Note: When all edit boxes are deleted, the previously used value is 
configured.

7.3.3 Wide/ Narrow

You can configure the transmission bandwidth of the test 
channel.  You can select the bandwidth using the 
pulldown menu.

Range

Check (Enable)
You can adjust the time 
while writing data to the 
transceiver.

Uncheck (Disable)
You do not adjust the 
time while writing data to 
the transceiver.

Default Checked (Enabled)

Range Channel Number configured in the Test 
Frequency window (1 - 16)

Default 1

Range 1 - 17

Default 1

Range Wide/ Narrow

Default Narrow
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7.3.4 TX Button

Click “TX” to toggle between transmission and reception.

7.3.5 Print Button

Click “Print” to print out the Tuning Data.

7.3.6 Tuning Mode

You can make various adjustments for the functions used 
in Test Mode in Tuning Mode.  Double-click the function in 
the list box in the Test Mode window to view the 
adjustment window of the selected function.  (Refer to 
Table 6-25 Function List in Tuning Mode.)
 

Figure 7-11   Tuning Mode Window 
(Single Reference Level Adjustment)

 

Figure 7-12   Tuning Mode Window 
(3 Reference Level Adjustments)

 

Figure 7-13   Tuning Mode Window 
(5 Reference Level Adjustments)

" Adjustment Bar
You can configure the transmit adjustment value. 
Configure the adjustment value using the slide bar.

" Volume (TK-7180/ 8180 only)
You can configure the volume. Configure the volume level 
using the slide bar.

Table 7-1   Functions in Tuning Mode

Range 1 - 256

Default Last configuration data

Range 0 - 31

Default Last configuration data

Function

Refere
nce 

Level 
Adjust
ment

Wide/ Narrow Remarks

Frequency 
Adjustment 1 -

Shift 1 3 -

Shift 2 3 -

Max High 
Transmit Power 5 - TK-7180/ 8180 only

Max Low 
Transmit Power 5 - TK-7180/ 8180 only

High Transmit 
Power 5 -

Low Transmit 
Power 5 -

DQT Balance 1/ 3 Wide/ Narrow

Max Deviation 1/ 3 Wide/ Narrow

VOX 1 1 - TK-2180/ 3180 only

VOX 10 1 - TK-2180/ 3180 only

QT Fine 
Deviation 1/ 3 Wide/ Narrow
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DQT Fine 
Deviation 1/ 3 Wide/ Narrow

LTR Fine 
Deviation 3 Wide/ Narrow

DTMF Fine 
Deviation 1 Wide/ Narrow

MSK Deviation 1 Wide/ Narrow Adjustment value 
range: 1 - 64

Single Tone 
Deviation 1 Wide/ Narrow

Sensitivity 1 5 -

Sensitivity 2 5 - TK-2180/ 3180 only

Squelch Open 3 Wide/ Narrow

Low RSSI 3 Wide/ Narrow

Squelch Tight 3 Wide/ Narrow

High RSSI 3 Wide/ Narrow

Battery Warning 
Level 1 - TK-2180/ 3180 only

Function

Refere
nce 

Level 
Adjust
ment

Wide/ Narrow Remarks
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8.1 Transceiver Information

The information configured in the transceiver appears on 
the Transceiver Information window.

Figure 8-1   Transceiver Information Window

8.1.1 Model Name

The model name of the transceiver appears.  (Refer to 
5.1.1 Model Name.)

8.1.2 Frequency

The frequency configured in the transceiver appears.  
(Refer to 5.1.1 Model Name.)

8.1.3 Serial Number

The Serial Number configured in the transceiver appears.

8.1.4 Version

The firmware version of the transceiver appears.  

8.1.5 Checksum

The checksum used to transmit/receive data appears.
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9.1 COM port

You can select the COM port of a PC to communicate 
with the transceiver.

Figure 9-1   COM Port Window

Select the COM port from COM 1 - COM 20 and click 
“OK”.

9.2 Language File Setup

You can select the language for the KPG-89D using the 
Language File Setup window.

Figure 9-2   Language File Setup Window

From the dropdown list, you can select the language.

Note: The selected language in the Language File Setup window 
is applied to all KPG-89D software functions.
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10.1 Tree View

This window displays the functions in the Edit menu.  
Double-click each item to display the window of the 
selected item.
The Tree View window can be docked to the KPG-89D 
window.
You can remove the Tree View window from the KPG-
89D window by double-clicking the frame of the window.

Figure 10-1   Tree View Window

10.2 Toolbar

You can display/ hide the toolbar.  You can display or hide 
the toolbar by selecting “View” >  “Toolbar”.  (Refer to 
3.1.3 Toolbar.)

10.3 Status Bar

You can display/ hide the status Bar.  You can display or 
hide the status bar by selecting “View” > “Status Bar”.  
(Refer to 3.1.4 Status Bar.)
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The Window menu appears when the function is 
selected in the Edit menu and the window of the function 
is displayed.  You can rearrange and close the opened 
windows.

11.1 Cascade

You can rearrange the opened windows in an overlapped 
fashion (cascade format) by selecting “Cascade”.

Figure 11-1   Cascade

11.2 Horizontal Tile

You can rearrange the opened windows in the horizontal 
tiles fashion by selecting “Horizontal Tile”.

Figure 11-2   Horizontal Tile

11.3 Vertical Tile

You can rearrange the opened windows in the vertical 
tiles fashion by selecting “Vertical Tile”.

Figure 11-3   Vertical Tile

11.4 Arrange Icons

You can rearrange the icons of the minimized windows by 
selecting “Arrange Icons”.

Figure 11-4   Arrange Icons
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11.5 Close All Windows

You can close all opened windows by selecting “Closes 
All Windows”.

11.6 Opened Window List

This function allows you to list all opened windows.  
When clicking the title of the window, the selected window 
appears.

Figure 11-5   Opened Window List
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12.1 Help Topics

You can display the KPG-89D HTML Help window by 
selecting “Help” > “Help Topics”.  In this window, you can 
search for the help topics relating to the operations and 
functions of the KPG-89D.
This window consists of the following tabs and you can 
switch the display by clicking the tabs.
• Contents Tab
• Index Tab
• Search Tab

12.1.1 Contents Tab

You can search for the help topics from the menu bar.  
The menu bar has 8 items; File, Model, Edit, Program, 
Tools, Setup, View and Window.

Figure 12-1   Contents Tab

The help text appear in the right frame of the Help 
window when clicking “ ” or “ ”.  The “ ” icon 
appears when double-clicking “ ” or the “ ” mark.  
The detailed help topics appear.

12.1.2 Index Tab

You can search the help topic from the Keyword list.  
Enter the Keyword into the edit box, then double-click the 
keyword in the Keyword list or click “Display”.

Figure 12-2   Index Tab

12.1.3 Search Tab

You can search the help topic with the word or phrases in 
the document.  Enter the Keyword into the edit box, then 
double-click the keyword in the Keyword list or click 
“Display”.

Figure 12-3   Search Tab
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12.2 About KPG-89D

You can view the information about the KPG-89D.

Figure 12-4   About KPG-89D Window

Click “OK” to close the About KPG-89D window.
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